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Preface 

The Personal Computing Systems Architecture (PCSA) is an extension 
of DIGITAL's system's and networking architecture that merges VMS 
and MS-DOS environments. The PCSA can include VAX, MicroVAX, 
and VAXmate servers running VAXmate Services for MS-DOS and 
PCSA Client software. It can also include the DECnet/PCSA Client 
software that runs on PC workstations and on VAXmate workstations. 
Other PCSA products include ThinWire Ethernet products, and other 
peripherals, such as the LN03 Plus and LA75 Companion printers. 

DIGITAL's PCSA network fully integrates all the elements of personal 
and corporate computing required for direct information access and 
sharing. Thus, it has computing and communicating capabilities 
substantially better than those of conventional PC local area networks 
(LANs). 

Guide Objectives 
The MS-Windows User's Guide explains how to use the following system 
software: 

• MS-Windows 

• VT220 terminal emulator with scripting 

• Desktop applications 

• MS-Paint 

This software and your workstation create a powerful tool for you to use 
to perform your everyday tasks quickly and efficiently. 
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Intended Reader 
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This guide is intended for new or experienced MS-Windows users. 
Before reading this guide, however, you must first read the workstation 
handbook that comes with your workstation. Besides describing some 
of the terminology used in this guide, the workstation handbook tells 
you how to set up your workstation and use: 

• Your key diskette 

• MS-Windows 

• The mouse 

• The Information System 

NOTE 
Standalone workstation users must also read the V AXmate 
Standalone Guide. 

Your system software includes an Information System. This 
information, found on-line, is similar to the information found in this 
guide. It differs only in that it is presented in a different format. 

The Information System is always available to you as an icon when you 
are using MS-Winqows on your workstation. This means you can use 
it as a learning aid while you are becoming familiar with MS-Windows 
and the rest of the system software. 

Both the workstation handbooks and the MS-Windows part of this guide 
explain how to start the Information System. 



"""" \ Guide Organization 
This guide contains these chapters and appendixes: 

Chapter 1 

Chapter 2 

Chapter 3 

Chapter 4 

Chapter 5 

Chapter 6 

Chapter 7 

Chapter 8 

Chapter 9 

Chapter 10 

Chapter 11 

Contains information about starting MS-Windows, running 
an application, using the Information System, scrolling a 
window, using menus and commands, using dialog boxes, 
and finishing an application. 

Contains information about running multiple applications, 
switching between windows, sizing windows, shrinking an 
application to an icon, sharing information, and receiving 
messages from another application. 

Contains information about using the MS-DOS Executive 
window, its menus and commands, using MS-DOS 
commands in MS-Windows, and how to finish an 
MS-Windows session. 

Contains information about selecting, copying, deleting, 
printing, renaming, and getting information about files. 

Contains information about working with directories and 
disks. 

Contains information about using a keyboard to perform 
tasks in MS-Windows. 

Contains information about running standard and special 
applications both inside and outside of MS-Windows, 
and about transferring information between standard 
applications. 

Contains information about the MS-Windows Control Panel 
to change features or characteristics. 

Contains information about starting the VT220 terminal 
emulation application and the MS-Windows features it uses. 
It also describes how to leave the VT220 emulator application. 

Contains information about using a keyboard with the VT220 
terminal emulation application. 

Contains information about using the VT220 terminal 
emulation application Set-Up utility and the VT220 Set-Up 
screens and selections. 
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Chapter 12 

Chapter 13 

Chapter 14 

Chapter 15 

Chapter 16 

Chapter 17 

Chapter 18 

Chapter 19 

Chapter 20 

Chapter 21 

Chapter 22 

Chapter 23 

xxviii 

Chapter 24 

Chapter 25 

Appendix A 

Appendix B 

Contains information about using VT220 configuration files, 
saving and recalling VT220 Set-Up selections, autotyping 
characters to a host, and receiving characters from a host 
through session logging. 

Contains information about the VT220 script processor for 
advanced VT220 users. You should read Chapters 9, 10, 11, 
and 12 before using the VT220 script processor. You should 
also be familiar with using script processors. 

Contains information about Notepad, a desktop application 
used to create, modify, and display text files. 

Contains information about Cardfile, a desktop application 
used to organize information such as names, addresses, 
phone numbers, and directions. 

Contains information about Calendar, a desktop application 
that resembles a calendar or appointment book. 

Contains information about Calculator, a desktop application 
that works like a handheld calculator. 

Contains information about Clock, a desktop application that 
acts like a standard clock and shows the current time. 

Contains information about Reversi, a desktop application 
that is a game you can play. 

Contains information about an MS-Windows drawing 
application for users who want to draw using the mouse. 

Contains information about icons for the MS-Paint tools and 
shapes. 

Contains information about starting MS-Paint, drawing with 
MS-Paint, saving and printing an MS-Paint canvas, using 
MS-Paint palettes, and finishing MS-Paint. 

Contains information about creating a drawing in MS-Paint 
using the various shapes, patterns, tools, and MS-Paint 
editing commands. 

Contains information about MS-Paint commands and menus. 

Contains information about error messages. Each message 
contains a cause and a corrective action section. 

Contains information about the WIN.INI file. 

Contains information about program information files (PIFs). 



Appendix C Contains information about using the MS-Windows Setup· 
utility for changing hardware configurations. You should 
read this before using your workstations with this guide. 

Appendix 0 Contains information about using the keyboard with the 
VT220 terminal emulator application. 

Appendix E Contains information about non-displayable characters used 
with the VT220 script processor. 

Appendix F Contains information about special keyboard techniques used 
to modify MS-Paint operations. 

Appendix G Contains information about using MS-Paint with a keyboard. 

Conventions Used 
Follow these conventions while using this guide: 

red type In examples of computer dialog, or as instructions, what 
you type is shown in red 

typing Type all spaces and punctuation marks exactly as they are 
printed. 

Alt/Tab While you hold down the Alt key, press the Tab key. 

Alt/Shift/Tab While you hold down both the Alt key and the Shift key, 
press the Tab key. 

workstation Refers to a VAXmate or PC computer used either on a 
network or as a standalone V AXmate. 

case You can type commands and parameters in upper or 
lowercase, or in a combination of both, unless otherwise 
noted. 

numbers All numbers shown in this guide are in decimal form, 
unless otherwise noted. 

default directory The directory you are currently in. 

default drive The drive you are currently in. In this guide the default 
network drive is shown as L. 

I Return I Means to press the Return key. 
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Chapter 1 
Getting Started with MS-Windows 

MS-Windows lets you organize or assign your tasks to windows. A 
window is a section of your terminal screen. With MS-Windows, you 
can have more than one window on your screen. Each can display a 
different application. Using multiple windows, you can switch between 
several tasks, such as writing a memo, updating a project status report, 
and organizing data for a monthly report. 

With MS-Windows, you switch from one application to another by 
clicking the mouse button or pressing keys. Because you never have to 
stop running an application, you can continue in any application where 
you left off. 

With MS-Windows, you do not have to memorize formats or type many 
commands. Each application has all the necessary commands contained 
in a series of menus; you select a command from a menu. 

MS-Windows lets you transfer information between your MS-Windows 
applications. For example, you can copy information from a project 
status report to a monthly report while running both in the work area of 
your screen. 

This chapter describes how to: 

• Start MS-Windows 

• Work in MS-Windows 

• Run an application 

• Use the Information System 
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• Scroll a window 

• Use menus and commands 

• Use a dialog box 

• Finish an application 

Starting MS-Windows 
Information on starting MS-Windows and other introductory 
MS-Windows material, including definitions for terms such as icon, 
work area, and mouse, is contained in your handbook. If you have not 
read the handbook, do so before continuing. 

Initial Window 
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The first window you see when you start MS-Windows depends upon 
how MS-Windows is installed on your workstation. When MS-Windows 
is installed on your workstation, you can: 

• Run a specific application automatically in the work area each 
time you start MS-Windows 

• Load specific applications as icons 

This is desirable if you consistently use several applications. 

• Open the MS-DOS Executive window 

If you run or load applications when MS-Windows is installed, the first 
window or windows you see are the applications that are set up to run 
automatically. You also see the icons for the applications in the icon 
area at the bottom of the screen. An icon is a graphic representation 
of an application that you can expand into a window. For information 
about running and loading applications, see Chapter 3. 

If you do not run or load applications when MS-Windows is installed, 
the first window you see is the MS-DOS Executive window. 
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Working in MS-Windows 
You work in MS-Windows by using the mouse or the keyboard to select 
and enter commands. In general, this guide describes how to enter 
MS-Windows commands using the mouse. For information on using 
the keyboard to enter commands, see Chapter 6. 

NOTE 
If you unplug your mouse and plug it back in, the mouse does 
not work. To get your mouse to work again, exit and restart 
MS-Windows. 

Table 1-1 lists the terms and actions you need to know to use the 
mouse. (These are introduced in your system handbook.) 

Table 1-1: Mouse Techniques 

Term Action 

Point to an object Move the mouse until the tip of the pointer rests on the 
desired object. 

Click the left 
mouse button 

Click on an object 

Double-dick on 
an object 

Drag an object 

Press and release the left mouse button. 

Point to an object and click. 

Point to an object and click twice in rapid succession. 

Three-step action: 

1. Point to an object. 

2. Press and hold down the left mouse button, and 
move the mouse to drag the object. 

3. At the desired location, release the mouse button. 
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Table 1-1 (Cont.): Mouse Techniques 

Term 

Select a command 

Action 

Three-step action: 

1. Point to a menu. 

2. Press and hold down the left mouse button. 

The menu commands are displayed in a drop-down 
menu. The menu is highlighted where the mouse 
points. 

3. Drag the highlight to the command you want and 
release the mouse button. 

Running an Application from an icon 
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To work with an application, it must be running in a window in the work 
area. One method of running an application is to load the application 
as an icon in your work area when you open MS-Windows. An icon 
expands into a window by doing one of the following: 

• Dragging the icon from the icon area to the center of the work 
area 

• Double-clicking on the icon in the icon area. If the icon does not 
expand, try double-clicking the left mouse button faster, keeping 
the mouse steady. 

Expanding an icon is not the only way to run an application. For 
information on using the MS-DOS Executive window to run applications 
in windows, see Chapter 3. 
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Using the Information System 
The Information System provides you with information about 
MS-Windows and your workstation. The Information System is 
represented by an icon in the icon area that you expand. Figure 1-1 
shows the Information System application after it has been expanded. 

Figure 1-1: Information System Application 

lnfot radt 1 on Sl)stem • 
Find GoBack t:ro!;s···R<!f's Book111ark Copv Help 
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and then select the first topic fro111 the menu below. 

Far lie• Users: 
C> Getting Started With Your Workstation ~ 

lieneral Topics: 
C> Desktop Applications 
C> !'IS-Windows 
C> Hotes From Your Syste111 Administrator 
C> Standard Applications 
C> UT228 Terlllinal E111ulator 

lduanced Topics: 
C> Disks and Diskettes 
C> 1'18-DOS Operating System 
C> MS-DOS Operating Syste111 Co111mands 
[:> PCSA Hetwork 

In the window of the Information System you see: 

• The main menu of topics displayed in the work area 

• A group of menu names displayed in the menu bar 

To select a topic from the the Information System's main menu, click 
on the topic you want to select. 

The highlight moves as you move the cursor up and down the menu; 
do not press any mouse buttons. 
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Information about the topic you selected is displayed in the window. 
Some topics, such as MS-Windows, display additional menus. In this 
case, select a topic from these menus as you selected a topic in the 
main menu. 

To get additional help on using the Information System, select the Help 
menu. 

Scrolling 
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Some applications have more information than fits in the window at 
one time. By using the scroll bars, you can move and display all the 
information. 

A window can have one or two scroll bars: 

• One is on the right side of the application window. 

• One is on the bottom of the application window. 

Either or both of the scroll bars can be used by an application, 
depending on where the additional information is: 

• If a scroll bar is on the right side of the application window, you 
can scroll up and down. For example, you can scroll this way 
when you run a word processing application with a long text 
file. 

• If a scroll bar is on the bottom of the application window, you 
can scroll to the right or left. For example, you may scroll this 
way when you run a spreadsheet application. 

Table 1-2 shows the procedures for scrolling with the mouse. 

Table 1-2: Scrolling with the Mouse 

To scroll ... 

One line 

One window 

To a general 
location rapidly 

Do this ... 

Click on the scroll arrows at either end of the scroll bar. 
Each time you click the left mouse button, the window 
scrolls one line in the direction you selected. If you hold 
down the left mouse button, the window seroUs faster. 

Click on the shaded area on either side of the small white 
box (the scroll box) in the scroll bar. 

Drag the scroll box to a position in the scroll bar 
corresponding to the general location you want (beginning, 
middle, or end of the file). 
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Using Menus and Commands 

System Menu 

The System menu contains commands for manipulating windows and 
is common to most applications. It is represented by a box with three 
lines inside, located in the upper-left corner of the window. 

The commands in the System menu are displayed in a drop-down 
menu. Figure 1-2 shows the System menu commands. 

Figure 1-2: System Menu Commands 

Size 
Moue 
Icon 
Zoom 
Close 

About ... 

Table 1-3 describes the commands in the System menu. 

Table 1-3: System Menu Commands 

Command Description 

Size Changes the size of a window when you have two or more 
windows in the work area. With this command, you can make 
the window larger or smaller. 

Move Moves a window to another position you select in the work 
area, when you have two or more windows in the work area. 

This command also expands an icon into a window in the 
work area and shrinks a window to an icon in the icon area. 
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Table 1-3 (Cont.): System Menu Commands 

Command Description 

Icon 

Zoom 

Close 

About 

NOTE 

Shrinks a window to an icon in the icon area. 
This command also expands an icon into a window in the 
work area. 

Enlarges a window to fill the entire screen. Selecting this 
command a second time returns the window to its original size 
and position. 

Closes the window of the application, stops running the 
application, and removes the application from system memory. 
However, the application remains in your MS-Windows 
directory and on your disk. 

Displays information about the application running in the 
active (current) window. The About command is not a 
part of all applications. Also, some applications may use 
other commands, such as Help or Info, instead of the About 
command. 

Some applications can show addHional commands in the 
System menu. See your application manuals for details 
on these commands. For more information on additional 
commands for these applications, see Chapter 7. 

Application Menus 
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Each application also has its own set of menus and commands. These 
menus are displayed in the menu bar at the top of the window below 
the application title bar. As with the System menu, each menu in 
the menu bar has a drop-down menu for displaying the list of menu 
commands. (Sometimes, the menu name is also the only command 
in the menu. In this case, there is no drop-down menu.) Some 
applications do not have any menus in the menu bar; they only have a 
System menu. 

You select a menu to display the menu commands in a drop-down 
menu. To perform an action, you must select a command from a menu. 
You can drag the highlight up and down the menu as long as you hold 
down the left mouse button. 
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When you release the left mouse button, the MS-Windows application 
performs the highlighted command. However, if you release the left 
mouse button before you drag the highlight into the menu, the 
drop-down menu is removed from the display. 

NOTE 
Some commands in a menu are clisplayed in a lighter shade 
than the other commands. You cannot select them because 
they are clisabled. For example, if you have only one window 
in the work area, the Size command is disabled (clisplayed 
in a lighter shade), because you cannot change the size of a 
window if it is the only window in the work area. However, 
when you have more than one window clisplayed in the work 
area, the Size command is not clisabled, and you can change 
the size of the windows. 

Using a Dialog Box 
When you select a command, MS-Windows often needs additional 
information before it can execute the command. When MS-Windows 
needs additional information, it displays a dialog box. Figure 1-3 shows 
a typical dialog box. After you provide the needed information in the 
dialog box, MS-Windows executes the command. 
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Figure 1-3: Dialog Box 
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A dialog box is a rectangle, resembling a window, which overlays a 
portion of the screen in which you select a command. If you display 
several windows in the work area, the dialog box can overlay portions 
of more than one window, depending on the size of the windows and 
the dialog box. 

The dialog box contains areas where you either type the information 
required by MS-Windows or select options to supply the needed 
information. 

Often, a dialog box displays some information already in it, for 
example, what you have selected on the screen or other options you 
selected earlier. Also, some options may be disabled. 

After you enter information or select an option, you perform the action 
by selecting a command button in the dialog box. 



Getting Started with MS-Windows 

The following key words describe the components of a dialog box. 

Text Box 

The text box is where you type information needed to carry out a 
command. Figure 1-4 shows a text box. 

Figure 1-4: Text Box 

File name : ll!IB!!!!!I~;t!!!.l _______ __j 

What you type is displayed to the left of the blinking vertical line, called 
the insertion point. To position the insertion point in the text box, dick 
where you want the insertion point moved. As you type, the insertion 
point moves to the right. 

To correct typing mistakes, press the Word Char key. Each time you 
press it, one character to the left of the insertion point is deleted. 

The text box can: 

• Be blank when the dialog box is displayed 

• Contain text if you already selected something applicable for the 
command 

• Contain a default option 

If information is already present in the text box, you can type new 
information. When you press the first key, any information already 
present is removed. You can also press the Word Char key to delete 
information already in the text box. 
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List Box 
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A list box lists the choices you can select for a command. Figure 1-5 
shows a list box. 

Figure 1-5: List Box 

C:\WIH\PCAPP 

( Open ) 

( Cancel ) 

You can distinguish between files, drives, and directories in a dialog 
box. For example, in the list box shown in Figure 1-5: 
MYFILE Is the name of the file, MYFILE. 

[-A-) 

[MYDIR) 

[ .. ] 

Represents drive A. Brackets and hyphens surround the name 
of a drive. 

Represents directory MYDIR. Brackets surround the name of a 
directory. 

Represents the parent directory (one level up). 

To select an item in the list box, click on it. 
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Option Buttons 

Option buttons let you select one option from a group. They are 
labeled to describe their functions. Figure 1-6 shows the option buttons 
for controlling the keydick volume. 

Figure 1-6: Option Buttons 
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0Soft 
@Intermediate 
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To select an option from a group, dick on it. 

Check Boxes 

Check boxes represent options that you can turn ON or OFF. They 
are labeled to describe the functions of the options. When an X is 
displayed in the check box, the option is ON. Click on the X again to 
turn the option OFF. You can select as many check boxes as needed. 
Figure 1-7 shows a check box for a mouse option. 

Figure 1-7: Check Box 

Mouse Options 
~left/right mouse buttons s~apped 

To select a check box, dick on it. 
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Command Buttons 
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Command buttons are large rectangular buttons (with rounded corners) 
that are labeled to describe how they affect the command you selected. 
Figure 1-8 shows sample command buttons. 

Figure 1-8: Command Buttons 

( Ok ) (Cancel) 

To select a command button, click on it. 

When you select a command button, MS-Windows performs the action 
immediately. Command buttons you see in MS-Windows include: 

• Ok or Yes 

The command is performed. Sometimes, the button that 
performs the command is labeled to describe the selected 
command, such as Open or Save. 

• Cancel or No 

The selected command is canceled. 

• Reset 

Anything you entered or changed in the dialog box is ignored. 
Settings are reset to their values before the dialog box was 
displayed. 

The default command button has bold borders. Usually, it is the Ok 
command button. 
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Finishing an Application 
When you finish using an application and want to remove it from the 
work area, you can do either of the following: 

• Shrink the application to an icon in the icon area. 

The application continues running. 

• Close the application. 

When you close an application, it: 

Stops running 

Remains in the MS-Windows directory but does not take 
any space in the work area 

Shrinking an Application to an Icon 

To shrink an application to an icon, you can: 

• Double-dick on the title bar of the application you want to 
shrink. 

• Point to the title bar and drag the icon into the icon area. 

• Select the Icon command from the System menu. 

When you release the left mouse button, MS-Windows performs 
the Icon command, and the application is displayed in the icon 
area as an icon. 

Closing an Application 
To close an application, you can: 

• Select the Close command from the System menu. 

When you release the left mouse button, MS-Windows executes 
the Close command, and the window for the application closes. 

• Double-dick on the System menu box of the application you 
want to close. 

NOTE 
When you close an application in which you opened a data file 
and made changes, a dialog box is usually displayed asking you 
to either save the changes you entered or confirm that you 
want to close the application. 
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Running Multiple Applications 

This chapter describes: 

• Running multiple applications 

• Displaying multiple windows 

• Moving windows 

• Switching windows 

• Changing the size of a window 

• Shrinking a window to an icon 

• Transferring information between windows 

• Receiving messages from another application 

When you use MS-Windows, you can run more than one application at 
the same time. Each application runs in its own window. 

The procedures and examples described in this chapter tell you how to 
run two and three windows at one time using these applications: 

You can use these procedures with other applications that run in a 
window. 

• Notepad 

• Clock 

• Information System 
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Running Multiple Applications 
You can run as many applications as you want with MS-Windows, 
depending on your workstation's memory capacity. 

With MS-Windows, you can also display more than one window for the 
same application. For example, two windows can display the Notepad 
application, with each window containing a text file. One Notepad 
window can contain your monthly report, while another Notepad 
window can contain a memo. 

When you have a small amount of memory, MS-Windows can 
excessively load data from your disk. (Your workstation runs slower 
than usual.) If this occurs, dose any applications you do not need. This 
gives MS-Windows more memory for your remaining applications. 

If you try to run an application and no memory is available, 
MS-Windows displays the message "Not enough memory to run." Use 
the Close command to stop running any unwanted applications, and try 
to run the application again. 

Displaying Multiple Windows 
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You do not have to change the size of any window to make all windows 
fit in the work area. As you add or subtract each new window, 
the existing windows are automatically made smaller or larger to 
accommodate the number of windows in the work area. This process is 
called automatic tiling. 

MS-Windows follows these general automatic tiling rules when you 
expand an icon to a window: 

• If there are no windows in the work area, the icon expands to a 
window that fills the entire work area. 

• If you place the icon within an existing window, the icon 
replaces the existing window. The existing window shrinks 
to an icon in the icon area. 

• If you place the icon on the border between two existing 
windows, the new window expands between the existing 
windows. 

• If you place the icon on a vertical or horizontal border of the 
screen, the new window expands between the border and the 
adjacent window. 
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When you expand an icon by double-clicking on it: 

If there are no windows in the work area, the icon 
expands to a window that fills the entire work area. 

If there are other windows in the work area, the 
newly-selected application is displayed directly above 
the icon area and below the existing windows. 

Displaying Icon Names 
Although icons are unique for each application, you can have more than 
one icon for the same application, such as Notepad, each containing 
a different text file. Because all Notepad icons look alike, you need to 
display the names of the applications the icons represent to identify 
which file you want. 

To display an icon name: 

1. Point to the icon. 

2. Press and hold down the Shift key. 

The icon name is displayed above the icon. Figure 2-1 shows 
an icon with the icon name. 

Figure 2-1: Displaying the Icon Name 

For the Notepad icon, the icon name is displayed with the name of 
its text file. The icon name displayed above the icon is the same as 
the icon name displayed in the title bar when the application runs in a 
window. The icon name remains as long as you hold down the Shift 
key and point to the icon. 

To display the name of another application, continue to hold down the 
Shift key and point to the other application icon. 
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Running Two Applications 
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Open the Information System window and display Notepad as an icon. 

To expand the Notepad icon and display it as a second window, drag 
the Notepad icon to the left border in the work area. 

When you hold down the left mouse button, you can drag the icon 
anywhere on the screen. When you release the left mouse button in the 
work area, the icon expands to a window. 

The Notepad window is now in the left half of the work area, and the 
Information System window is in the right half. Figure 2-2 shows both 
windows. 

Figure 2-2: Displaying Two Windows 
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Running Three Applications 

To expand the Clock icon and display it as a third window, drag the 
Clock icon to the right border of the Information System window. 

The Clock icon changes to a blank rectangle when you drag it. 

The Clock window is displayed in the right quarter of the work 
area. Figure 2-3 shows the Notepad, Information System, and Clock 
windows. 

Figure 2-3: Displaying Three Windows 
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Switching Windows 
Although you can run several windows simultaneously in the work area, 
you can only work in one window at a time. The window in which you 
work is called the active window. Only the active window is affected by 
commands and any other information you enter with the mouse or the 
keyboard. 

To make another window active, you switch to another window and 
click inside of that window. The new active window has its title bar 
highlighted, and you can now work in this window. 

NOTE 
If you display a pop-up program/window on the screen so that 
it becomes unreachable with the mouse, use the keyboard to 
make it active and move it. Use the Alt/Tab key sequence 
to make the pop-up window active again, then use the 
Alt/Spacebar sequence to open the System menu. Select the 
Move command to move the window. 

If you switch from an active window with an application running in it 
and then switch to this window again, you resume activity where you 
left off. 

Moving Windows 
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You can rearrange your windows in the work area. For example, you 
can move the the Clock window below the Notepad window to make 
the Information System window wider and easier to use. 

To move the Clock window: 

1. Point to the middle of the Clock window title bar. 

When you click on the title bar, the cursor changes to the Clock 
icon (a blank rectangle). 
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2. Drag the icon down and to the left until the icon is on the 
lower border between the Notepad window and the icon area. 
Figure 2-4 shows moving the Clock icon. 

Figure 2-4: Moving the Clock Icon 
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3. Release the left mouse button. 

The Clock window is below the Notepad window. Figure 2-5 
shows the new location of the Clock window. 
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Figure 2-5: Clock Window After a Move 
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Changing the Size of a Window 
When you have more than one window in the work area, you can 
change some of the windows' sizes to better use the work area. Using 
the System menu commands and other components of a window, you 
can make a window: 

• Larger 

• Smaller 

• Fill the entire screen (zoom) 

Making a Window Larger 

To make a window larger, use: 

• The Size command from the System menu 

• The Size box in the title bar 
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Using the Size Command 

To make the Notepad window larger by using the Size command: 

1. Select the Size command from the System menu of the Notepad 
window. 

The cursor changes to a small box, called the size box. 

2. Move the size box beyond the Notepad window borders until 
the window is the size you want. You do not need to hold down 
the left mouse button to move the size box. 

Nothing happens until the size box moves beyond the borders 
of the window. After the size box crosses the borders, a pair of 
lines, one vertical and one horizontal, is displayed. These lines 
mark the new borders of the window you are sizing. 

Figure 2-6 shows the new size for the Notepad window. 

Figure 2-6: Defining the Larger Notepad Window 
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3. When the window is the size you want, click the left mouse 
button. 

MS-Windows widens the Notepad window and adjusts the size 
of any adjacent windows. Figure 2-7 shows the larger Notepad 
window. 

Figure 2-7: Larger Notepad Window 
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Using the Size Box 
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Some windows have a size box in their upper- or lower-right corner. 

To make a window larger using the size box: 

1. Point to the size box of the window you want to change. 

2. Drag the size box beyond the window borders. 
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3. When the window is the size you want, release the left mouse 
button. 

MS-Windows makes the window larger and adjusts the size of 
the other windows in the work area. 

Making a Window Smaller 

To make a window smaller, use the same process as for making a 
window larger: 

• The Size command from the System menu 

• The Size box in the title bar 

Be sure to drag the size box beyond the window border before shrinking 
the window. 

Filling the Screen with a Window 

When you are working with more than one window, you can enlarge 
one window temporarily to fill the entire screen, without moving the 
other windows to the icon area. This process is called zooming. 

To fill the screen with a window, use: 

• The Zoom command from the System menu 

• The size box 

Using the Zoom Command 

To zoom the Information System window, select the Zoom command 
from the System menu of the Information System window. The window 
enlarges to fill the entire screen, including the icon area. Figure 2-8 
shows an Information System window that has been zoomed. 
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Figure 2-8: Window Filling the Entire Screen 
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To restore the window to its former size, select the Zoom command 
again. 

Using the Size Box 
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To use the size box to zoom, double-dick on the size box. 

The window enlarges to fill the entire screen, including the icon area. 

To restore the window to its former size, double-dick on the size box 
again. 
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Shrinking a Window to an Icon 
You can free space in the work area by shrinking a window into an icon. 
For example, you can shrink the Information System to an icon if you 
are finished using it but want it available for later use. It still runs in 
memory but does not take up space in the work area. 

To shrink a window to an icon, use: 

• The Icon command 

• The title bar 

Using the Icon Command 

To shrink the Information System window into an icon using the Icon 
command, select the Icon command from the System menu of the 
Information System window. 

The Information System shrinks to an icon, and the other windows 
adjust to fill the work area. Figure 2-9 shows an example of shrinking a 
window to an icon. 

Figure 2-9: Shrinking a Window to an Icon 
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Using the Title Bar 

To shrink the Information System window to an icon using the title bar, 
you can: 

1. Point to the middle of the Information System title bar. 

Press the left mouse button. The cursor changes to the 
application icon. 

Drag the Information System icon to the icon area and release 
the left mouse button. 

2. Double-dick on the middle of the title bar of the window you 
want to shrink. 

Transferring Information Between Windows 
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You can transfer, copy, or move information within a window or 
between windows: 

• From one place in a window to another 

For example, you can move text in a report as you edit. 

• From one window to another window when both windows are 
running the same application 

For example, you can transfer information from one report 
being prepared by a word processing application into another 
report being prepared by the same word processing application. 

• From one window to another window when the windows are 
running different applications 

For example, you can transfer numbers from a spreadsheet 
application into a report being prepared with a word processing 
application. 
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Cutting and Pasting 

To transfer larger quantities of information, use the cut (or copy) and 
paste features of MS-Windows. 

To cut and paste information, MS-Windows uses the Clipboard to 
hold information. The Clipboard is a temporary storage area that 
holds the information while you move it from its original location to its 
destination. The Clipboard is always available when you run 
MS-Windows. You do not need to run any program to use the 
Clipboard. However, if you want to look at what is stored in the 
Clipboard, you select and run CLIPBOARD .EXE. 

Each time you cut or copy information to the Clipboard, anything 
already stored there is overwritten (the previously stored information is 
deleted.) 

To transfer information to the Clipboard, use the Cut command or the 
Copy command procedure of your application. To insert information 
from the Clipboard to your application, use your application's Paste 
command procedure. Although your application may have different 
names for these commands, the commands should work as described 
in Table 2-1. 

Table 2-1: Cut, Copy, and Paste Commands 

Command 

Cut 

Copy 

Paste 

Description 

Deletes the selected information from the window and 
places it on the Clipboard. 

Copies the selected information and places it on the 
Clipboard. The selected information remains intact in 
its original location. 

Inserts information from the Clipboard into a selected 
location in a window. You can paste the same information 
from the Clipboard as many times as you want as long as 
you are using the same paste buffer contents. When you 
put new information into the Clipboard, the previously 
stored information is overwritten. 

If you move the cursor in the window, the information is 
inserted and displayed to the left of the cursor. 

If you have marked text for selection in the receiving 
document, the information from the Clipboard replaces the 
selected text. For more information on marking text, see 
Chapter 7. 
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Generally, ASCII text (text composed of 8-bit binary numbers 
representing the alphabet, punctuation, numerals, and other special 
symbols) and graphics are stored on the Clipboard, but formatting 
commands for your text or graphics are not. However, this can vary 
with your application. 

Some standard applications (applications that run on your workstation) 
have commands similar to Cut, Copy, and Paste, although they do not 
necessarily use the MS-Windows Clipboard to transfer information. 

Receiving Messages from Another Application 
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When another application sends you status or error information, you 
hear a beep, and the application sending you the message flashes its 
title bar or icon. To display the message in a dialog box, switch to the 
flashing window or icon by clicking on it. 

Figure 2-10 shows an example of a message an application sends 
you. In this example, the Calendar application reminds you of an 
appointment. 

Figure 2-10: Message from Another Application 
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Chapter 3 
Using the MS-DOS Executive Window 

This chapter describes the MS-DOS Executive window and its 
components and tells you how to: 

• Use menus and commands 

• Load an application 

• Run an application 

• Run MS-DOS commands and programs 

• Finish your MS-DOS Windows session 

Chapter 4 discusses using the MS-DOS Executive window to work with 
files. Using the MS-DOS Executive window to work with directories and 
disks is discussed in Chapter 5. 

Defining the MS-DOS Executive Application 
You use the MS-DOS Executive application, an MS-Windows application to 
control or manage your MS-Windows session. The MS-DOS Executive 
application runs when MS-Windows runs, either as a window or as an 
icon. (Chapter 7 describes an exception to this rule, associated with 
running certain kinds of applications.) 

With the MS-DOS Executive application, you can perform most of the 
functions that you do by entering MS-DOS commands. 
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When you start MS-Windows, the first window you see is the MS-DOS 
Executive window. You use this window to: 

• Load any application icons into the icon area 

• Run any application not already loaded as an icon 

Some key diskettes are set up so that when you start MS-Windows an 
application runs automatically in a window. In this case, the MS-DOS 
Executive application is displayed in the icon area as a diskette icon. To 
run the MS-DOS Executive application, expand its icon into the work 
area. 

MS-DOS Executive Window Components 
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Figure 3-1 identifies the components of the MS-DOS Executive window. 
Table 3-1 describes these components. 

Figure 3-1: MS-DOS Executive Window 
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Table 3-1: MS-DOS Executive Window Components 

Component 

System menu 
box 

Menu bar 

Title bar 

Size box 

Cursor 

Work area 

Scroll bar 

Drive icons 

Highlight 

Path 

Current 
directory 

Directory 
listing 

Description 

Contains the commands, such as Move, Zoom, and Close, 
you use to manipulate the window. This menu is common 
to most MS-Windows applications. 

Contains the three menus of the MS-DOS Executive 
application: File, View, a.nd Special. 

Displays the name of the MS-DOS Executive application. 

Changes the size of a window. 

Is the mouse cursor you use to point to an object. 

Is the expanded window. 

Displays in the window when there is more information 
than can be displayed in one screen. 

Represent the disk drives of your workstation. The current 
drive is highlighted. 

Shows the file name or menu command that is currently 
selected. 

A hierarchy of directories. Consists of the drive letter, 
the volume name (if there is one), the d.h·ectory and 
subdirectory names, then the current directory name. Each 
directory is separated by a backslash 

The directory you are in now. In the path name, the 
current directory is the one at the right. 

Lists the file names in the current directory. A directory is 
a group of files stored on a disk. 

Using Menus and Commands 
The MS-DOS Executive has four menus from which you can display and 
select commands: 

• System menu 

• File menu 

• View menu 

• Special menu 
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The System menu is represented by the System menu box. The other 
three menus are in the Menu bar. When you select a menu, a 
drop-down menu is displayed, containing the menu's commands. 

System Menu 
The System menu contains commands for manipulating the windows 
and is common to most applications. Figure 3-2 shows the System 
menu commands. 

Figure 3-2: System Menu Commands 
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When you select the About command in the MS-DOS Executive 
window, MS-Windows displays a dialog box, showing the amount 
of disk space and memory space available on your workstation. 

File Menu 
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The File menu contains commands that let you act on the files displayed 
in the MS-DOS Executive window. When you select any of these 
commands, except for the Get Info command, MS-Windows displays 
a dialog box in the window. In the dialog box, you enter additional 
information needed by the command before MS-Windows runs the 
command. 

Figure 3-3 shows the File Menu. Table 3-2 describes the File menu 
commands. For more information on using the File menu commands, 
see Chapter 4. 
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Figure 3-3: File Menu Commands 
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Table 3-2: File Menu Commands 

Command Description 

Run 

Load 

Copy 

Get Info 

Delete 

Print 

Rename 

Runs the application in the window. Select the Run command 
to run an application not in the current directory listing and to 
enter a program parameter for the selected application. 

Using the Run command is the preferred method of running 
an application. 

Loads the application as an icon in the icon area. Select the 
Load command to load an application not in the current 
directory listing and to enter a program parameter for the 
application. 

Copies the files to a different directory or disk, or to a different 
file name in the same directory. 

Displays the file names, file extensions, size in bytes, and the 
date and time the file was created or most recently changed for 
the selected files. 

Deletes the selected files from the directory and the disk. 

Prints the selected files or directory listing on your printer. 

Changes the name of the selected files. 
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View Menu 
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The View menu contains commands that let you list the directory files. 
The commands are divided into three groups. Only one command from 
each group can be active at a time. The active command in each group 
is preceded by a check mark. 

By selecting the commands you want, you can list the directory files 
in the way you want. The commands you select from the View menu 
affect any directory you display in the MS-DOS Executive window. 

Figure 3-4 shows the View menu. Table 3-3 describes the View menu 
commands, according to each group. 

Figure 3-4: View Menu Commands 
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Table 3-3: View Menu Commands 

Command 

Group 1: 

Short 

Long 

Group 2: 

All 

Partial 

Programs 

Group 3: 

By Name 

By Date 

By Size 

By Kind 

Description 

Lets you select how much information is displayed for each 
file. 

Displays a directory listing by file name only (default 
setting). Directory names are displayed in bold letters. 

Displays a directory listing by file name, file extension, size 
in bytes, and date and time last changed for each file listed. 
The key information by which the files are sorted (name, 
date, size, or type) is displayed in boldface. 

Directory names are listed in one column, with < DIR > ·to 
the right of each directory name. 

Lets you select which files are displayed. 

Usts all the files in a directory (default setting). 

Displays all files with the specified file specification. 

For example, if you type *.TXT in the displaying dialog box, 
only files having the file extension . TXT are displayed. 

Displays all files that can run as programs, such as files 
having the file extension .EXE, .BAT, and .COM. 

Lets you select the key information by which the files are 
sorted and displayed. If you select the Long command from 
Group 1, the key information is displayed in boldface. 

Sorts a directory alphabetically by file name (default setting). 

Sorts a directory by the date and time each file was created 
or most recently changed. MS-Windows lists the most 
recent date and time first. 

Sorts a directory according to the size of each file in bytes. 
MS-Windows lists the files from largest to smallest. 

Sorts a directory alphabetically by file extension. 
MS-Windows sorts files with the same file extension 
alphabetically by name. 
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Special Menu 
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The Special menu contains commands that let you: 

• Finish the MS-Windows session 

• Work with disks 

• Work with directories 

Figure 3-5 shows the Special menu. Table 3-4 describes the Special 
menu commands. For more information about the commands that let 
you work with disks and directories, see Chapter 5. 

Figure 3-5: Special Menu 
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Table 3-4: Special Menu Commands 

Command 

End Session 

Create Directory 

Change Directory 

Format Data Disk 

Make System Disk 

Set Volume Name 

Description 

Finishes your MS-Windows session. 

Creates a new directory. 

Changes directories. 

Formats a data diskette. 

Creates a diskette containing the MS-DOS operating 
system files. 

Assigns the name you enter to a disk (also called a 
volume). This command can also change the name of 
an existing volume. 
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Loading an Application 

Use the MS-DOS Executive window to load an application as an icon in 
the icon area. . 

To load an application into the icon area, use: 

• The Load command from the File menu 

• The file name 

Using the Load Command 

Use the Load command from the File menu to: 

• Load an application into memory 

• Run the application as an icon 

• Display the application icon in the icon area 

From your default directmy, you can use the Load command to load 
any application in your path. The default directmy becomes the 
application's current directory. 

The Load command is also useful for entering a program parameter or 
a command line argument when you start the program. For example, 
when loading Notepad, you can specify a text file to edit. 

To load an application: 

1. Select the Load command from the File menu. 

The MS-DOS Executive window displays the Load dialog box. 
Figure 3-6 shows the Load dialog box. 

Figure 3-6: Load Dialog Box 
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2. In the dialog box, type the file name of the application you want 
to run. 

If the application is not in the path, include the drive and 
directory of the application you want to run. 

Also type any additional information that the application needs, 
such as a command line argument. 

3. Click on the Ok command button. 

The application you selected loads into memory. If the 
application has an icon, it runs in the icon area, and its icon 
is displayed. Otherwise, it may display as a pop-up window. 

If you have an application in the current directory, you can highlight the 
file name of the application before you select the Load command from 
the File menu. This name is displayed in the dialog box, and you can 
add any program parameters necessary for your application. 

Using the File Name 
To load an application from the current directory into the icon area: 

1. Press and hold down the Shift key. 

2. Double-click on the file name of the application you want to 
load as an icon. 

The application you selected from the current directory loads 
into memory. It runs in the icon area, and its icon is displayed. 

Running an Application 
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To run an application in a window, using the MS-DOS Executive 
window, you can use: 

• The Run command from the File menu 

• The file name 
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Using the Run Command 
' 

The Run command gives you another way to run an application. From 
your default directory, you can use the Run command to run any 
application that is in your path. The default directory becomes the 
current directory for the application you are running. 

The Run command is also useful for entering a program parameter and 
command line arguments when you start the program. For example, 
when running Notepad, you can include the name of a text file you want 
to edit. 

To run an application: 

1. Select the Run command from the File menu. 

The MS-DOS Executive window displays the Run dialog box. 
Figure 3-7 shows the Run dialog box. 

Figure 3-7: Run Dialog Box 
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2. In the dialog box, type the file name of the application you want 
to run. 

If the application is not in the path, include the drive and the 
directory of the application you want to run. 

Also type any additional information that the application needs, 
such as a command line argument. 

3. Click on the Ok command button. 

The application you selected replaces the MS-DOS Executive 
application in the window. The MS-DOS Executive application 
changes to an icon. 
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If you have an application in the current directory, you can highlight 
the file name of the application before you select the Run command 
from the File menu. This name is displayed automatically in the dialog 
box, and you can add any program parameters necessary for your 
application. 

Using the File Name 
To run an application in your default directory, double-click on the file 
name of the application you want to run. 

The file name is highlighted. 

The cursor temporarily changes to an hourglass, indicating that 
MS-Windows is loading the application into memory. 

The application you selected replaces the MS-DOS Executive application 
in the window. The MS-DOS Executive application changes to an icon. 

Using Temporary Files 

Some applications that run with MS-Windows create temporary files 
with the file extension . TMP to store your work. 

The file names for temporary files begin with a tilde and letters 
indicating the application name. For example, a temporary file for 
MS-Paint has the file name "MSP*.TMP. 

You can create a special directory on your local hard disk drive to hold 
temporary files. To send temporary files to this directory, put the SET 
TEMP command in your AUTOEXEC.BAT file. 

Do not delete these files while MS-Windows is running because an 
application could be using them. You can delete them after quitting 
your MS-Windows session. 

Running Batch Files 
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You run batch files only from the MS-DOS Executive window. If you 
run a standard application from a batch file, you should create a PIF for 
the batch file. For more information about PIFs, see Appendix C. 

Set options in the batch file PIF to be the same as the application PIF. 
However, set the Memory Required and Memory Desired options for 
the batch file PIF to 32K, regardless of the memory requirements for the 
application. 
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Using MS-DOS Commands and Programs 

MS-DOS commands are divided into three groups: 

• Commands you must use outside of MS-Windows 

• Commands you run from MS-Windows with COMMAND.COM 

• Commands you run from the MS-DOS Executive window 

Those commands that you must run outside MS-Windows, you can run 
from the MS-DOS operating system prompt. Or, you can put these 
commands in your AUTOEXEC.BAT file, which runs automatically 
before MS-Windows starts. For more information on MS-DOS 
commands and programs, see the MS-DOS Reference Guide or refer 
to the DOS reference manual that comes with your DOS software. 

An asterisk(*) marks commands that have an MS-Windows equivalent. 

The MS-DOS commands you must run outside MS-Windows are: 

APPEND GRAFTABL MODE SHARE 

ASSIGN GRAPHICS NET START SORT 

CHKDSK JOIN PRINT* 

CTTY DECKEYB RECOVER 

FONT LCOUNTRY SELECT* 

The MS-DOS commands you can run in MS-Windows from the 
Command window are: 
BREAK ECHO MORE SET 

CHOIR* ERASE* PATH SHIFT 

CLS EXIT PAUSE TIME* 

COPY* FOR PROMPT TYPE 

DATE* GOTO REM VER* 

DEL* IF REN* VERIFY 

DIR* MKDIR* RMDIR* VOL* 
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The MS-DOS commands you can run from the MS-DOS Executive 
window are: 
ATTRIB EDLIN FORMAT* RESTORE 

BACKUP EXE2BIN LABEL SUBST 

COMMAND FC LINK SYS* 

DEBUG FDISK NET 

DISK COPY FIND PERMIT 

Running an MS-DOS Operating System Program 
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To use an MS-DOS command in MS-Windows with COMMAND.COM: 

1. Select the Run command from the File menu in the MS-DOS 
Executive window. 

2. In the dialog box, type: 

COMMAND 

3. Click on the Ok command button. 

The MS-DOS command processor starts in a window titled 
''Comn1and.'' 

4. Type the MS-DOS command and any command arguments at 
the MS-DOS prompt. 

5. To exit the MS-DOS command processor, type: 

EXIT 

The window title is now enclosed in parentheses. 

6. Close the window. 

To run an MS-DOS command from the MS-DOS Executive window: 

1. Select the RUN command from the File menu. 

2. Type the command name and its arguments in the dialog box. 

3. Close the window. 

If the application does not stop automatically, type the Exit command 
and then close the window. 
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Using the MS-DOS Executive Window 

Finishing an MS-Windows Session 
To finish an MS-Windows session: 

1. Save all files you have worked on. 

2. Exit from any standard application still running in a window or 
as an icon. 

3. From the MS-DOS Executive window, end your MS-Windows 
session by using one of the following methods: 

• Double-click on the System menu box. 

• Select the Close command from the System menu. 

• Select the End Session command from the Special 
menu. 

With either method, a dialog box is displayed, indicating 
that this action ends your MS-Windows session. 

4. Click on the Ok command button. 

MS-Windows closes, and the MS-DOS operating system 
prompt is displayed on the screen. You can now do one of 
the following: 

• Turn off your workstation and remove your key diskette 
if you do not want anyone else to access your files. 

• Enter MS-DOS commands or restart MS-Windows from 
the MS-DOS operating system prompt by typing: 

WIN !Return! 

If you try to close MS-Windows while an MS-Windows application such 
as Notepad is still running, MS-Windows displays a dialog box and lets 
you save the updated data file. 

If you try to close MS-Windows while a standard application is still 
running, MS-Windows displays a dialog box indicating an application is 
still running. The name of the active application is displayed in the title 
bar of the dialog box. Close the application, then close MS-Windows. 
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Chapter 4 
Working with Files 

This chapter describes how to use the MS-DOS Executive window to: 

• Use files 

• Select files 

• Copy files 

• Delete files 

• Print files 

• Rename files 

• Get information about files 

This chapter describes how to work with the file names listed in the 
MS-DOS Executive window. 

Using Files 
Your workstation stores information on a disk in files. Each file has 
a name, usually assigned by you. A file can contain a document, an 
application, a program you have written, or coded information for use 
by an application. 

Files in MS-Windows use MS-DOS file-naming conventions. For more 
information, see the MS-DOS Reference Guide. 
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Selecting Files 
When you work with MS-Windows, you must select the file that the next 
command or action affects. The selected file is highlighted. 

With MS-Windows you can select: 

• One file 

• Multiple files 

Selecting a File 
To select a file, click on the file name you want. 

To cancel the selected file: 

1. Press and hold down the Shift key. 

2. Click on the highlighted file name. 

The highlight is removed from the file name. 

Selecting Multiple Files 
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To select multiple files: 

1. Click on the first file name you want to select. 

2. Hold down the Shift key. 

3. Click on each additional file name you want to select. 

If you select a file name by mistake, you can cancel the selection 
by clicking on it again while still holding down the Shift key. 

4. After you select all the files you want, release the Shift key. 

If you release the Shift key and click on a file name, the file 
name you selected is highlighted, and all the highlighted files 
are no longer selected. 
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Figure 4-1 shows a group of selected files. 

Figure 4-1: Selecting Multiple Files 

I·IS-DOS Execut1ue • 
File Uiew Special 
AI • I Cl I Dl I HI I II I Jl I~ K: \ 

W~t!.\'xE 
CALEHDAR. EXE 
CARDFILE.EXE 
CLIPBRD.EXE 
CLOCK.EXE 

HOTEPAD.EXE 
PAIHT.EXE 
REUERSI.EXE 
SPOOLER.EXE 
UT2211.EXE 

Using the File Menu Commands 
The File menu of the MS-DOS Executive window contains commands 
that affect a file. The Run and Load commands are described in 
Chapter 3. Figure 4-2 shows the File menu commands. 
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Figure 4-2: File Menu Commands 

NOTE 

load .•• 
Copy ••• 
Get Info 
Delete ••• 
Pr:int~~~ 
Rena1ne ••• 

For applications that have an Open command in the File 
menu, there is usually a [ .. ) in the list box. This [ .. ) 
represents the directory above the current directory and 
indicates that the current directory is a subdirectory. To move 
to the higher-level directory, in the File name text entry field, 
type: 

If the drive is on a VAX/VMS server, the [ .. ) is not displayed. 

Copying Files 

To copy an existing file, use the Copy command. You can use this 
command to copy: 

• An existing file into another directory 

• A file with a new name 

You can copy both single and multiple files. 

Copying One File 

To copy one file: 

1. Click on the file name you want to copy. 

The file name is highlighted. 

2. Select the Copy command from the File menu. 
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MS-Windows displays the Copy dialog box. Figure 4-3 shows 
the Copy Command dialog box. 

Figure 4-3: Copy Command Dialog Box 

Copy: IDOTHIS.TXT 

To: I 
~----------------------------------------~ 

( Ok ) (Cancel) 

The file name you selected is in the Copy text box, indicating that the file is 
the source file you want to copy from. 

3. In the To text box, type the new file name, including the new 
drive and directory if applicable. 

4. Click on the Ok command button. 

A message is displayed at the bottom of the Copy dialog box, 
indicating that the file you selected is being copied. 

MS-Windows takes a few seconds to create the new file with 
the specified name. After MS-Windows creates the new file, the 
dialog box is removed from the window. 

The MS-DOS Executive window then displays a new list of file 
names, including the new file you created. 

Copying More Than One File 

To copy several files at the same time to another directory or drive: 

1. Select all the file names you want to copy. 

2. Select the Copy command from the File menu. 

MS-Windows displays the Copy dialog box, containing all the 
selected file names. 

If the file name is not listed in the dialog box, type the correct 
one, including any file extension. 
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3. In the To text box, type the drive and directory to which you 
want the files copied. 

NOTE 
You cannot copy more than one file to a single file. 
(Use the MS-DOS operating system to concatenate 
files.) However, you can copy multiple files to a drive 
or an existing directory. 

4. Click on the Ok command button. 

Deleting Files 
To delete files that are no longer useful and to make space for other 
files, select the Delete command. When you delete a file, MS-Windows 
removes it permanently from the disk. 

Deleting One File 

To delete a file from the File menu: 

1. Click on the file name you want to delete. 

2. Select the Delete command from the File menu. 

MS-Windows displays the Delete dialog box, containing the 
name of the selected file. 

If the file name is not the one you want to delete, type the 
correct file name over the one displayed. You must type the 
entire file name, including any file extension. 

3. Click on the Ok command button. 

Deleting More Than One File 
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To delete more than one file at a time, select all the files you want to 
delete, then follow steps 2 and 3 in the previous section. 
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Printing a Text File 

To print text files, select the Print command from the File menu. With 
the Print command, you can print any files you can display on your 
screen. 

NOTE 
Most applications have a command that prints files you 
create with that application. You should use the application 
command when possible. 

To print a file: 

1. Click on the file name of the text file you want to print. 

The file name you selected is highlighted. 

2. Select the Print command from the File menu. 

MS-Windows displays the Print dialog box. Figure 4-4 shows 
the Print dialog box. 

Figure 4-4: Print Dialog Box 

Print: pmu;11~wt:t1 

( Ok J (Cancel) 

If the file name is not the one you want to print, type the correct 
file name over the one displayed. You must type the entire file 
name, including any file extension. 

3. Click on the Ok command button. 

The MS-DOS Executive window displays the Print Spooler 
dialog box, telling you the file is being sent to the Spooler for 
the default printer. Figure 4-5 shows the Print Spooler dialog 
box. 
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Figure 4-5: Print Spooler Dialog Box 

NOTE 

§ NS~DOS Executive 

Sending 
DOTHIS.TXT 

to print spooler. 

(Cancel) 

Printing does not start until the file has been sent to the 
Spooler. The length of the delay before the printer starts 
depends on the complexity and the length of the file you are 
printing and the number of files already waiting in the print 
queue. 

For more information about the default printer and how to select it see 
Chapter 8. 

To cancel the print request, click on the Cancel command button. 

Using the Spooler 
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The MS-Windows Spooler is an application that stores files waiting to be 
printed. When you run the Print command from the MS-DOS Executive 
or from a Desktop application: 

• The Spooler application starts. 

• The Spooler icon is displayed in the icon area. 

• A file is sent to the Spooler application. 

• The Spooler starts to print the file on your printer, if no other 
files are printing. 

The Spooler application works in the background; therefore, you do 
not have to wait while your file prints. You can perform another task or 
work with another application while the Spooler prints your file. 
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If you expand the Spooler icon in the work area, the Spooler window 
lists: 

• The file names in the order they are to be printed 

This listing is called a print queue. The first file name in the print 
queue is the one that is currently printing. 

The Spooler prints the files one at a time, in the order they are 
listed. If the listing scrolls off the bottom of your window, use 
the vertical scroll bar to see the entire list. 

• The printers installed on the workstation 

Figure 4-6 shows the Spooler window. 

Figure 4-6: Print Spooler Window with Print Queue 

P~io~ity Cont~ols 
LPI1 [Paused]: D111tal LA/5 

B•.n; 
README. TlO 
DOTHIS.TXT 

LPT2 (Actiue]: Digital LH03 
LPT3 [Actiue]: Digital LASO 

Spooler • 

The Spooler application has two menus: 

• Priority 

• Control 
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Priority Menu Commands 
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The Priority menu commands specify how fast you want to print your 
work. These commands change the rate of data transfer from the 
Spooler to the printer ports. 

To specify how fast to print: 

1. To print faster, select the High command from the Priority 
menu. 

This setting uses more resources of your workstation for 
printing. The system slows down, and other applications you 
are using run more slowly. 

2. To print slower, select the Low command from the Priority 
menu. 

This setting allows the other applications you are working with 
more resources of your workstation. 

The check mark in the menu shows the current setting. Low is 
the default setting. 

Control Menu Commands 

The Control menu commands interrupt or cancel a print job. 

To interrupt a print job (to change a ribbon, for example): 

1. Select the Pause command to interrupt printing. 

The status of the printer changes to Paused in the Spooler 
window, and the printer stops printing. 

2. To continue printing the file, select the Resume command. 

To cancel a print job: 

1. In the Spooler window, click on the file name of the job you 
want to cancel. 

2. Select the Terminate command. 

MS-Windows displays the Terminate dialog box. 

3. Confirm the cancellation. 

4. Click on the Ok command button. 
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The file name you selected is removed from the print queue. 

NOTE 
If you cancel a job while it is printing in graphics mode, you 
may need to reset your printer by turning it off and then on 
again to ensure the buffer is cleared. For more information 
on resetting your buffer, see your printer documentation. 

The Spooler application sometimes displays information about the 
status of your printing jobs. For example, the printer may be out of 
paper. If the Spooler needs to display information, but the window 
or icon is not selected, the title bar or icon flashes. Select the Spooler 
window or icon to display the message. 

Renaming a File 
To change the name of a file, use the Rename command. 

To rename a file: 

1. Click on the file name you want to rename. 

2. Select the Rename command from the File menu. 

MS-Windows displays the Rename dialog box. Figure 4-7 shows 
the Rename dialog box. 

Figure 4-7: Rename Dialog Box 

Rena111e: I DOTH IS. TXT 

To: I 
~---------------------------------------

( Ok J (Cancel) 

If the file name is not the one you want to rename, type the 
correct file name over the one displayed. You must type the 
entire file name, including any file extension. 
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3. In the To text box, type the new file name. 

4. Click on the Ok command button. 

Getting Information About Files 
To get more information about a particular file or group of files, use the 
Get Info command. 

To get information about a file: 

1. Click on the file names for which you want information. 

2. Select the Get Info command from the File menu. 

MS-Windows displays the Get Info dialog box, containing the 
file names, size in bytes, and the date and time it was created or 
last changed. (You may need to scroll to see all the information 
in the dialog box.) Figure 4-8 shows the Get Info dialog box. 

Figure 4-8: Get Info Dialog Box 

§ Get Info 
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36528 14/11/85 
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1:54PM 
2:12PM 

12:48PM 
4:29PM 

11:18AM 

3. After you finish looking at the Get Info dialog box, close it by 
either of the following: 

• Select the Close command from the System menu. 

• Double-click on the System menu box. 
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Chapter 5 
Working with Directories and Disks 

This chapter describes how to use the MS-DOS Executive window to: 

• Work with directories 

• Work with disks 

Working with Directories 
A directory lists a group of files stored on a disk. Each directory also 
briefly catalogs the group of files it contains. A directory contains 
information, such as the name, size, type of file, and date of entry, of 
all its files. You can also have subdirectories within directories. 

Directory names are displayed at the beginning of the directory listing 
in the MS-DOS Executive window. 

When the listing is in the short form, directory names are displayed in 
bold letters. When the listing is in the long form, directory names are 
listed with < DIR > to the right of each directory name. 

The name of the current directory (the one you are in now) is the directory 
name farthest to the right in the path name at the top of the MS-DOS 
Executive window. 

For more information about directory structures, path names, and disks, 
see the MS-DOS Reference Guide. 
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Changing Directories 
You can change directories or subdirectories to see what is in another 
directory and to work with the files in another directory. The path name 
at the top of the MS-DOS Executive window always shows your location 
in the directory structure. 

To change directories, use: 

• The Change Directory command 

• The path name 

• The Word Char key 

Using the Change Directory Command 

To change directories: 
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1. Select the Change Directory command from the Special menu. 

MS-Windows displays the Change Directory dialog box. 
Figure 5-1 shows the Change Directory dialog box. 

Figure 5-1: Change Directory Dialog Box 

Change To: ~....1 h_:_\_d_ec_a..:.p..:...p.:._l _________ ____. 

( Ok ~ (Cancel) 

2. Type the path name of the directory to which you want to 
change. 

3. Click on the Ok command button. The directory you selected is 
displayed in the MS-DOS Executive window. 
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Using the Path Name 

To change directories: 

1. Click on the directory in the path name to which you want to 
change. 

MS-Windows displays the Change Directory dialog box. The 
path name of the directory you selected is displayed in the text 
box. 

2. To change to a directory other than the one displayed in the text 
box, type the path name of the directory to which you want to 
change. 

3. Click on the Ok command button. 

The directory you selected is displayed in the MS-DOS 
Executive window. 

Using the Word Char Key 

To change directories only when you want to go to the next higher 
directory (the directory immediately to the left of the current directory 
in the path name), press the Word Char key. 

With this method, no matter where you are or what you have selected in 
the MS-DOS Executive window, the next higher directory (if one exists) 
is displayed in the MS-DOS Executive window. 

To change to a lower directory using the keyboard, highlight the name 
of the directory to which you want to go and press the Return key. 

Creating Directories 

To create a new directory or subdirectory to organize files, use the 
Create Directory comma-nd. You must create a directory before you can 
put files 
in it. 

To create a new directory: 

1. Select the Create Directory command from the Special menu. 

MS-Windows displays the Create Directory dialog box. 
Figure 5-2 shows the Create Directory dialog box. 
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Figure 5-2: Create Directory Dialog Box 

Create Directory: I 
~------------------------~ 

( Ok ) (Cancel) 

2. Type the name of the new directory or subdirectory. 

3. Click on the Ok command button. 

A new directory, with the name you entered, is created. The 
new directory name is displayed in the MS-DOS Executive 
window. 

After you create a directory, you can copy files into it using the Copy 
command from the File menu. You can also use an application to create 
new files for the directory. 

Changing How File Names Are Listed 

5-4 

The View menu commands change how file names are listed in the 
MS-DOS Executive window. 

When you first start MS-Windows, the files in the MS-DOS Executive 
window are listed in alphabetical order. The directory names are at the 
top of the list. 

However, you can list files in a different order, such as by size or by 
the date they were created or changed. You can also list files having the 
same file extension. 

To see only files having the same file extension, you must first use the 
Partial command to specify the type of files you want to view. 

To view a partial list of files: 

1. Select the Partial command from the View menu. 

MS-Windows displays the Partial dialog box. Figure 5-3 shows 
the Partial dialog box. 
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Figure 5-3: Partial Dialog Box 

Partial: '-'-~~--------.....1 
( Ok ) (Cancel) 

2. In the text box, type the file names you want to see. 

Use wildcard characters(* or?) to specify the kind of file you 
want to display. For example, to display all file names with the 
file extension .EXE, in the text box, type: 

*.EXE 

3. Click on the Ok command button. 

Displaying Multiple Directories 

Because you can display more than one MS-DOS Executive window at 
a time, you can display two different directories at the same time, one 
directory in each MS-DOS Executive window. 

NOTE 
If you copy or delete files in one directory, there is no change 
to the directory in the inactive MS-005 Executive window. 

To display a second MS-DOS Executive window: 

1. Use the Run command to open the second MS-DOS Executive 
window. 

The file name is MSDOS.EXE. 

2. In the new MS-DOS Executive window, double-click on the 
directory path name you want to display. 

The selected directory is displayed in the second MS-DOS 
Executive window. 

If you display the same directory in multiple windows, only the 
directory in the active window is updated when you create, delete, 
rename, or copy a file. To update the listing in an inactive window, 
move the mouse to that window and click on the highlighted drive icon. 
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Printing a Directory Listing 
To print a directory listing, use the Print command. The directory listing 
is printed as it is displayed in the MS-DOS Executive window. 

To print a directory listing: 

1. Click on the directory name. 

2. Select the Print command from the File menu. 

MS-Windows displays the Print dialog box. 

3. Click on the Ok command button. 

The listing of the selected directory is printed. 

To print the current directory or a directory that is not currently listed: 

1. Select the Print command from the File menu. 

MS-Windows displays the Print dialog box. 

2. In the text box, type the directory specification. 

3. Click on the Ok command button. 

The listing of the specified directory is printed. 

Deleting a Directory 
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To delete a directory, use the Delete command. Before you can delete a 
directory permanently, you must first delete all the files in the directory. 
MS-Windows does not let you delete a directory containing files. This 
protects you from losing files if you try to delete a directory that is not 
empty. 

To delete a directory: 

1. Make the directory to be deleted the current directory. 

2. Select all the file names in the directory. 

3. Select the Delete command from the File menu to delete them. 

4. Move to the parent directory. 

5. Select the directory name and select the Delete command from 
the File menu. 

The selected directory is deleted permanently from the disk. 
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r-, Working with Disks and Diskettes 
You can use the MS-DOS Executive window to: 

• Prepare diskettes for storing data 

• Name a diskette 

• Display the contents of a disk 

These examples describe working with diskettes. If you want to work 
with a virtual disk, you must first be connected to the virtual disk. 

Preparing a Diskette for Storing Data 

Before you can use a diskette, you must prepare it as a data diskette 
or a system diskette. A data diskette is a blank formatted diskette for 
storing data. A system diskette contains the files necessary for starting 
the MS-DOS operating system. You cannot format hard disks with 
MS-Windows. For more information on formatting a hard disk, see the 
MS-DOS Reference Guide or the DOS reference manual that comes with 
your DOS software. 

To prepare a diskette so it can be used on your workstation, use the 
Format Data Disk command. 

Preparing a Data Diskette 
To make a data diskette: 

1. Insert the new diskette in the disk drive of your workstation. 

2. Select the Format Data Disk command from the Special menu. 

MS-Windows displays the Format Data Disk dialog box. 
Figure 5-4 shows the Format Data Disk dialog box. 

3. Click on the option button of the disk drive containing the r.ew 
diskette. 

4. Click on the Ok command button. 

The system displays a warning that any data on the diskette in 
the drive will be destroyed. 

5. Click on the Ok command button to continue or click on the 
Cancel command button to stop. · 
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Figure 5-4: Format Data Disk Dialog Box 

Select driue to format 

C!> A 

( Ok ) f Cancel) 

The Format Data Disk command in the MS-DOS Executive Special 
menu always formats to the highest capacity of the drive. 

To format diskettes of any densities, use the FORMAT command 
in the MS-DOS Executive File menu Run option. Respond to the 
prompts with the appropriate parameters. For more information on 
the FORMAT command, see the MS-DOS Reference Guide or the DOS 
reference manual that comes with your DOS software. 

Preparing a System Diskette 
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A system diskette contains the files necessary for starting the MS-DOS 
operating system. 

To prepare a system diskette: 

1. Prepare a diskette by using the Format Data Disk command. 

2. Ensure the new diskette is in the disk drive to which you want 
to copy. 

3. Select as your current drive a drive that contains the system 
files. 

4. Select the Make System Disk command from the Special menu. 

MS-Windows displays the Make System Disk dialog box. 

5. Click on the option button of the disk drive to which the 
MS-DOS system files are to be copied. 

6. Click on the Ok command button. 



Working with Directories and Disks 

Copying starts when you click on the Ok command button. 
While the MS-DOS system files are being copied, the dialog box 
remains on the screen and the arrow changes to an hourglass. 

When complete, the dialog box is removed from the screen, and 
the hourglass changes to the arrow. 

Naming Disks 
To assign a volume name to a diskette, use the Set Volume Name 
command. The volume name identifies the contents of the disk. 

To name a disk: 

1. Click on the symbol of the disk drive containing the disk you 
want to name. 

2. Select the Set Volume Name command from the Special menu. 

MS-Windows displays the Volume Name dialog box, containing 
the current name if any exists. Figure 5-5 shows the Volume 
Name dialog box. 

Figure 5-5: Set Volume Name Dialog Box 

Uolurne Harne: I 
~----------------------------~ 

( Ok J (Cancel) 

3. In the text box, type a name. Only the first twelve characters are 
accepted. 

4. Click on the Ok command button. 

The new volume name for the disk is displayed to the right of 
the drive letter in the path name. 
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Displaying the Contents of Another Disk 
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To display the contents of another disk, click on the symbol of the disk 
drive you want to display. 

The file names of the selected drive are listed in the MS-DOS Executive 
window. You can change the default directory by selecting a new 
directory on the drive. 

CAUTION 
When you display the contents of another directory or drive, 
you change the default directory or drive. When you run an 
application, its default drive and directory become the default 
drive and directory of the MS-DOS Executive window from 
which you invoked it. If the new default drive is read-only, 
you cannot save files, and your application cannot write 
temporary files to it. 

Each copy of the MS-DOS Executive window acts independently of the 
other, so you can display and work with different directories and drives 
in each window. 
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Using the Keyboard 

• Select menus and commands 

• Load an application 

• Run an application 

• Finish an application 

• Scroll a window 

• Work with files 

• Use more than one window 

• Print screen images 

Keyboard Features 
In the previous chapters, you used the mouse to perform the actions 
available to you in MS-Windows. This chapter describes how to use 
the keyboard to perform those same actions. Because details about 
the MS-Windows functions are given in previous chapters, they are not 
repeated here. 
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Table 6-llists the keys you use most often with MS-Windows. Look at 
your keyboard and identify the keys listed in Table 6-1. 

Table 6-1: MS-Windows Keys 

Keys MS-Windows Function 

AJt Lets MS-Windows know you want to select a command 
using the keyboard. If you release the AJt key before you 
press another key, nothing happens. It also modifies the 
meaning of certain keys used with MS-Windows. 

Arrow Moves the highlight in the menus and in the MS-DOS 
Executive window in the same direction as the arrow: up, 
down, right, left. 

Alphabet (A-Z) 

Ctrl/Arrow 

Ctri/Break 

Return 

Esc 

Spacebar 

Moves the highlight in the menus and in the MS-DOS 
Executive window. For example, when you are in the 
MS-DOS Executive window and you press the C key, the 
highlight moves to the first file name beginning with the 
letter C. If you press the C key again, the highlight moves 
to the next file name beginning with the letter C, and so 
on. 

Moves the cursor without making any selections, such as 
moving the highlight over the file names in the MS-DOS 
Executive window. 

Selects the Cancel command button in a dialog box. 

Runs the selected (highlighted) application file name, or 
performs the highlighted command in menu. 

Selects the default command button in a dialog box and 
overrides any selected command in the dialog box. (See 
Spacebar) 

Cancels a command if you press it before you press the 
Return key, or before you click on the Ok command button 
in a djalog box. 

Removes a menu or a dialog box from a window. The Esc 
key is equivalent to the Cancel command button in most 
dialog boxes. 

Selects and cancels selected check boxes. (Toggles check 
boxes on and off.) 

Selects the underscored command button in a dialog box; 
needed to override the default. (See Return) 
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Table 6-1 (Cont.): MS-Windows Keys 

Keys 

AI t/ spacebar 

Shift 

Shift/Tab 

Alt/Shift/Tab 

Shift/arrow 

Shift/Return 

Tab 

Word Char 

MS-Windows Function 

With the Alt key, the spacebar displays the commands in 
the System menu. 

Used with the Tab key, the Alt/Tab keys, the arrow keys, or 
the Return key to change their function, as follows: 

Used with the Tab key, Shift changes the direction of the 
cursor movement in a dialog box from left-to-right and 
top-to-bottom to right-to-left and bottom-to-top. 

Used with the Alt/Tab keys, Shift changes the direction of 
window and icon selection from left-to-right and top-to­
bottom to right-to-left and bottom-to-top. 

Used with the arrow keys, Shift allows multiple selection of 
file names in the MS-DOS Executive window. 

Used with the Return key, Shift loads into memory the 
application represented by the highlighted file name in the 
MS-DOS Executive window and displays its icon in the icon 
area. 

Moves the cursor between items in a dialog box. 

Selects an icon, a window, or a dialog box when used with 
the Alt key. 

When used in a text box, deletes a character to the left of 
the insertion point each time it is pressed. 

When used in the MS-DOS Executive window, changes the 
current directory to the next higher directory. 

Using the Alt Key 
The Alt key lets MS-Windows know you want to select a command. You 
can use the Alt key in several ways: 

• If you press the Alt key and release it before you press another 
key, nothing happens. 

• If you hold down the Alt key, select a menu, then release the 
Alt key before highlighting a command, the menu remains 
displayed. You can then highlight a command and press the 
Return key (or the Alt key) to perform the command. To close 
the menu, press the Esc key. 
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• If you hold down· the Alt key, select a menu, highlight a 
command, then release the Alt key, MS-Windows performs 
the command immediately. 

The next sections show examples of using the Alt key when working 
with menus. 

Using Menus and Commands 
Using the keyboard, you can select menus and commands. 

Selecting a Menu 
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To select a menu with the keyboard: 

1. Press and hold the Alt key. 

2. Press the spacebar. 

MS-Windows displays the System menu. 

3. Release the Alt key. 

4. To select another menu, press the right arrow key until the 
menu you want is selected. 

Each time you press the right arrow key, the next menu to the 
right is selected, and its commands are displayed. Similarly, 
if you press the left arrow key, the next menu to the left is 
selected, and its commands are displayed. 

To select a menu, you can also: 

1. Press and hold down the Alt key. 

2. To display a menu, press the initial letter of the menu name you 
want. To display the System menu, press the spacebar. 

If more than one menu starts with the same initial letter, use the 
right or left arrow keys to move from the highlighted menu to 
the menu you want. 



Selecting a Command from a Menu 
To select a command from a menu: 

1. Press and hold down the Alt key. 

2. Press the spacebar. 

MS-Windows displays the System menu. 

3. Release the Alt key. 

Using the Keyboard 

4. To display the commands of another menu, press the right or 
the left arrow key until the menu you want is displayed. 

5. Press the initial letter of the command you want, or press the 
down arrow key until the highlight moves to the command you 
want. 

When you press the initial letter of the command, the highlight 
moves to the first command with the initial letter you pressed. 
If two commands start with the same letter, press the letter twice 
to move the highlight to the second command. 

The highlighted command is selected. 

6. Press the Return key. 

The command you selected is performed. 

You can cancel a command or remove a menu by pressing the 
Esc key. However, you must do this before you press the Return 
key. 

To select a command from a menu, you can also: 

1. Press and hold down the Alt key. 

2. Press the initial letter of the menu you want to select (to display 
the System menu, press the spacebar). Continue to hold down 
the Alt key. 

3. Press the initial letter of the command you want. 

When you press the initial letter of the command, the highlight 
moves to the first command with the initial letter you pressed. 
If two commands start with the same letter, press the letter twice 
to move the highlight to the second command. 

The highlighted command is selected. 
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4. Release the Alt key. 

The command you selected is performed. 

You can cancel a command or remove a menu by pressing the 
Esc key. However, you must do this before you release the Alt 
key. 

Loading an Application 
To load an application as an icon using the keyboard, use: 

• The Load command 

• The file name 

Using the Load Command 
To load an application using the Load command: 

1. Select the Load command from the File menu. 

MS-Windows displays the Load dialog box. 

2. In the dialog box, type the file name of the application you want 
to load. 

Also type any additional information needed, such as path name 
or program parameters. 

3. Select the Ok command button by pressing the Return key. 

The application you select loads as an icon in the icon area. 

Using the File Name 
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To load an application using the file name: 

1. Press the up arrow or down arrow key until the file name of the 
application you want is highlighted. 

2. Press and hold down the Shift key. 

3. Press the Return key. 

The selected application loads as an icon in the icon area. 
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Running an Application 
To run an application in a window using the keyboard, use: 

• The Icon command 

• The Move command 

• The Run command 

• The file name 

Using the Icon Command 

To expand an icon into the work area using the Icon command: 

1. Press and hold down the Alt key. 

2. Press the Tab key until the icon you want is highlighted. The 
name of the application is displayed above the highlighted icon. 

3. Press the spacebar. 

4. Release the Alt key. 

5. Select the Icon command from the System menu, and press the 
Return key. The icon you selected expands into a window in the 
work area. 

When you use the Icon command, you have little control over exactly 
where the icon expands into a window in the work area. Where it 
expands depends on how many windows are already in the work area 
and the arrangement of those windows. To control where the icon 
expands into a window in the work area, use the Move command. 

Using the Move Command 

The Move command provides more control over where the icon 
expands into the work area. 

To expand an icon into the work area using the Move command: 

1. Press and hold down the Alt key. 

2. Press the Tab key until the icon you want is highlighted, 
indicating it is selected. 

3. Press the spacebar. 

4. Release the Alt key. 
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5. Select the Move command from the System menu, and press 
the Return key. The icon you selected is displayed in the work 
area above the icon area. 

6. Press the arrow keys until the icon is where you want the 
window to be displayed. 

7. To complete the move, press the Return key. The window 
expands where you positioned its icon. 

Using the Run Command 
To run an application using the Run command: 

1. Select the Run command from the File menu. 

MS-Windows displays the Run dialog box. 

2. In the dialog box, type the file name of the application you want 
to run. 

Also type any additional information needed, such as path name 
or command line argument. 

3. Select the Ok command button by pressing the Return key. 

The application you select runs in a window. 

Using the File Name 
To run an application using the file name in the MS-DOS Executive 
window: 

1. Press the up arrow or down arrow key until the application file 
name is highlighted. 

2. Press the Return key. 

The selected application is displayed in the work area, replacing 
the MS-DOS Executive window. 

Finishing an Application 
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When you finish using an application in the work area, you can remove 
it by using the Icon command or the Close command. If you use 
the Icon command, the application continues to run, but it is in the 
icon area. However, if you use the Close command, the application 
is removed from the work area, stops running, and is removed from 
memory, but the application remains on the disk. 
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Shrinking an Application to an Icon 
To remove an application temporarily from the work area, use the Icon 
command to shrink the application to an icon in the icon area. 

To shrink an application to an icon: 

1. Press and hold down the Alt key. 

2. Press the Tab key until the application you want is highlighted. 

3. Press the spacebar, but continue to hold down the Alt key. 

4. Select the Icon command from the System menu. 

5. Release the Alt key. 

The window you selected shrinks to an icon in the icon area. 

Closing an Application 

When you finish using an application and want to remove it from 
memory, use the Close command. 

To close an application: 

1. Press and hold down the Alt key. 

2. Press the Tab key until the application you want is highlighted. 

3. Press the spacebar, but continue to hold down the Alt key. 

4. Select the Close command from the System menu. 

5. Release the Alt key. 

The window you selected closes, the application is removed 
from memory, but the application remains on the disk. 
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Using a Dialog Box 
To supply information to a dialog box, you move the cursor to items 
in the dialog box. The flashing underscore shows the location of the 
cursor, and identifies the active component in the dialog box. Table 6-2 
describes the keyboard procedures for moving the cursor in a dialog 
box. 

Table 6-2: Moving the Cursor In a Dialog Box 

To move the cursor ..• 

In the dialog box 

In a group of check boxes 

In a group of option buttons 

(Insertion point) in a text box 

From the text box to the list box 

In a list box 

Press ... 

Tab key or Shift/Tab keys 

Arrow keys, Tab key, or Shift/Tab keys 

Arrow keys 

Arrow keys 

Tab key 

Arrow keys 

Selecting Options in a Dialog Box 

To select an option in a dialog box with the keyboard: 

1. Move the cursor to the option you want to select, such as the 
check box, option button, or command button, as explained in 
Table 6-2. 

2. Press the spacebar. 

The option is selected. 

Selecting Command Buttons in a Dialog Box 
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There are alternative ways to select the default command button (usually 
the Ok c~mmand button) and the Cancel command button. The default 
commands buttons have bold borders. 

To select the default command button in a dialog box, press the Return 
key. 

MS-Windows performs the default command and removes the dialog 
box from the window. 
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To select other command buttons, press the Tab key to move to the 
desired button. An underline is displayed under the selected button. 
To use the command button, press the spacebar. 

To select the Cancel option in a dialog box, press Ctrl/Break. 

The command represented by the dialog box is canceled, and the dialog 
box is removed from the window. 

Closing a Dialog Box 
You usually do not have to close a dialog box, because it is removed 
when you select the Ok or Cancel command button. However, if a 
dialog box has no Ok or Cancel command button and has a System 
menu box in the title bar, you can use the Close command of the 
System menu to close the dialog box. You can also use the Esc key to 
close most dialog boxes. 

Scrolling a Window 
How an application scrolls using the keyboard depends on the 
application. 

You can also use the keyboard to scroll in the MS-DOS Executive 
window. When you scroll in the MS-DOS Executive window, you move 
the highlight from one file name to another. 

Figure 6-1 shows the two sets of keys you can use for scrolling the 
MS-DOS Executive window: one set in the cursor keypad, and one set 
in the numeric keypad. The keys in the numeric keypad are available 
only when the Num Lock feature is not selected (the Num Lock light is 
off). Table 6-3 describes scrolling the MS-DOS Executive window with 
the keyboard. 
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Table 6-3: Keyboard Scrolling in the MS-DOS Executive Window 

To scroll .•• 

Down one file name 

Up one file name 

Right one file name 

Left one file name 

Down one page in the directory 

Up one page in the directory 

Press ••• 

Down arrow key 

Up arrow key 

Right arrow key 

Left arrow key 

Pg On key 

Pg Up key 

Figure 6-1: Keys Used for Scrolling 
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Working with Files 

Selecting Files 

You can select: 

• One file 

• A block of files 

• Scattered files 

Selecting One File 

To select a file in the MS-DOS Executive window, use: 

• Arrow keys 

Press the arrow keys until the file name you want is highlighted. 

• Alphabet keys 

Press the first letter of a file name. 

The highlighted file name is selected. 

For example, if you press S, the first file name beginning with S 
is highlighted. Press S again to highlight the second file name 
beginning with S, and so on. 

If no more files begin with the letter, the last file remains 
selected. 

Canceling One Selected File 

To cancel a selected file with the keyboard, press the spacebar. 

The highlight changes to an underscore, showing the file is no longer 
selected. 

If you press the spacebar again, the file becomes selected again. 

Selecting a Block of Files 

To select a block of files: 

1. Press the down arrow key until the first file you want is 
highlighted. 

2. Press and hold down the Shift key. 
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3. To select other files, move the highlight by pressing the arrow 
keys. 

The file names are selected as the highlight moves across them. 

4. Release the Shift key after you select all the files you want. 

All the file names you selected are highlighted. 

Selecting Scattered Files 

To select scattered files: 

1. Press the down arrow key until the first file you want is 
highlighted. 

2. Press and hold down the Ctrl key. 

3. To move the underscore across files you do not want to select, 
continue to hold down the Ctrl key, and press the arrow keys, 
until the underscore is under the next file you do want to select. 

4. Press the spacebar. 

The highlighted file is selected. 

5. Select all the files you want by repeating steps 3 and 4. 

6. After you select all the files you want, release the Ctrl key. 

All the file names you selected are highlighted. 

Using More Than One Window 
You can display more than one window at a time, but only one window 
can be the active window. 

Switching Windows 
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To switch to another window: 

1. Press and hold down the Alt key. 

2. Press the Tab key until the title bar of window you want to 
switch to is highlighted. 

Each time you press the Tab key, the title bar of the next 
window or icon, from top-to-bottom and left-to-right, is 
highlighted. 

3. Release the Alt key and the Tab key. 
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The window you switched to is now the active window. Any 
commands you select or any other information you enter with 
the mouse or the keyboard affect that window. 

You can reverse the direction the highlight moves if you type the 
Shift/Alt/Tab sequence. You can move the highlight from bottom-to-top 
and right-to-left if you press and hold down the Shift key before you 
press the Tab key. 

Changing the Size of a Window 

You can change the size of a window using commands from the System 
menu. 

Making a Window Larger or Smaller 

To make a window larger or smaller: 

1. Switch to the window you want to make larger or smaller. 

2. Select the Size command from the System menu. 

The cursor changes to the size box. 

3. Move the size box to the window border by pressing the arrow 
keys. 

Continue pressing the arrow keys to move beyond the window 
border to the size you want. A line shows where the new 
window's border is located. 

To make the window smaller, you must move the size box 
beyond the window border and back inside the window border. 

4. Press the Return key. 

MS-Windows changes the size of the window and adjusts the 
size of any adjacent windows. 

Making a Window Fill the Entire Screen 

To zoom a window so that it fills the entire screen: 

1. Switch to the window you want to fill the entire screen. 

2. Select the Zoom command from the System menu. 

The window you selected zooms and fills the entire screen 
including the icon area. 
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To zoom a window, you can also: 

1. Switch to the window you want to fill the entire screen. 

2. Press the Alt/Return keys. 

The window you selected zooms and fills the entire screen 
including the icon area. 

To return the window to its former size: 

• Use the Zoom command again. 

• Press the Alt/Return keys to restore the window to its former 
size. 

Moving a Window 
To move a window to another position in the work area: 

1. Switch to the window you want to move. 

2. Select the Move command from the System menu. 

MS-Windows displays the icon of the application in the middle 
of the window. 

3. Press the arrow keys until the icon is where you want the 
window to be moved. 

4. Press the Return key. 

The window is moved to the position you selected. 
MS-Windows adjusts the size of the other windows in the work 
area. 

Receiving Messages From Another Application 
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To see a message sent by another application, switch to the window 
whose title bar is flashing or to the flashing icon: 

1. Hold the Alt key and press the Tab key until the window or icon 
of the application sending you the message is highlighted. 

2. Release the Alt key. 

The message is displayed when you switch to the window or 
icon of the application sending you the message. 
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Printing Screen Images 
With MS-Windows, you can send the information displayed on the 
screen to LPTl. To print a screen, the GRAPHICS/R command must be 
loaded and run before MS-Windows starts. The key diskette runs 
the GRAPHICS command for you. For more information on the 
GRAPHICS/R command see the MS-DOS Reference Guide or the DOS 
reference manual that comes with your DOS software. 

To print your screen: 

1. If you are using a local printer, be sure your printer is attached 
and on line, and that LPTl is redirected to your printer. 

2. Ensure the screen contains the information you want printed. 
Everything displayed on the screen is printed. 

3. Press Shift/Prt Sc. 

The screen is printed. This operation may take a few minutes. 

NOTE 
Do not press Shift/Prt Sc if LPTl is being used by another 
application. 

When running a standard application, the following message can display 
when you try to print the screen from an application: 

Not enough disk space for screen exchange 

MS-Windows cannot save the screen image because an error occurred 
while it was writing the file or because the drive was read only. 
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Chapter 7 
Running Standard Applications 

This chapter describes how to: 

• 
• 
• 
• 
• 

Run standard applications in a window 

Run standard applications outside a window 

Transfer information between standard applications 

Run large standard applications 

Run special applications 

Working with Standard Applications 
A sta11dard applicatio11 is an application (with a .EXE, .BAT, or .COM 
extension) that you can use with MS-Windows, even though it was not 
designed for this use. (MS-Windows applications, such as Notepad and 
Clock, are specifically designed to be used with MS-Windows.) 

When you run a standard application with MS-Windows, you continue 
to use the commands and functions of the application. For many 
standard applications, MS-Windows lets you run several applications 
and switch from one application to another. 

Many standard applications can run in a window, sharing the work area 
with other applications in their own windows. However, some standard 
applications require the entire screen and run outside a window. 
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Whether a standard application runs in a window depends on how it: 

• Uses memory 

• Processes input/output (110) activities 

When an application runs on your workstation, it processes 1/0 activities 
that use the workstation resources. These resources include: 

• Computer memory 

• Communications ports 

• Video display screen 

• Keyboard 

If a standard application ·uses standard MS-DOS supplied 110 
procedures and memory allocation, it can run in a window, because 
MS-Windows emulates the 110 activities that are compatible for 
MS-DOS. 

If a standard application does not use standard MS-DOS supplied 
110 procedures or standard memory allocation, it cannot run in a 
window, because MS-Windows cannot provide the interface for 110 
activities. These standard applications provide their own interface for 
110 activities. 

NOTE 
Standard applications must run under MS-DOS Version 3.10 
or later to run fl"Om MS-Windows. 

Using Program Information Files 
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A program information file (PIF) contains information about how 
a standard application uses workstation resources. The system 
administrator enters this information into a PIF for the standard 
application, and the information is used by MS-Windows. Each 
standard application you use should have a PIF associated with it. 

Included with your MS-Windows software package are PIFs for many 
standard applications. If you try to run an application that has no PIF, 
MS-Windows uses default settings for the resources. However, the 
system administrator should create a PIF for the application. 

An application can have more than one PIF associated with it. For 
example, you can have two versions of the same application. One 
version can require a large amount of memory, because you use all 
the features of the application, while another version can require less 
memory, because you use only a few features. 
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Some applications require more than one PIF. Each file with a .EXE, 
.COM, and .BAT extension that an application runs must have a PIF 
associated with it. 

If you are running a batch file (an application with a .BAT extension) that 
redirects 1/0, you must set the Directly Modifies Screen option in the 
application PIF file and run the batch file from the MS-DOS Executive 
window. See Appendix B for more information on creating PIFs for 
standard applications. 

NOTE 
You should not run a batch file from a COMMAND.COM 
window if the file includes redirected l/0 or piping. 

You can run an application by selecting its PIF in the MS-DOS Executive 
window. When you select the PIF, MS-Windows loads and runs the 
application named in the PIF. 

Running a Standard Application 

You run a standard application that runs in a window as you run 
MS-Windows applications, such as Calculator and Notepad. 

NOTE 
When you run a standard application in a window, the 
Special light in the top right of the keyboard can turn on and 
off. This means the keyboard is automatically changing modes 
accorcUng to the needs of the application. 

Shrinking a Window 

You shrink a standard application that runs in a window as you 
shrink MS-Windows applications, such as the Information System 
and Notepad. 

Most icons for standard applications are a plain rectangle containing 
a three-letter abbreviation for the application. However, some 
applications have custom icons that are graphic representations of 
the application. 

NOTE 
When you drag the icon of any standard application, it 
becomes a plain rectangle, resembling the Clock icon when it 
is dragged. 
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Closing a Window 
To dose a standard application running in a window: 

1. Use the Exit command of the application. 

This ensures a normal ending of operations for the application. 

NOTE 
Standard applications have a Quit command, an 
End command, or some other command that is 
equivalent to the Exit command; see your application 
documentation for using them. 

2. Observe and note any information the application displays in 
the window. 

Some standard applications display information for you to look 
at or copy. Observe the name of the application displayed in 
the title bar with parentheses around it, indicating you have 
successfully exited from the application and it has stopped 
running. 

3. Select the Close command from the System menu. 

The standard application stops running, the window closes, and 
the standard application is removed from memory. 

An option in the PIF allows a standard application window to 
close when you exit the standard application. If you include this 
option in the PIF, the window automatically closes when you use 
the standard application's exit command. For more information 
on the Close or Exit option, see Appendix B. 

Scrolling a Window 
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If your standard application runs in a window, MS-Windows adds the 
Scroll command to the System menu of the application. 

To scroll a standard application, you use: 

• The Scroll command from the System menu 

• The commands and keys built into your standard application 

If using the Scroll command, you must use the keyboard to scroll. The 
Scroll command is independent of the commands already built into 
your standard application. 
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The keys you use have two functions: their normal function and their 
scrolling function. Press the Esc key to use the normal function. Press 
the Esc key again to use the scrolling function. 

If using the built-in commands and keys, use the mouse to scroll. See 
the application documentation for information on what these commands 
and keys are. 

Table 7-1 shows the keys used for scrolling standard applications that 
run in a window. 

Table 7-1: Scrolling Standard Applications That Run in a Window 

To scroll ••. 

Up one line 

Down one line 

Left one character 

Right one character 

Up one screen 

Down one screen 

Left one screen 

Right one screen 

Press ... 

Up arrow key 

Down arrow key 

Left arrow key 

Right arrow key 

Pg Up key 

Pg Dn key 

Home key 

End key 

Finishing an MS-Windows Session 

You cannot finish an MS-Windows session while a standard application 
is still running. You must exit from all standard applications before you 
can end your MS-Windows session. 

If you try to end your MS-Windows session while a standard application 
is still running, MS-Windows displays a dialog box, showing a message 
that a standard application is still active. The name of the active 
standard application is displayed in the title bar of the dialog box. 
When you see this dialog box, use the Exit command of the application. 

Any standard application running as an icon must also be closed before 
you try to end your MS-Windows session. For each standard application 
running as an icon, you must expand the icon into a window and use 
the Exit command of the application. 
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Running Multiple Standard Applications 
You run multiple standard applications the same as MS-Windows 
applications, such as the Information System and Notepad. 

Running Standard Applications Outside a Window 
Some standard applications require exclusive use of the screen and 
cannot run in a window. When you run this kind of application, you no 
longer seeMS-Windows features, such as the title bar, the menu bar, 
and the icon area. 

When you run a standard application outside a window, 
MS-Windows temporarily removes itself from the screen. You can use 
the application's commands and functions, but you cannot use all of 
MS-Windows' functions. 

Starting an Application That Runs Outside a Window 
You start a standard application that runs outside a window the same as 
you start other applications. You can: 

• Expand the icon 

• Select the Run command from the File menu of the MS-DOS 
Executive window and type the file name and path name, if 
needed 

• Select the file name in the MS-DOS Executive window 

When you start a standard application that runs outside a window, it 
fills the entire screen. Any applications that are displayed on the screen 
are removed. They return to the screen after you finish the application 
and return toMS-Windows. 

Returning to MS-Windows 

7-6 

To return toMS-Windows from a standard application that runs outside 
a window, you can use: 

• The application's Exit command 

All applications use this method. 

• Alt/Tab keys 

Some applications use this method, depending on how they 
use certain workstation resources, as specified in each standard 
application's PIF. 
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For example, the Alt/Tab keys cannot be used to switch 
windows if the Program Switch option is set to Prevent in 
the application's PIF. For information on the Program Switch 
option, see Appendix B. 

After you close the standard application, switch to the application that 
was running previously. 

To run the standard application again, expand its icon. 

Transferring Information 
To transfer information between applications that run in windows, use: 

• Added System menu commands: 

Mark 

Copy 

Paste 

These commands are only used with standard applications 
that run in a window, because only standard applications 
have a System menu. 

• Alt/Prt Sc keys 

To transfer information from an application that runs outside a window, 
use the Alt/Prt Sc keys. 

Marking Information to be Transferred 

Before you can transfer information, you must mark (select) it, using the 
mouse or the keyboard. 

To use the mouse to mark information: 

1. Point to the beginning of the area you want to transfer. 

2. Drag the cursor across the area of the window you want to 
transfer. 

As you drag the cursor across the window, the selected 
information is highlighted. 

3. Release the mouse button. 

The information you want to transfer is now marked. 
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To use the keyboard to mark information: 

1. Select the Mark command from the System menu. 

A rectangular cursor is displayed at the upper-left corner of the 
window. 

2. Press the arrow keys to move the cursor to the beginning of the 
area you want to transfer. 

3. Press and hold down the Shift key. 

4. Press the arrow keys to define the area you want to transfer. 

The block of information you marked for transfer is highlighted. 

To cancel the selected area, press the Esc key, or the Return 
key. This removes the highlighting on the block of information 
you selected. 

5. Release the Shift key. 

The information you want to transfer is now marked. 

For example, to select a paragraph: 

1. Move the cursor to the first character of the paragraph. J 
2. Press and hold down the Shift key. 

3. Press the right arrow key to go to the end of the line, then press 
the down arrow key to go to the last line of the paragraph. 

4. Release the Shift key. 

After you mark the information, you transfer it to the Clipboard using 
the Copy command. 

Copying Information to the Clipboard 
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You must copy information to the Clipboard before you can transfer 
it to an application. To transfer marked information to the Clipboard, 
select the Copy command from the System menu. 

The information you marked is copied to Clipboard. You insert this 
information into another location using the Paste command. 
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Pasting Information 

After the information has been copied to the Clipboard, you can transfer 
it to another location using the Paste command. You can paste the 
information to: 

• Applications designed to work with MS-Windows 

For example, you can paste text screens to Notepad and 
graphics screens to MS-Paint. 

• Standard applications that run in a window 

You can paste all or part of an application that runs in a 
window. 

When you paste information to a terminal emulator, you must first 
enable HOSTSYNC under VMS by typing: 

$ SET TERMINAL/HOSTSYNC [Return[ 

This command prevents loss of characters due to data overruns. 

You cannot paste: 

• Information from the Clipboard to an application that runs 
outside a window 

• Graphics information from the Clipboard to any standard 
application (inside or outside a window) 

NOTE 
Text is stored in its character (ASCII) representation. When 
you use the Copy or Paste commands, the text is also 
transferred in this character representation. 

To use the Paste command: 

1. Switch to the window into which you want to paste the 
information. 

2. Move the cursor where you want to insert the information. 

3. Select the Paste command from the System menu. 

The selected text is inserted in your application at the cursor 
location. 
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Using the Prt Sc Key 

You can also transfer information to the Clipboard by using the 
Alt/Prt Sc keys. To copy a standard application's window to the 
Clipboard: 

1. To copy from a standard application that runs in a window, 
make sure the window is the active window. (Switch to the 
window you want to copy if it is not the active window.) 

2. Press ·the Alt/Prt Sc keys. 

For a standard application that runs outside a windo~, the 
screen contents are copied to the Clipboard. For a standard 
application that runs in a window, the active window is copied, 
as if it filled the entire screen, to the Clipboard. Other windows 
in the work area are not copied. 

A block of information, 80 columns by 25 lines, is transferred 
from the selected window to the Clipboard, regardless of the 
number of columns and lines displayed in the window. 

After the information has been copied to the Clipboard, you can paste 
it to other applications with the Paste command. 

Running Large Standard Applications 
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To run multiple standard applications efficiently, run the largest 
application first. 

If you run more than one application and try to run a new application 
that requires more memory than is available, MS-Windows displays the 
message "Not enough memory to run." 

If you see this message, close an application that you do not currently 
need and try to run the standard application again. 

If you are closing a standard application, you should first use the Exit 
command of the application. 

The application runs after enough memory has been freed by closing 
other applications. If the MS-DOS Executive window is the only 
application running, the application you selected runs because 
MS-Windows and the MS-DOS Executive application step aside and 
give the application most of the available memory. A small amount of 
memory is retained for restoring MS-Windows. 
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When you finish using the large application, dose it. After you close the 
application, the MS-DOS Executive window returns to the work area. 
Any application defined in the WIN .INI file to load or run is started. 

NOTE 
Do not use a large standard application in the WIN.INl file's 
RUN= line. 

Running Special Applications 
Some applications remain in memory even after exiting the application. 
These special applications are sometimes called memory resident, 
terminate and stay resident, or pop-up programs. 

You must load special applications before you start MS-Windows. 

You run special applications from MS-DOS outside MS-Windows. You 
can also run special applications while using standard applications that 
both: 

• Do not run in a window 

• Have Directly Modifies Memory set in their PIPs 

You cannot run special applications from COMMAND.COM in 
MS-Windows. 

NOTE 
The PIF for a special application should have the Directly 
Modifies Memory option enabled. If you then try to run 
a special application, a system warning displays. Select 
CANCEL. If you select Ok, the special application can cause 
system problems. 

Some special applications prevent you from switching back to 
MS-Windows. To return toMS-Windows, stop the special application 
by using its EXIT command. 
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Chapter 8 
Using the Control Panel 

This chapter describes how to use the Control Panel application to: 

• Change the date and time 

• Change the mouse cursor blink rate 

• Change the mouse double-click rate 

• Add and remove printers 

• Add and delete display fonts 

• Change printer ports 

• Change the default printer and its output modes 

• Change communications ports 

• Change network terminal services 

• Change screen shades 

• Change keyboard settings 

• Exchange mouse button functions 

• Change country settings 
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Running the Control Panel 
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The Control Panel is an application that lets you change the settings for 
MS-Windows. MS-Windows saves the Control Panel changes you make 
in the WIN.INI file, which is stored in your personal directory. Each 
time MS-Windows starts, it uses the settings in the WIN.INI file. For 
more information on the WIN.INI file, see Appendix A. 

To run the Control Panel: 

1. In the MS-DOS Executive window, select the Run command 
from the File menu. 

The MS-DOS Executive window displays the Run command 
dialog box. 

2. In the dialog box, type: 

CONTROL I Return I 

The MS-DOS Executive window displays the Control Panel 
window with a dialog box in the window and three menu names 
in the menu bar. Figure 8-1 shows the Control Panel window. 

Figure 8-1: Control Panel Window 
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Using the Control Panel Dialog Box 
The Control Panel dialog box, in the center of the window, lets you 
change: 

• Time 

• Date 

• Cursor blink rate 

• Double-click rate 

The three menu names in the menu bar are: 

• Installation 

• Setup 

• Preferences 

Changing the Time 

The time you set from the Control Panel is used in many applications, 
such as Clock or Calendar. 

To change the time using the mouse: 

1. Click on the part of the time (hours, minutes, or seconds) you 
want to change. Figure 8-2 shows changing the time. 

Figure 8-2: Changing the Time 
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The part of the time you selected is highlighted. An up arrow 
and a down arrow are displayed to the right of the time. 

The Clock does not advance while the cursor is on any part of 
the time display. 
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2. Click on the up arrow to increase the number; click on the down 
arrow to decrease the number. 

To change the time using the keyboard: 

1. Press the Tab key to move the cursor, displayed as an 
underscore, to the Time section. 

2. Press the right arrow and left arrow keys to highlight the part of 
the time (hour, minutes, or seconds) you want to change. 

The selected time is highlighted. An up arrow and a down 
arrow are displayed to the right of the time. 

The Clock does not advance while the cursor is on any part of 
the time display. 

3. Press the up arrow key to increase the number; press the down 
arrow key to decrease the number. 

Changing the Date 
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You change the date the same way that you change the time. 

To change the date with a mouse, click on the part of the date (month, 
day, or year) you want to change, then use the same procedure as for 
changing the time. Figure 8-3 shows changing the date. 

Figure 8-3: Changing the Date 
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To change the date with the keyboard, press the Tab key to move the 
cursor, displayed as an underscore, to the Date section, then use the 
same procedure as for changing the time. 
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Changing the Cursor Blink Rate 

Some applications have a cursor that blinks. The cursor is usually an 
underscore or insertion point that blinks. The blink rate is the frequency 
at which the cursor flashes. 

To change the cursor blink rate with the mouse, move to the Cursor 
Blink section and do one of the following: 

• Click on the right or left scroll arrow. 

The scroll box moves as you click on an arrow. 

• Drag the scroll box within the scroll bar to the right or to the 
left. 

The vertical cursor below the scroll bar shows the new cursor 
blink rate. As you scroll, the blink rate of the vertical cursor 
changes. The farther right you scroll, the faster the cursor 
blinks. The cursor blink rate stays in effect until you change it 
again. 

To change the cursor blink rate with the keyboard: 

1. Press the Tab key to move the cursor to the Cursor Blink section. 

2. Press the left arrow or the right arrow key to scroll to the setting 
you want. 

Changing the Mouse Double-Click Rate 

You can double-click to use many commands. MS-Windows interprets 
this action either as a double-click or as two individual clicks, depending 
on how soon one click follows another. If you do not double-click fast 
enough, MS-Windows interprets the action as two individual clicks of 
the left mouse button, instead of a double-click. 

To change the mouse double-click rate, do one of the following: 

• Click on the right or left scroll arrow in the Double-Click section. 

• Drag the scroll box within the scroll bar. 

The farther right you scroll, the faster MS-Windows expects a 
double-click. 

You can test the new double-click setting by double-clicking on the 
TEST button in the dialog box. If MS-Windows interprets your clicking 
as a double-dick, the TEST button shade changes from dark to light, 
or from light to dark. If the TEST button shade does not change, try 
double-clicking faster or reducing the double-click rate. 
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Using the Installation Menu 
The Installation menu has four commands: 

• Add New Printer-adds a printer to the list of available printers 

• Delete Printer-removes a printer from the list of available 
printers 

• Add New Font-adds a font to the list of available fonts 

• Delete Font-removes a font from the list of available fonts 

Figure 8-4 shows the Installation menu commands. 

Figure 8-4: Installation Menu Commands 

~~~~~·~ Setu 
Add Hew P~inte~ .. . 
Delete P~inte~ .. . 
Add Hew Font .. . 
Delete Font .. . 

Adding and Removing a New Printer 
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To change printer selections, use the Add New Printer and the Delete 
Printer commands from the Installation Menu. 

On the network, you can connect to print servers that generate output 
in either landscape or portrait mode. Using the Control Panel, you 
can select the default printer mode: landscape or portrait. The printer 
mode you select overrides the current mode of the printer. 

When you use the Control Panel to add to or remove a printer from 
MS-Windows, you are adding or removing the printer driver file from 
the other printer drivers listed in the MS-Windows WIN.INI file. Only 
printers that list their printer driver files in the WIN .INI file are used by 
MS-Windows and its applications. 
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After MS-Windows is set up, you can add a printer driver file to 
MS-Windows when you want to install: 

• An existing printer driver file 

The printer driver file is in the network directory L:\WIN\UTIL, 
which stores printer driver files. 

• A new printer driver file 

The printer driver file is not in the network directory 
L:\WIN\UTIL. You install the printer driver file by copying 
it from the distribution diskette of a new application to the 
network directory L:\WIN\UTIL. 

After you add a new printer to your system, you must let MS-Windows 
know which communications port the printer is connected to before 
you can use the printer. To define the communications port, use the 
Connections command in the Setup menu of the Control Panel. 

Adding an Existing Printer Driver File 

To add an already existing printer driver file to your system: 

1. Select the Add New Printer command from the Installation 
menu. 

MS-Windows displays the Add Printer dialog box. Figure 8-5 
shows the Add New Printer dialog box. 

2. In the text box, you type the location of the printer driver file, 
typically: 

L:\WIN\UTIL 

3. Select the Ok command button. 

MS-Windows displays a dialog box, listing the printers available 
in the directory you specified. 

4. From the list box, select a printer. 

The name of the corresponding printer driver file is displayed 
in the Printer File text box of the dialog box. 

See Table 8-1 for information on selecting printers. 

5. Select the Add command button. 
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Figure 8-5: Add New Printer Dialog Box 
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MS-Windows displays a dialog box. 

6. Select the No command button. 

Selecting the No command button is the normal procedure. 
However, if you want to duplicate this printer driver file, type 
the drive or name of an existing directory you want, and select 
the Yes command button. 

MS-Windows updates the WIN.INI file to include information 
for the new printer driver. However, only the WIN.INI file used 
when you start MS-Windows is updated. If the printer is added 
to the network and is used by more than one user, the WIN.INI 
of each user needs to be updated. 
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Table 8-1: Selecting Printers 

Printer 

LA 50 

LA75 Companion 

LA210 Letterprinter 

LN03R 

PrintServer 40 

LN03 Plus with or 
without CG-Times cartridge 

LN03 Plus with 
ISO/PC cartridge 

L75 Companion to 
emulate IBM Proprinter 

LN03 Plus with ISO/PC 
cartridge to emulate 
IBM Proprinter 

LA210 Letterprinter to 
emulate an IBM 
Proprinter 

Adding a New Printer Driver File 

Printer Type 

Digital LA50 

. Digital LA75DEC 

Digital LA210DEC 

PostScript 

PostScript 

Digital LN03PLUS 

Digital LN03DEC 

Digital LA75STD 

Digital LN03STD 

Digital LA210STD 

Your system administrator adds new printer driver files from the 
distribution diskette that comes with a new printer. This section 
includes information about adding a new printer driver file. 

To add a new printer driver file to the directory containing the other 
MS-Windows printer driver files: 

1. Select the Add New Printer command from the Installation 
menu. 

MS-Windows displays a dialog box that prompts you to insert 
into Drive A the diskette with the printer driver file you want 
to add, or to select an alternate drive/directory. It displays 
L:\WIN\UTIL in the text box. Select Drive A by typing: 

A:\ 
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2. Insert the diskette with the printer files. 

See the printer hardware documentation to determine which 
diskette and which directory contains the printer driver files 
(.DRV). 

3. Select the Ok command button. 

MS-Windows displays a dialog box, listing the printers available 
on the diskette. 

4. From the list box, select a printer. 

After you select a printer, the name of the corresponding printer 
driver file is displayed in the Printer File text box at the right. 

5. Select the Add command button. 

A dialog box prompts you for the name of the drive or directory 
to which you want to copy the printer driver file. 

6. In the text box, type the service name for L:\WIN\UTIL. The 
drive and directory from which the printer driver file is to be 
copied. Drive L: must be connected to the read service name 
for the system files. 

7. Select the Yes command button. 

MS-Windows updates the WIN.INI file to include information 
for the new printer driver. However, only the WIN.INI file used 
by MS-Windows when you started MS-Windows is updated. If 
the printer is added to the network, and is used by more than 
one user, the WIN.INI file of each user needs to be updated. 

Removing a Printer 
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To remove a printer from MS-Windows: 

1. Select the Delete Printer command from the Installation menu. 

MS-Windows displays the Delete Printer dialog box. The 
list box shows all the printers currently in your WIN .INI file. 
Figure 8-6 shows the Delete Printer dialog box. 
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Figure 8-6: Delete Printer Dialog Box 
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2. Select the printer you want to remove from the list box. 

The file name of the corresponding printer driver file is 
displayed in the text box. 

3. Select the Delete command button. 

MS-Windows displays a dialog box. 

4. Select the No command button. 

NOTE 
When you select the No command button, the 
printer name is deleted from the WlN.INI file, but 
the printer driver file remains. By selecting the 
No command button, you can use the procedure 
discussed in "Adding an Existing Printer Driver 
File", because the printer driver is still stored in the 
directory. 

You should not delete the printer driver file. 

Some printer drivers support more than one printer model. In this case, 
the printers share the print driver file. If other printers share the printer 
driver file that is displayed in the Delete Printer dialog box, that printer 
driver file is not deleted, because it is still used by the other printers. 

In this case, MS-Windows displays a dialog box, indicating the shared 
printer driver file is not deleted. However, it is disassociated from the 
selected printer in the WIN.INI file. 
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Adding a New Font 
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To add an MS-Windows font file (.FON) toMS-Windows, use the Add 
New Font command from the Installation menu. 

When you select the Add New Font command (or the Delete Font 
command), you must specify where the font files are located. 
MS-Windows lists the available fonts, including the font names, the font 
sizes, and the set numbers. 

The set number is based on the devices that the font is primarily 
designed to be used with. 

Set 1 

Set 1 fonts are stroke fonts. They can be used for the screen, a printer, 
or a plotter device of any resolution. 

Set 2 

Set 2 fonts are raster fonts. They are designed for a screen resolution of 
640 X 200, such as a workstation with the IBM Color Graphics Adapter 
or compatible adapter card. 

Set 3 

Set 3 fonts are raster fonts. They are designed for a screen resolution of 
640 X 350, such as a workstation with an IBM Color Graphics Adapter 
or Hercules Graphics Card. These fonts are also used by the VAXmate. 

Set 4 

Set 4 fonts are raster fonts. They are designed for printers in 60 dots 
per inch (dpi) resolution: 

• LA75, LA210, and LN03 in STD mode (landscape mode) 

• 
• 

• 
• 
• 

Okidata 92, 93, 192, 193, standard models (portrait mode) 

Okidata 92, 93, 192, 193, standard and PC-compatible models 
(landscape mode) 

IBM Graphics (landscape mode) 

IBM Proprinter (landscape mode) 

Star Micronics SG-10 (landscape mode) 
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Set 5 fonts are raster fonts. They are designed for printers in the 120 
dpi resolution: 

• LA75, LA210, and LN03 in STD mode (portrait mode) 

• Okidata 92, 93, 192, 193, PC-compatible models (portrait mode) 

• IBM Graphics (portrait mode) 

• IBM Proprinter (portrait mode) 

• Star Micronics SG-10 (portrait mode) 

In addition to these fonts, an application can list device fonts. These are 
the fonts provided by a device. For example, on print-wheel printers, 
font names correspond to wheel names. These fonts cannot be added 
or deleted with the Control Panel, but they can be listed when the 
output device is selected. When a raster font does not correspond to 
the screen, MS-Windows can substitute a screen font in the same class. 

NOTE 
Because applications handle fonts differently, some 
applications may not list all fonts. 

Fonts have names that represent their different characteristics. Table 
8-2 lists and describes the fonts that are included on L:\WIN\UTIL. 

Table 8-2: Fonts on the Fonts Disk 

Font Description 

Helv (Raster font.) A proportional font (characters having 
varying widths) without serifs. 

Courier (Raster font.) A fixed-width font (charters having uniform 
width) with serifs. 

Tms Rmn (Raster font.) A proportional font with serifs. 

Roman (Stroke font.) A proportional font with serifs. 

Modern (Stroke font.) A proportional font without serifs. 

Script (Stroke font.) A proportional font of slanted characters 
formed from nearly continuous curved lines. 
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Table 8-3 describes the fonts that are not included on the L:\WIN\UTIL, 
but that you can see in some applications. These fonts cannot be added 
or deleted. 

Table 8-3: Fonts Not on the Fonts Disk 

Font 

System 

Terminal 

Description 

(Raster font.) A fixed-width font designed for the screen. 

(Raster font.) A fixed-width font that is the same as the font 
your workstation displays from MS-DOS. 

Deleting a Font 
To delete a font file in MS-Windows, use the Delete Font command 
from the Installation menu. 

Using the Setup Menu 

8-14 

The Setup menu has four commands: 

• Connections, which lets you assign or change printer port 
connections 

• Printer, which lets you select the default printer 

• Communications Port, which lets you select a serial 
communications port and select parameters, such as baud 
rate, word length, parity, and stop bits 

• Network Terminal Services, which lets you select network 
services for your communication ports 
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Figure 8-7 shows the Setup menu commands. 

Figure 8-7: Setup Menu Commands 
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Changing Printer Connections 
MS-Windows needs to know to which communications port your printer 
is connected. To set or change the port for your printers, use the 
Connections command. 

For example, to move your printer from the communications port LPTl 
to LPT2, use the Control Panel to change the printer connections setting. 

To change printer connections: 

1. Select the Connections command from the Setup menu. 
MS-Windows displays the Connections dialog box. Figure 8-8 
shows the Connections dialog box. 

Figure 8-8: Connections Dialog Box 
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2. From the Printer list box, select the printer you want to change. 
The current communications port assignment for the selected 
printer is displayed in the Connection list box, located at the 
right. 

3. From the Connections list box, select one of the 
communications ports. 

4. Select the Ok command button. 

Changing the Default Printer 

8-16 

When you use a Print command, MS-Windows prints the file on the 
default printer. To select the default printer and to set its output modes, 
use the Printer command. 

Printer output modes are printer-specific settings, such as portrait 
mode (normal vertical page orientation) or landscape mode (horizontal 
page orientation). The Printer command is useful when you have both 
local and remote printers, or both dot matrix and character printers, 
connected to your workstation. 

To change the default printer: 

1. Select the Printer command from the Setup menu. 

MS-Windows displays the Default Printer dialog box. It lists all 
the available printers and their current connections. Figure 8-9 
shows the Default Printer dialog box. 

Figure 8-9: Default Printer Dialog Box 
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2. From the list box, select the printer name. 

3. Select the Ok command button. 

( Ok ) 

(Cancel) 

MS-Windows displays the Output Mode dialog box, containing 
the mode settings specific to the printer you selected. 
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4. To select another output mode, select from the options for 
printer output or answer the questions in the dialog box. 

5. Select the Ok command button. 

The printer you select becomes the default printer. 

Changing the Communications Port 

To select COMl and COM2 settings, including baud rate, stop 
bits, parity, word length, and the retry (print/send) option, use the 
Communications Port command. 

The MS-Windows print spooler uses these settings to configure the 
communication port before printing. (COMl and COM2 are serial 
communications ports and can be used only with serial printers and 
serial communication devices.) To set the serial printer port, use the 
MS-DOS MODE command before starting MS-Windows. For more 
information on the MODE command, see the MS-DOS Reference Guide 
or the DOS reference manual that comes with your DOS software. 

To configure a communications port: 

1. Select the Communications Port command from the Setup 
menu. 

MS-Windows displays the Communication Settings dialog box. 
Figure 8-10 shows the Communications Settings dialog box. 

Figure 8-10: Communications Settings Dialog Box 
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2. Select the communications port COMl or COM2. 

The settings for the selected communications port are displayed 
in the dialog box. 

3. Select the rest of the settings. 

The settings for Baud Rate, Word Length, Parity, Stop Bits, 
and Handshake (protocol) should be the same as those set for 
your printer or device. The setting "Hardware" is equivalent to 
XON7XOFF. For the proper communications port settings, see 
your printer or device documentation. 

4. Select the Ok command button. The communications port you 
select is set up. 

NOTE 
This command does not configure or set up the 
communication hardware. It gives information about the 
communication hardware settings toMS-Windows and the 
applications using the communications ports. When you 
set up a communications printer or device, make sure the 
communications port settings are configured according to the 
serial communications instructions supplied by your printer or 
device manufacturer before you try to print. 

Selecting Network Terminal Services 
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To select terminal services for the workstation's communication ports, 
use the Network Terminal Services command. This command lets you 
redirect the COMl and COM2 communications ports to the selected 
terminal services. Any application using COMl or COM2 is redirected 
over the local area network to the specified network terminal service. 

To select a network terminal service: 

1. Select the Network Terminal Services command from the Setup 
menu. 

MS-Windows displays a Network Terminal Services dialog box. 
It lists the currently available network services. Figure 8-11 
shows the Network Terminal Services dialog box. 
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Figure 8-11: Network Terminal Services Dialog Box 
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NOTE 
For most systems, you can access a maximum of 10 
services. A warning box is displayed if the service 
table has overflowed. 

To add more services, you must change the table size 
in the Network Terminal Services (LAT) driver. For 
more information on changing the table size, see the 
Using Networks from Your Workstation. 

2. From the Port list box, select the COMl or COM2 
communications port. 

The current terminal services for that port are displayed. 

3. From the Services list box, select a terminal service. 

4. Select the Ok command button. 

·-

You can redirect communications ports to a network terminal service 
for any standard application that runs in a window, such as the VT220 
terminal emulator. Using the configuration shown in Figure 8-10 and 
Figure 8-11, you can connect the VT220 emulator to the COMl port; 
however, all communications for the VT220 emulator will use the 
network terminal service called DONAL. 
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When you run an application that uses COMl or COM2, the selected 
terminal service is redirected if the following conditions are met: 

• The Network Terminal Service driver (LAT) was installed prior 
to starting MS-Windows. This driver lists all available services, 
normally assigned by the key diskette. 

• The redirected port is COMl or COM2. Only COMl and 
COM2 can be redirected. 

• The mode of transmission is computer to computer, and does 
not use a modem. Only applications that do not use modem 
control signals to control the flow of data can be redirected. 

• No more than four Network Terminal Services are active, 
including redirected and direct connections. 

• A terminal services name is present in the WIN .INI file for the 
serial communication device being used. You cannot select a 
terminal service not listed in the Services list box. 

• The terminal service is available. This availability is dynamic. 
If a terminal service is selected for a communications port, the 
terminal service is assigned to that communications port only 
as long as terminal service is available to the network. If the 
terminal service becomes unavailable to the network, it is no 
longer assigned to the communications port. 

NOTE 
Even if COMl and COM2 hardware is not installed, 
redirection over the local area network can occur, because 
the redirection is done by software. 

Using the Preferences Menu 
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The Preferences menu has four commands: 

• 
• 

• 

• 

Screen Colors, which lets you adjust shades on your screen 

Keyboard Settings, which lets you change settings such as 
keyclick and autorepeat 

Mouse, which lets you swap the function of the left and right 
mouse buttons 

Country Settings, which lets you select country-specific user 
preferences 
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Figure 8-12 shows the Preferences menu commands. 

Figure 8-12: Preferences Menu Commands 

Screen Colors ... 
Keyboard Settings ... 
Mouse ... 
Countr 

Changing Screen Colors 
To adjust the shades of the components in a window, use the Screen 
Colors command. These components are: 

• Window background 

• Window text 

• Scroll bars 

• Active (selected) title bar 

• Inactive (unselected) title bar 

• Title bar text 

• Window frame (the thin border around the outside of the 
window) 

• Menu bar 

• Menu text 

• Screen background (including the icon area) 
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To change the shade of a component in a window: 

1. Select the Screen Colors command from the Preferences menu. 

MS-Windows displays the Screen Colors dialog box. 
Figure 8-13 shows the Screen Colors dialog box. 

NOTE 
Set your screen to have contrasting text and 
background colors. Otherwise, your screen could 
look blank. 

Figure 8-13: Screen Colors Dialog Box 

Screen Colors 
•~nrn rrn:.1 

Sa111ple 

1 ~Ud!Jill ! ext 
Scroll Bars 
Actiue Title Bar 
Inactiue Title Bar 

Hue 

Bright 

Color 

2. From the Screen Colors list box, select the part of the screen for 
which you want to change the shade. 

The current settings for Hue, Bright, and Color of the selected 
component in the window are displayed in the scroll bars. The 
mixture of these three settings for the selected component result 
in the current shade displayed in the Sample area. 

To change the shade of a component in the window, change the 
settings for Hue, Bright, and Color. 

3. To change a setting for Hue, Bright, or Color: 

a. Move the cursor to the scroll bar by clicking on the scroll 
bar or by pressing the Tab key until the scroll box blinks 
in the desired scroll bar. 
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b. Scroll to the right or to the left to change the setting. 

With the mouse, click on the arrows or drag the scroll 
box in the scroll bar. 

With the keyboard, press the right and left arrow keys 
to change settings in small increments, or press the Pg 
Up or Pg Dn keys to move across the scroll bar more 
quickly. 

As you scroll, the Sample area dynamically shows the 
changing shade of the selected window component. 

c. Select another scroll bar until the desired shade is 
displayed in the Sample area. 

d. Change the shades of all other items in the Screen 
Colors dialog box. 

e. When you finish changing screen colors, select the Ok 
command button. 

When you select the Ok command button, the settings are 
recorded in the WIN.INI file, and the dialog box is removed 
from the screen. 

Changing Keyboard Settings 
To change keyboard features, use the Keyboard Settings command. 
These features include: 

• Keyclick volume (No sound, Soft, Intermediate, Loud) 

The default setting is Intermediate. 

• Autorepeat (Enable or Disable) 

The default setting is autorepeat enabled. 

• Lock selection (Caps or Shift ) 

The default setting is Caps, which selects the function of the 
Lock key. 

When you type a key with Caps selected, uppercase 
letters are used for the alphabetic keys, and the lower 
characters are used on the numeric/symbolic keys. 

When you type a key with Shift selected, uppercase 
letters are used for the alphabetic keys, and the top 
characters are used on the numeric/symbol keys. 
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In either case, pressing the Lock key turns on the 
keyboard lock indicator light. To override the lock 
function, press the Lock key again. The lock indicator 
light turns off. 

If you want to use lowercase or the upper characters on 
the numeric/symbolic keys without leaving Caps Lock, 
press the Shift key in combination with the desired 
key. 

To change keyboard settings: 

1. Select the Keyboard Settings command from the Preferences 
menu. 

MS-Windows displays the Keyboard Settings dialog box. 
Figure 8-14 shows the Keyboard Settings dialog box. 

Figure 8-14: Keyboard Settings Dialog Box 

Keyboard Settings ~ 

Keyboard in use: U.S.A. 

Keyclick uolu111e 0 Ho sound 
0Soft 
@ I nter111ediate 
Oloud 

Autorepeat @ Enabled 
0 Disabled 

lock selection @ Caps 
0 Shift 

( Ok ) ( Reset ) 

2. Select the settings you want. 

3. Select the Ok command button. 

(Cancel) 
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The keyboard settings for the keyclick volume and autorepeat 
are in effect for your workstation, even when you are not 
running MS-Windows. 

When you change a keyboard feature, MS-Windows enters the 
change into the WIN.INI file. Any changes take effect after you 
click on the OK command button and remain in effect until you 
change them. 

The default settings are used when: 

• You run MS-Windows for the first time and have not made any 
changes to the keyboard preference features. 

• The WIN .INI file is not present, or the information about the 
keyboard preference features has been removed from the 
WIN .INI file with a text editor. 

Changing Mouse Settings 

To swap the function of the left and right mouse buttons, use the Mouse 
command. The default setting is the left mouse button for performing 
the mouse actions of clicking, double-clicking, and dragging. 

To swap the functions of the left and right mouse buttons: 

1. Select the Mouse command from the Preferences menu. 

MS-Windows displays the Mouse Options dialog box. 
Figure 8-15 shows the Mouse Options dialog box. 

Figure 8-15: Mouse Options Dialog Box 

Mouse Options 

~Left/right 

( Ok 

~ouse buttons swapped 

) (Cancel) 

2. Click on the check box. 

An X is displayed in the check box, showing that the functions 
of the right and left mouse buttons will be swapped. 
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3. Click on the Ok command button. 

The functions of the left and right mouse buttons are swapped. 
Until you swap the functions of the left and right mouse buttons 
again, and remove the X from the check box, you must use the 
right mouse button when using any mouse action. 

Changing Country Settings 
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To specify country-specific information, such as the formats for date 
and time, use the Country Settings command. This information can 
then be used by the MS-Windows applications you run. 

NOTE 
All applications you run do not automatically access this 
information. Access depends on how the application 
interfaces with MS-Windows. When the settings are 
changed in MS-Windows, they must also be changed in 
CONFIG.SYS for them to be effective with all applications. 
For information on how to make these changes using the 
COUNTRY command, see the MS-DOS Reference Guide or the 
DOS reference manual that comes with your DOS software. 

To change country settings: 

1. Select the Country Settings command from the Preferences 
menu. 

MS-Windows displays the Country Settings dialog box. 
Figure 8-16 shows the Country Settings dialog box. 
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Figure 8-16: Country Settings Dialog Box 

Country Settings .... _, 
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Separator: [ZJ Oeci111al: D 

List: [J D Leading Zet·o 

( Ok ) ( Reset ) (Cancel) ~n·ency F ot·lllat 
111bol: [L=:J (!;o Pt·efix (:;Suffix 

2. From the list box, select a country. 

The default settings for the selected country are shown in the 
dialog box. 

3. Select the setting you want to change. 

The user can change any of the default country settings; Date 
Format, Time Format, Number Format, or Currency Format. 

I 

For example, the default setting for the date format in the U.S. 
country setting is month/day/year. You can use day/month/year 
or year/month/day. 

4. Select the Ok command button. 

The country settings you selected are in effect. 

NOTE 
A currency symbol cannot exceed five characters, even though 
you can enter more than five characters in the Currency 
Symbol field. 
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Chapter 9 
Using the VT220 Terminal Emulator 

A termi11al emulator is an application that lets you use your workstation as 
if it were a terminal connected to VAX/VMS host computer. When you 
use a terminal emulator, your workstation keyboard and screen behave 
like a DIGITAL terminal. 

The VT220 terminal emulator application behaves like VT52, VT100, 
or VT200 7 and 8-bit control terminals that support both DEC and ISO 
Latin-1 character sets. 

The VT220 terminal emulator application has a printer interface that 
supports the same DIGITAL printers used by the VT220 terminal. 

The VT220 terminal emulator is an MS-Windows application that offers 
many Set-Up parameters or selections you can change or set depending 
on your needs. You save these selections in a file that the emulator 
reads when it starts. 

Wherever the words VT220 emulator are used, it means the VT220 
terminal emulator for the workstation. 

The VT220 emulator lets you: 

• Put the VT220 emulator application on temporary hold while 
you switch to another application 

• Receive or send information to or from a host using files 

• Save and recall Set-Up selection settings using Set-Up 
configuration files 

• Use MS-Windows Clipboard commands 
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• Use script processing 

This chapter covers: 

• Starting the VT220 emulator 

• Using the VT220 emulator window 

• Leaving the VT220 emulator 

Starting the VT220 Emulator 
Start the VT220 emulator either by: 

• Expanding the VT220 emulator icon (a small terminal) in the 
icon area into the work area 

• Using the Run command from the File menu in the MS-DOS 
Executive window 

To do this: 

1. Select the Run command. 

2. Type VT220 in the dialog box. 

3. Click on the Ok command button. 

Your workstation is emulating a VT220 terminal, and your 
host login information is displayed. 

NOTE 
If your login information is not displayed, see 
your system administrator. 

Using Multiple VT220 Emulators 
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You can run more than one VT220 emulator. You might want to do this 
if you are: 

• Editing a file in one VT220 emulator and want to access or 
monitor your mail using another VT220 emulator 

• Compiling a program in one VT220 emulator and want to edit a 
memo using another VT220 emulator 
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When you start another VT220 emulator, the title bar displays square 
brackets next to the VT220 emulator title. A number is displayed in 
these brackets to indicate the emulator session you are running. These 
brackets only display if you are running more than one VT220 emulator 
application. 

You can change the VT220 emulator Window Title in Display Set-Up 
screen to any 30 character string. 

If there is more than one copy of the VT220 icon in the icon area, a 
unique number is displayed in each icon. You can change the way each 
icon looks by defining any device-independent .ICO file in the VT220 
Display Set-Up screen. 

Scrolling in the Emulator Window 
If you need to view more information than can be displayed in an 
emulator window, use these keys: 

1 cil-iii=inCi 1 

lctri/Selectl 

lctri/Prevl 

[Ctrl/Nextl 

To scroll to the left 

To scroll to the right 

To scroll up 

To scroll down 

Using the VT220 Emulator System Menu Commands 
The VT220 emulator adds the following commands to the standard 
System menu commands: 

• Set-Up 

• Mark 

• Copy 

• Paste 

• Script 

• About 
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The Set-Up Command 

You can start or exit from the VT220 emulator Set-Up utility by selecting 
the Set-Up command. Chapter 11 discusses the Set-Up utility. 

The Mark, Copy, and Paste Commands 

The VT220 emulator lets you transfer information between itself and the 
MS-Windows Clipboard application. You copy the information from 
the emulator to the Clipboard or paste· information from the Clipboard 
to the emulator as if you typed it. When you send information to the 
Clipboard, the characters are interpreted as ISO Latin-1 characters. 

To copy text to the Clipboard: 

1. Select Mark from the VT220 System menu. 

The word "Mark" is displayed in parentheses next to the VT220 
emulator title in the title bar. A special vertical bar, the insertion 
point, is also displayed in the window. 

2. Drag the insertion point across the text you want to copy. 

3. Select Copy to move the marked text to the Clipboard. 

NOTE 
Marking is disabled whenever a key is typed, or when 
Mark is selected a second time. 

You can paste from the Clipboard at any time. The pasted text is sent 
to the host computer. Text is not displayed in the window unless the 
host echoes it, or Local Echo is enabled in Set-Up. 

The Script Command 

The Script command lets you automatically run script commands 
contained in script files as if you were in an interactive computing 
session. 

The About Command 
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The About command displays the version number of the VT220 
emulator application. 
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Leaving the VT220 Emulator 
To leave the VT220 emulator select one of the following commands 
from the VT220 System menu: 

• The Icon command. 

Selecting the Icon command shrinks the VT220 emulator to an 
icon without exiting from the emulator application. 

• The Close command. 

Selecting the Close command closes the VT220 emulator. 
Before using this command, you should log off the host system. 
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Chapter 10 
Using the VT220 Emulator Keyboard 

This chapter: 

• Shows a diagram of the workstation keyboard. 

• Describes the differences between the workstation keyboard for 
the VT220 emulator and an actual VT220 terminal keyboard. 

The VT220 Emulator Keyboard 
The layout of the VT220 emulator keys on a workstation keyboard is 
identical to the emulated terminal except for: 

• Labels for some keys 

• Location of the I I -~ <, and > 1 and Compose key 

The labels referred to are those on the standard United States legend 
strip. All countries are supplied with a separate emulator legend strip 
and you should be sure to use that strip with the VT220 emulator. 
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Labels 
Some labels for the workstation top-row function keys differ from those 
on a VT220 terminal keyboard. These keys are indicated in Figure 10-1. 

Figure 10-1: Workstation Keyboard 
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The VT220 emulator keys function exactly as they do for the VT220 
terminal. In addition, the V AXmate workstation keyboard has an Alt 
key. 

For more information about the Alt key, see Appendix D. 

Top-Row Function Keys 
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Most of the top-row function keys have functions assigned to them 
by your application software. Refer to your application software 
documentation for their use. 

This section describes keys with fixed meanings for the VT220 emulator. 
The labels in parentheses refer to the labels on the standard United 
States legend strip. 



Fl (Hold) 

F2 (Print 
Screen) 

F3 (Set-Up) 

F4 (Data/Talk) 

FS (Break) 

Fll (ESC) 

F12 (BS) 

F13 (LF) 
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Pressing the Fl (Hold) key freezes the screen display and 
stops any new characters from being displayed. Pressing 
the Fl (Hold) key again returns the emulator to normal 
operation. 

If the Fl key is pressed, the word "Hold" is displayed next 
to the title in the title bar. 

Pressing the F2 (Print Screen) key sends the screen text to 
the DIGITAL compatible printer. Note: If you print to a 
non-DIGITAL printer the results are unpredictable. 

Pressing Ctrl/F2 (Print Screen) sets or resets Auto Print 
Mode. 

Pressing the F3 (Set-Up) key allows you to enter and exit 
Set-Up. 

Used when the optional integral modem is installed or if an 
external modem is used. For more information, refer to the 
VAXmate Modem User's Guide. 
Note: The integral modem may not be available for your 
country. 

Pressing the FS (Break) key transmits a break if you 
enabled Break in Set-Up. You may use it with other 
key combinations when the optional integral modem is 
installed. For more information, refer to the V AXmate 
Modem User's Guide. 
Pressing the Shift/FS keys initiates a communications line 
disconnect. 

Pressing the Ctri/FS keys sends an answerback message as 
defined in Set-Up. 

Note:The integral modem may not be available for your 
country. 

Pressing Fll (ESC) generates an escape character when in 
VT52 and VT100 modes. In VT200 modes, Fll is a function 
key. 

Pressing F12 (BS) generates a backspace character when in 
VT52 and VT100 modes. In VT200 modes, F12 is a function 
key. 

Pressing F13 (LF) generates a line feed character when in 
VT52 and VT100 modes. In VT200 modes, F13 is a function 
key. 
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Using Special Keyboard Mappings with the VT220 
Emulator 
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When using the VT220 emulator with an IBM or IBM compatible 
keyboard, a number of keys perform functions that are different from 
their labels. 

To create VT220 application function keys not available on the IBM 
keyboards, special keyboard mappings and, in some cases, key 
combinations are used to take advantage of those VT220 keys. 

For example, to use the function supplied by the VT220 Fll key, using 
the IBM Enhanced keyboard you would type: 

~ltiiETI 

Tables 10-1 through 10-3 list the labels for the VT220 emulator and their 
IBM counterparts. 
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Table 10-1: IBM Enhanced Keyboard Keys 

VT220 Function Key 

Fll 

F12 

F13 

F14 

F15 

F16 

F17 

F18 

F19 

F20 

VT220 Edit Keypad Key 

Home 

Ins 

Del 

End 

Pg Up 

Pg Dn 

VT220 Numeric Keypad Key 

Compose 

Add 

IBM Alt Key Sequence 

Alt/Fl 

Alt/F2 

Alt/F3 

Alt/F4 

Alt/F5 

Alt/F6 

Alt/F7 

Alt/F8 

Alt/F9 

Alt/FlO 

IBM Edit Keypad Key 

Insert 

Home 

End 

Pg Up 

Delete 

Next 

IBM Numeric Keypad Key 

Escape 

Alt/-
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Table 10-2: IBM-PC/AT Keyboard Keys 

10-6 

VT220 Function Key 

Fll 

F12 

F13 

F14 

F15 

F16 

F17 

F18 

F19 

F20 

VT220 Numeric Keypad Key 

Compose 

Home 

up arrow 

Pg Up 

left arrow 

right arrow 

End 

down arrow 

Pg Dn 

Ins 

Del 

IBM Alt Key Sequence 

Alt/Fl 

Alt/F2 

Alt/F3 

Alt/F4 

Alt/F5 

Alt/F6 

Alt/F7 

Alt/F8 

Alt/F9 

Alt/FlO 

IBM Numeric Keypad Key 

Alt/PFl 

Alt/7 

Alt/8 

Alt/9 

Alt/4 

Alt/6 

Alt/1 

Alt/2 

Alt/3 

Alt/0 

Alt/. 
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Table 10-3: IBM-PC/XT Keyboard Keys 

VT220 Function Key 

Fll 

F12 

F13 

F14 

F15 

F16 

F17 

F18 

F19 

F20 

VT220 Numeric Keypad Key 

Num Lock 

Scroll 

End 

down arrow 

Next 

left arrow 

right arrow 

Home 

up arrow 

Pg Up 

Ins 

Del 

Add 

IBM Alt Key Sequence 

Alt/Fl 

Alt/F2 

Alt/F3 

Alt/F4 

Alt/FS 

Alt/F6 

A1t/F7 

Alt/F8 

Alt/F9 

Alt/FlO 

IBM Numeric Keypad Key 

Alt/PF2 

Alt/PF4 

Alt/1 

Alt/2 

Alt/3 

Alt/4 

Alt/6 

Alt/7 

Alt/8 

Alt/9 

Alt/0 

Alt/. 

Alt/Enter 
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Chapter 11 
Using Set-Up With the VT220 Emulator 

This chapter describes: 

• How to enter and exit Set-Up 

• How to make or change Set-Up settings 

• Each Set-Up screen and all the settings 

Entering Set-Up 
The VT220 emulator offers several Set-Up selections that affect such 
settings as tab stops, screen background, or column width. 

To enter Set-Up either: 

• Press the F3 (Set-Up) key 

• Select the Set-Up command from the Set-Up System menu 
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Understanding the VT220 Set-Up Screens 
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After you enter Set-Up the VT220 emulator displays Figure 11-1, the 
Actions Screen, the first of eight Set-Up screens. For this discussion 
the Actions Screen is being treated as a general example of all eight 
screens. 

Figure 11-1: VT220 Set-Up 

UT220 Emulatlll" - o • 

Receiue File Idle 
Send File Idle 

Printer Hone 
Modem Hot Selected 

Set Default Set-Up Parameters 
Send File 
Receiue File 

Telephone Talk Mode - Manual Answer 
Insert/Replace Replace 
Communications Comm Port 1 - Data Leads Only 

Each Set-Up screen displays: 

• A title bar with a Set-Up System menu in the first line. 

• A menu bar in the next two lines of the screen with the name of 
the currently selected screen highlighted. You select a screen by 
clicking on its name. 

• The current selections and settings in the mid-section of the 
screen. Some selections are actions that can be taken, while 
others represent settings with different values. These selections 
vary depending on the selected screen. 

• A status section in the bottom half of the the screen. 
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Table 11-1 describes each of the Set-Up screens. 

Table 11-1: VT220 Set-Up Screens 

Set-Up Screen Description 

Actions Contains selections relating to clearing the screen and 
resetting the emulator, saving and recalling Set-Up 
settings, and sending or receiving files. 

Communications 

Display 

General 

Keyboard 

Pl'inter 

Tabs 

Telephone 

Contains selections for defining the communications 
environment, such as speed, parity, and disconnect. 

Contains selections for defining screen display, such as 
columns, cursor style, and background. 

Contains commonly-used general operating selections, 
such as local echo, character sets, and terminallD. 

Contains selections for defining keyboard operating 
characteristics, such as margin bell, break, and 
answerback. 

Contains selections for defining printer operations, such 
as print size or type of printer. 

Contains selections for defining the tab settings. 

Lets you determine how telephone answering is done. 
You can also enter the telephone numbers you want to 
use with the modem. 

From each Set-Up screen you can: 

• View the current selections and settings 

• Change the current settings to suit your needs 

• Access any of the other Set-Up screens from the menu 

All settings can be saved in or recalled from Set-Up files. You can also 
recall the factory default settings. 
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The VT220 Status Section 
The status section displays information relating to the state of operations 
you initiate through various Set-Up selections. 

All screens for the VT220 emulator have a bottom section displaying the 
current status for: 

• Receiving or sending a file 

- Idle or In Progress 

• Printer 

- Printer type and Mode 

• Modem usage (valid only if the optional integral modem is 
installed, and you selected Modem Control) 

- Selected or Not selected 

• Telephone modes (valid only if the optional integral modem is 
installed, and you selected Modem Control) 

- Manual or Automatic Answer 

• Insert/Replace mode 

• Communications 

NOTE 

Comm Port 1, Comm Port 2, or Network Terminal 
Service 

The VT220 status area is a reporting area only. 

Changing Settings in VT220 Set-Up 
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You can use either the mouse or the keyboard in VT220 Set-Up. This 
section describes only how to use the mouse. For information on how 
to use the keyboard to change settings, see Appendix D. 



Using Set-Up With the VT220 Emulator 

Using the Mouse in Set-Up 
To select a Set-Up screen and change a setting: 

1. Select the desired screen from the menu area. 

2. After the desired Set-Up screen is displayed, click on the 
selection you want to view or change. 

If a drop-down menu is displayed, go to the next step; otherwise 
release the mouse button. 

3. Drag the pointer to the desired setting and release the mouse 
button. 

NOTE 
Some settings take effect immediately; others take effect when 
you exit Set-Up. 

Exiting Set-Up 
To exit Set-Up either: 

• Press the F3 (Set-Up) key again 

• Select the Close command from the Set-Up System menu 

Using Set-Up Table Information 
The following sections describe the Set-Up screens and the settings you 
can change. 

The information for each Set-Up screen is organized as follows: 

• A description of the Set-Up screen 

• The VT220 screen 

• A table containing: 

Selection definitions 

Setting descriptions for each selection 

Default settings 
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Actions Screen 
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Whenever you enter VT220 Set-Up, it displays the Actions Set-Up 
screen. 

Figure 11-2: VT220 Actions 
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Receiue File: Idle 
Send File: Idle 

Printer: Hone 

Set Default Set-Up Para~eters 
Send File 
Receiue File 

Mode~: Hot Selected 
Telephone: Talk Mode - Manual Answer 

Insert/Replace: Replace 
Co~unications: Co~~ Port 1 - Data Leads Only 

Table 11-2 defines the Actions Set-Up selections. 

Table 11-2: VT220 Actions Set-Up 

Selection Function 

Reset Terminal Resets many terminal operating settings to the 
power up default state. 
Does not affect NRC (National Replacement 
Characters), multinational modes, user-defined 
keys, or communications. It takes effect 
immediately. 
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Table 11-2 (Cont.): VT220 Actions Set-Up 

Selection 

Clear Display 

Clear Communications 

Recall Set-Up 
Parameters 

Save Set-Up 
Parameters 

Set Default 
Set-Up Parameters 

Function 

Clears the clisplay and sends the cursor to the 
upper-left corner of the screen. 

Clears communication lines immecliately and 
stops any print operation in progress. It also exits 
printer controller mode. 

Does not affect LA T communications. 

Replaces all existing settings with values you saved 
in a default file called DEFAULT.220 or in a file 
you created. 

Clears the clialog box from the Actions Set-Up 
screen and returns the cursor to the upper-left 
corner of the Actions Set-Up screen. 

Saves the Set-Up settings in a default file called 
DEFAULT.220 or in a file you can specify. 

Clears the dialog box from the Actions Set-Up 
screen and returns the cursor to the upper-left 
corner of the Actions Set-Up screen. 

Replaces all current Set-Up settings with factory 
default settings. 

Clears the clialog box from the Actions Set-Up 
screen and returns the cursor to the upper-left 
corner of the Actions Set-Up screen. 
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Table 11-2 (Cont.): VT220 Actions Set-Up 

Selection 

Send File 

Open File 

Close File 

Receive File 

Open File 

Open File 
and Append 

Close File 

On 

Off 

Script File 

Function 

Allows you to send characters to a host from an 
MS-DOS text file as though you entered them 
from a keyboard. 

Displays a dialog box and asks you to enter a file 
name. When you open a file from the dialog box, 
sending begins after you select Ok and exit Set-Up. 
When the file is opened this setting is displayed in 
a lighter shade until the file is closed. 

Displayed in a lighter shade until you open a file. 
Closes and saves the file. 

Controls the receiving of characters from a host 
into a specified file. 

Displays a dialog box and asks you to enter the 
name of the file that is to receive the characters. 
If a file of the same name already exists, it is 
replaced. 

This is identical to Open File except that text is 
appended to a file of the same name if it exists. If 
not, a new file is created. 

File logging is ended and the file is closed. 

File logging resumes. 

File logging is suspended but the file remains 
open. 

Displays a dialog box and asks you to enter a 
script filename. When Set-Up is exited, the file is 
opened and transmission begins. 
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Communications Screen 
The Communications Set-Up screen lets you define the communications 
environment between the terminal and the host. 

Normally a terminal can only connect to a host using a serial port. Your 
workstation VT220 emulator allows you to connect to a host using either: 

• A serial port 

• Network Terminal Services/the ThinWire Ethernet port 

Figure 11-3: VT220 Communications 

Port/Hetwork 
Network Terminal Seruice 
Disconnect Delay 
XOFF Point 

Receiue File Idle 
Send File Idle 

Printer Hone 
Modem Hot Selected 

Speed 
Data Bits and Parity 
Stop Bits 

Telephone Talk Mode - Manual Answer 
Insert/Replace Replace 
Communications Comm Port 1 - Data Leads Only 

11-9 



Usiug Set-Up Witlt the VT220 Emulator 

Table 11-3 defines the Communications Set-Up selections and, where 
applicable, the settings. 

Table 11-3: VT220 Communications Set-Up 

Selection Function 

Port/Network Indicates the type of port used for communication 
with a host, either serial or Network Terminal 
Services communications. 
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Comm Prt 1: Data 
Leads Only (default) 

Comm Port 1: Full 
Modem Control 

Comm Port 2: Data 
Leads Only 

Comm Port 2: Full 
Modem Control 

Comm Port 2: 
lntegt·al Modem 

If you select serial communications, Network 
Terminal Service is displayed in a lighter shade on 
your screen. 

Select when you connect to the host using serial 
communications. 

Select if your workstation is connected to the host 
through the communications port and an external 
modem requiring modem control is used. 

Select when you connect to the host using serial 
communications. 

Select if your workstation is connected to the host 
through the communications port and an external 
modem requiring modem control is used. 

Note: The VT220 emulator may not function 
correctly with certain external modems due to 
timing inconsistencies under MS-Windows. To 
avoid problems using external modems, use the 
SETHOST emulator. 

Select if the optional integral modem is installed, 
and the workstation uses it to communicate with 
the host. 

Note: The integral modem may not be available 
for your country. 
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Table 11-3 (Cont.): 

Selection 

Network 
Communication 
Port 

Network Terminal 
Services 

Disconnect Delay 

2 second delay 
(default) 

60 Millisecond 
delay 
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VT220 Communications Set-Up 

Function 

Selects connection to Network Terminal Services. 
You must be connected to the Ethernet to access 
these services. 

If you have not selected a Network Terminal 
Service, a dialog box is displayed listing the 
available workstation services. For more 
information on defining the table size for 
these services in the MSNET .IN I or in the 
AUTOEXEC.BAT, see the VAXmate Services for 
MS-DOS Administration Guide. 
Click on the service you want to access, then click 
on the Ok command button. 

If displayed in a lighter shade, you are using serial 
communications. 

If you set the Network selection under 
Port/Network, all items relating to serial 
communications are displayed in a lighter shade, 
and you are connected to services available under 
Network Terminal Services. 

Selects (when modem control is used) the amount 
of time before the workstation disconnects from 
the communications line if the carrier detect is 
lost. 

Most countries, except the United Kingdom, use 
the two-second delay. 

The 60 millisecond delay is for use in the United 
Kingdom. 
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Table 11-3 (Cont.): VT220 Communications Set-Up 

Selection 

XOFF Point 

XOFF at 64 
(default) 

Disabled 

Speed 

Data Bits and Parity 

Stop Bits 
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Function 

Selects the XOFF point or disables the automatic 
XON/XOFF flow control. 

For most applications you should set XOFF at 64 
or 256. If you set XOFF greater than 256 and have 
a buffer overflow problem, set XOFF to the next 
lower value. 

The choices for XOFF are: 64 (default), 256, 512, 
and 1024. 

Characters are received continuously from the 
host. Some characters may be lost. 

Selects the rate at which characters are received 
or transmitted. The default is 9600. 

Selects the character format used for 
communication with the host. The default is 
8 bits- No Parity. 

Selects the number of stop bits (1 or 2) required 
for use by the host port. The default is 1 stop bit. 
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Display Screen 
The Display Set-up screen lets you define screen display 
characteristics. 

Figure 11-4: VT220 Display 
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Table 11-4 defines the Display Set-Up selections and, where applicable, 
the settings. 

Table 11-4: VT220 Display Set-Up 

Selection 

Columns 

80 
Columns 
(default) 

132 
Columns 

Text Cursor 

Visible 
(default) 

Invisible 

Auto Wrap 

On 

Off 
(default) 

Cursor Style 

Block 
(default) 

Underline 
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Function 

Selects an 80- or 132-column screen for text. 

Selects an 80-column screen. 

Selects a 132-column screen. 

Selects whether to display a text cursor. 

Displays the cursor. 

Does not display the cursor. 

Selects whether text automatically wraps on the screen. 

Causes characters that reach the right margin to 
automatically be displayed in the first character position 
of the next line. 

Causes characters that go beyond the right margin to 
overwrite the last character position of the current line. 

Selects the text cursor style. 

Displays block cursor. 

Displays underline cursor. 
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Table 11-4 (Cont.): VT220 Display Set-Up 

Selection 

Background 

Light 
(default) 

Dark 

Blink 

Font Size 

Window Title 

User Icon 
Name 

Function 

Selects the screen display type. 

Selects reverse video screen display (dark text on a light 
background). 

Selects a dark screen display (light text on a dark 
background). 

Blinking display is not implemented for the VT220 emulator. 

To indicate characters with blinking attributes, you have a 
choice of displaying these characters as either normal video 
(default), reverse video, or underscored. 

Changes the font size of characters displayed on the screen. 
The settings are: Normal (default), Small, or Automatic. 

Automatic switches between the two font sizes according to 
whether a whole line fits in the current window width. 

Displays a dialog box asking you to enter a title. The 
maximum number of characters you can use is 30. When 
you press the Enter key, the title bar changes to reflect your 
entry. This parameter is saved in the Recall Set-Up file. 

Displays a dialog box and asks you to select either the 
standard VT220 icon or a special icon. The icon file format 
uses a .ICO default extension. When you press the Enter 
key, the icon changes to reflect the defined icon. The icon 
name is saved in the Recall Set-Up file. 
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General Screen 
The General Set-Up screen lets you define a group of commonly-used 
general operating settings. 

Figure 11-5: VT220 General 
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Table 11-5 defines the General Set-Up selections and, where applicable, 
the settings. 

Table 11-5: VT220 General Set-Up 

Selection 

Une Mode 

On Une 
(default) 

Off Une 

Local Echo 

On 

Off 
(default) 

New Une 

Enabled 
(Return= 
CR/LF) 

Disabled 
(Return = CR) 
(default) 

Function 

Lets you select the mode of operation. 

Lets the workstation communicate with a host. 

Puts a host on hold. Data entered at the keyboard goes 
directly to the workstation screen. 

Enables or disables the local echo selection. 

Directs characters from the keyboard to the screen as 
well as to the host. lt is used when the host does not 
send the characters back to the screen. 

Directs characters from the keyboard to the host only. 
The host in turn may or may not send the characters 
back to the screen. 

Selects whether the Return key generates a carriage 
return only or a carriage return and a line feed. 

Generates a carriage return and a .line feed. Received 
carriage returns cause a new line operation. When 
autotyping, any line feeds in an autotyped file are sent. 
When using Oipboard, any pasted lines are separated 
by carriage returns and line feeds. 

Generates a carriage return only. Received carriage 
returns do not cause a new line operation. When 
autotyped or Clipboard pasted lines are separated by 
carriage returns, line feeds are not sent. 

Note: When the VT220 emulator is in numeric keypad 
mode, this setting affects the Enter key in the same 
way it does the Return key. 
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Table 11-5 (Cont.): VT220 General Set-Up 

Selection 

Multinational Mode 

NRC 

Multinational 
(default) 

Multinational 
Character Set 

ISO Latin-1 

DEC 
Multinational 
(default) 

Terminal Emulation 

TerminallD 
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FuncHon 

Determines character set mappings for the terminal. 

Selects the 7-bit NRC (National Replacement 
Character) mode. The NRC set depends on the country 
keyboard which is determined during MS-Windows 
configuration Set-up. 

Selects the 8-bit MCS (Multinational Character Set), 
including the 7-bit ASCII character set. 
Note: This selection is disabled when you select NRC 
mode. 

Allows you to choose either the ISO Latin-1 or the DEC 
Multinational character set. 

Selects the 8-bit ISO Latin-1 charactet set. 

Selects the 8-bit DEC Multinational character set. 

Determines how the VT220 emulator acts. It can act 
like a VT52, VT100, VT200 with 7-bit controls (default), 
or VT200 terminal with 8-bit controls. 

Identifies your terminal as a VT220 (default), VT102, 
VT101, or VT100 terminal. 

Terminal 10 can only be selected when emulation is set 
for VT100 mode. It is displayed in a lighter shade (not 
selectable) if you are in VT52 or VT200 mode. 



Usittg Set-Up With the VT220 Emulator 

Table 11-5 (Cont.): VT220 General Set-Up 

Selection 

User Features 

Locked 

Unlocked 
(default) 

UDK Lock State 

Locked 

Unlocked 
(default) 

UDK Shifted State 

Shifted 

Unshifted 
(default) 

Function 

Selects whether a host can change certain user features. 

Prevents a host from changing certain user features. 

Lets a host change certain user features. 

The user features are: Light/Dark Screen, Tab Stops, 
and Keyboard Lock. 

Note: Some applications expect to control these user 
settings. If this applies to your application, select 
Unlocked. 

Determines whether a host can change user-defined 
key (UDK) definitions. UDKs can be saved in the 
Set-Up file. 

Prevents UDKs from being changed. 

Allows UDKs to be changed. 

Allows you to choose unshifted User Defined Keys 
(UDKs). Your selection is saved in the Set-Up file and 
is recalled when you start the VT220 emulator. 

Allows UDKs to be invoked from a shifted state. 

Allows UDKs to be invoked from an unshifted state. 
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NOTE 
To program the 15 programmable function keys, you have 256 
available bytes. Space is defined on a first-come/ 
first-serve basis. After the 256 bytes are used, you cannot 
define additional keys or redefine existing keys until the entire 
buffer is cleared. 

Keys are loaded sequentially, so once the limit is reached, you 
cannot load another key definition. The VT220 emulator does 
not inform you when the limit is reached. 

In addition, because the keys are saved in the Set-Up file, the 
256 byte limit carries over from one session to the next until 
you clear the buffer. 

Keyboard Screen 
The Keyboard Set-Up screen lets you define keyboard operating 
features. 

Figure 11-6: VT220 Keyboard 
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Table 11-6 defines the Keyboard Set-Up selections and, where 
applicable, the settings. 

Table 11-6: VT220 Keyboard Set-Up 

Selection 

Keypad Mode 

Numeric 
(default) 

Application 

Cursor Keys 

Normal 
Control 
(default) 

Application 
Control 

Margin Bell 

Enabled 
(default) 

Disabled 

Function 

Sets the terminal keypad for generating either numbers 
or control codes. 

Sends numbers from the numeric keypad. 

Sends escape sequences from the numeric keypad. 

Selects the kind of control codes sent by the cursor 
keys. It is disabled if the terminal is in VT52 mode. 

Sends ANSI cursor control sequences for cursor keys 
(up, down, left, and right). 

Sends application program control functions for cursor 
keys. 

Determines whether the terminal sounds a bell tone 
when the text cursor approaches the right margin. 

Turns on the margin bell setting. 

Turns off the margin bell setting. 
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Table 11-6 (Cont.): VT220 Keyboard Set-Up 

Selection 

Warning Bell 

Enabled 
(default) 

Disabled 

Break 

Enabled 
(default) 

Disabled 

Auto Answerback 

Enabled 
(default) 

Disabled 

Answerback 
Concealed 
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Concealed 

Not Concealed 
(default) 

Function 

Determines whether the terminal generates a bell tone, 
such as for operating errors, mail messages, or system 
messages. 

Turns on the warning bell setting. 

Turns off the warning bell setting. 

Enables or disables the Break key function. 

Turns on the Break key function. 

Turns off the Break key function. 

Selects whether the answerback message is 
automatically sent to a host after a communication 
line connection. 

Turns on the answerback message. 

Turns off the answerback message. 

Selects whether your answerback message entry is 
displayed on the screen. 

Your answerback message is not displayed on the 
screen. 

You can only reset this setting to Not Concealed by 
entering a new answerback message. 

Displays the answerback message as entered. 
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Table 11-6 (Cont.): VT220 Keyboard Set-Up 

Selection Function 

Answerback String Lets you enter an answerback message. A dialog box is 
displayed and asks for the answerback string. 

Printer Screen 

The emulator sends an answerback message when it 
receives an ENQ (enquiry control character) or if you 
or the host send a Ctrl/Break. In the case of ENQ, the 
message you enter is sent to a host without affecting 
screen data or requiring further operator action. 

You can enter any keyboard character, up to a 30 
character limit. To enter a control sequence , enter a 
caret """followed by the control letter. For example, a 
control C would be entered as ""C". 

The Printer Set-Up screen lets you select printer (or auxiliary device) 
operations for the emulators. 

Figure 11-7: VT220 Printer 
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Table 11-7 defines the Printer Set-Up selections and, where applicable, 
the settings. 

Table 11-7: Printer Set-Up 

Selection Function 

Print Extent Determines how much of the screen is printed during 
a text print operation. 

Full Page Prints the full screen. 
(default) 

Scroll Region 

Print Size 

Normal 
(default) 

Compressed 

Print Mode 
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Normal 
(default) 

Auto 

Controller 

Prints only the scrolling region. 

Determines the size of the printed characters. 

Prints 80 characters on a line. 

Prints 132 characters on a line. 

Selects the operating mode for the printer. 

Only sends information to the printer when you invoke 
print functions from the keyboard. 

Prints the current text line when the terminal receives 
a line feed, form feed, or vertical tab code from a host. 

Treats the device connected to the printer port as a 
terminal, while the VT220 emulator monitors traffic. 
(The printer and host transfer data without displaying 
the data on the screen.) 
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Tabs Screen 
The Tabs Set-Up screen lets you set the terminal tab stop interval 
settings. 

Figure 11-8: VT220 Tabs 
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Table 11-8 defines the Tab Set-Up selections and, where applicable, the 
settings. 

Table 11-8: VT220 Tab Set-Up 

Selection Function 

Oear All Tabs Oears all tab settings. 

Set 8 Column Tabs 

Set Tab Interval 

Sets tabs every 8 columns, starting with column 9. 

Displays a dialog box containing the current tab 
stop setting. You enter a new interval in the dialog 
box by typing the desired number. 

Manually Set Tabs A1lows you to change individual tab stops. The tab 
intervals are updated in a displayed ruler. 

Setting VT220 Tabs Manually 
To manually set tabs for the VT220 emulator: 
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1. Click on the Manually Set Tabs selection. 

A tabs ruler and blinking cursor are displayed below the Tabs 
Set-Up screen where the Icon area was. Figure 11-9 shows the 
current tab settings. 

2. To move the blinking cursor to the desired tab setting, use the 
mouse pointer. 

3. Click on the desired tab setting. 

A "T" is displayed where you clicked. 

To erase a tab stop, click on the "T." 

4. Repeat steps two and three until you have marked all desired 
tab stops. 

NOTE 
To cancel the tab settings you made and leave the tab 
settings unchanged, dick on the Cancel command 
button. 

5. To exit the tabs ruler and save the tab settings, click on the Ok 
command button. 
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Figure 11-9: Manually Setting VT220 Tabs 
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You are returned to the Tabs Set-Up selections. 

Telephone Screen 
The telephone Set-Up screen lets you store and display telephone 
numbers for automatic dialing. 

To use the Telephone selections, you should have: 

• Installed the integral modem option (This is not available for all 
countries.) 

• Selected and saved from the Communications screen: 

• The Integral Modem selection 

• The appropriate transmit and receive speeds 
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Figure 11-10: Telephone 
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For more information on telephone settings, refer to the VAXmate Modem 
User's Guide. 

Table 11-9 defines the Telephone Set-Up selections and, where 
applicable, the settings. 
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Table 11-9: VT220 Telephone Set-Up 

Selection 

Modem Answer 

Manual 
(default) 

Automatic 

Telephone Numbers 

Function 

Selects automatic telephone answering by the terminal 
or manual telephone answering by the user. 

Leaves the integral modem in talk mode after 
disconnecting from the host and allows you to answer 
the incoming call. Manual answer is required for 
normal telephone operation. 

Leaves the integral modem in data mode after 
disconnecting from the host and allows the terminal to 
automatically answer the incoming call. 

Displays a dialog box requesting you to enter phone 
numbers. Any previously entered phone numbers (A-J) 
are remembered and displayed. 
To enter phone numbers, click to the right of the 
desired letter. An insertion point is displayed indicating 
where to type in the phone number. 
Type in a phone number or type over an existing phone 
number. 
Repeat the process until you have entered or changed 
alJ the desired phone numbers. 
After you type the phone number(s), dick on the Ok 
command button. You save these settings by using the 
Save Parameters selection before exiting Set-Up. 
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Chapter 12 
Using VT220 Special Features 

This chapter tells you how to: 

• Use configuration files 

• Save and recall Set-Up selections 

• Receive and autotype characters using files 

Using Configuration Files 
The VT220 emulator allows you to save Set-Up settings in a Set-Up 
configuration file. You can have several of these files, each specifying 
different settings. 

What the VT220 Emulator Does 

When you start the VT220 emulator, it looks for the default 
Set-Up configuration file named DEFAULT.220. When found, this file 
configures your VT220 emulator with the initial values of all 
Set-Up selections. 

If the VT220 emulator does not find the DEFAULT.220 file, it configures 
your VT220 emulator with the factory default settings instead. 
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What You Can Do 
When starting the VT220 emulator, you can direct it to run a Set-Up 
configuration file other than DEFAULT.220. 

You can also run configuration files after you start the VT220 emulator. 
To do this, use the Recall Set-Up Parameters as described in this 
chapter. 

These Set-Up configuration files need not reside in the current 
directory. You can precede configuration file names with a directory 
path. For more information about appropriate file naming, see the 
MS-DOS Reference Guide. 

Specifying Set-Up Configuration Files on Startup 
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To specify a Set-Up configuration file when you start the VT220 
emulator, do one of the following: 

• Select the Run command. 

A dialog box requests the name of the application you want to 
run. 

Type VT220 followed by a space and the name of the desired 
configuration file. The .220 is the default extension if none is 
given. 

Click on the Ok command button. 

• The standard WIN .INI file distributed with your system 
associates the file extension .220 with the VT220 emulator. 
This lets you run Set-Up configuration files with a .220 extension 
as if they were the VT220 emulator. 

You click on the Set-Up configuration file in the MS-DOS 
Executive window and start the emulator with the settings 
contained in that Set-Up configuration file. 

You can also save or start Set-Up configuration files after you start the 
VT220 emulator. To do this, use either the Save Set-Up Parameters or 
the Recall Set-Up Parameters selection from the Action screen. 
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Saving and Recalling Set-Up Files 
After you select the desired Set-Up settings, you can save and recall 
them from the default file, DEFAULT.220, or a file you specify. 

When you start the VT220 emulator, it looks for one of these files and 
initializes the emulator to the values contained in that file. 

Saving VT220 Selection Settings 
To save your VT220 Set-Up selections: 

1. Select the Actions screen. 

2. Click on the Save Set-Up Parameters. 

A dialog box asking for a file name is displayed. The dialog box 
either displays the default file name or the last file name you 
entered. You may edit this file name or replace it. 

NOTE 
If you select a currently displayed file, any settings 
you made replace any existing settings in that file. 

3. To save your settings in the new or selected file, click on the Ok 
command button. 

Recalling VT220 Selection Settings 
To recall VT220 selection settings under Set-Up: 

1. Select the Actions screen. 

2. Click on the Recall Set-Up Parameters. 

A dialog box is displayed asking for a file name. It will also 
either display the default file name or the last file name you 
entered. You may edit this file name or replace it. 

3. To recall saved settings from the selected file, click on the Ok 
command button. 
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Receiving Characters from the Host Into a File 
The status portion of your screen indicates whether session logging is 
active or idle during this process. 

To receive or log characters from a host into a file using session logging: 

1. Select the Actions screen. 

2. Click on the Receive File selection. 

A drop-down menu displays the Receive File options. 

3. Select the Open File or the Open and Append File option. 

A dialog box asks for the name of the file you want to receive 
the characters. 

4. Type in the file name. 

5. To begin receiving characters into the file, click on the Ok 
command button. 

6. To stop receiving and close the file, select Close File from the 
Receive File menu. 

To suspend reception of characters without closing the file, you 
can alternately select On and Off from the Receive File menu. 

Autotyping Characters to the Host 
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The status portion of your screen indicates whether autotyping is active 
or idle during this process. 

When a file is autotyped to VMS, you must enable HOSTSYNC under 
VMS by typing: 

$ SET TERMINAL/HOSTSYNC IReturnl 

This prevents data overruns on a V AXNMS host. 



Using VT220 Special Features 

To autotype characters to the host from a file as if you entered them 
from the keyboard: 

1. Select the Actions screen. 

2. Select Send File. 

3. Select the Open File option. 

A dialog box is displayed asking for the name of the file you 
want to autotype. 

4. Type in the file name. 

5. To begin autotyping the specified file to the host, click on the 
Ok command button. 

File autotyping stops when the end of the file is reached. 

You can also stop autotyping the file by selecting Close File 
from the Send File menu. 
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Chapter 13 
Scripting for Advanced VT220 Users 

A script is a text file containing sets of commands to perform a function 
automatically, such as: 

• Logging into a host computer 

• Running an automated billing procedure 

• Dialing into a remote computer to retrieve information 

This chapter describes: 

• Writing a script 

• Script file examples 

• Running a script file 

• Troubleshooting a script 

• Script commands 

To use the script processor, you should be familiar with a VT220 
terminal emulator and the VT220 Set-Up features described in Chapters 
11 and 12. You should also be familiar with using script processors. 
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Writing a Script 
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When you write a script, use these guidelines: 

1. Manually perform the task you want to automate, and as you do 
each step, write down the keystrokes and any response times. 

2. Determine the basic structure of the script. Scripts usually 
consist of: 

• An introductory part containing commands like BAUD 
RATE: and PARITY: to set up the communications line. 

• A main part containing a dialog between your 
workstation and the remote computer. 

• Sections for error handling. 

• An exit or end of script section. 

3. Debug the script. 

Use the DEBUG and ECHO commands to check for problems 
with scripts. 

• DEBUG displays each command on the workstation 
screen as it is performed. 

• ECHO displays everything that comes through the 
communications line to the workstation. 

4. Check the timing. 

Using the system response times you write down, you can add 
the TIMER and PAUSE commands to your script. You can 
increase some of the TIMER and PAUSE values in your script to 
allow for times when the remote computer is unusually slow. 

NOTE 
When using the ECHO or DEBUG commands, take 
into account the time it takes to display characters on 
the screen when you specify timer values. ECHO and 
DEBUG can display enough extra characters to cause 
timeouts that would not occur otherwise. 
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5. Handle flow control. 

Use the ON ERROR, SKIP ON, and RETRY commands to 
handle problems that might occur. For example, when you 
autodial a modem to connect to a remote computer, retry that 
portion of the script 10 times if the remote computer does not 
answer. 

6. Give the script an file name with a .SCR extension. 

7. Test the script. 

Make sure your script runs in the environment for which it is 
intended. 

Scripts that are called using CHAIN or SCRIPT can work 
differently when run from the main script than when run by 
themselves. 

Remove all DEBUG commands and leave ECHO commands 
only where you need to see what messages your workstation is 
receiving. · 
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Scripting Examples 
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This section contains two examples of scripts. 

NOTE 
Each example contains a sequnces of characters that must be 
typed to rend codes used by the script processor to generate a 
carriage return. The sequence is: 

<CR> 

Logging into a VAX/VMS Account 

The following script example is used to: 

• Log into a VAX/VMS account 

• Place all new mail in a file 

• Print the file on the VAX' s printer 

COMMENT: This is a sample script showing some of the features 
COMMENT: that are part of the script processor. 

LOAD: I:\VT220\SCRIPT\VIKING.220 
TIMER: 60 

COMMENT: The LOAD: command sets up the user's VT220 emulator 
COMMENT: with appropriate communications parameters. Also 
COMMENT: notice the MS-DOS pathname. The TIMER: command is 
COMMENT: set to allow enough time for any system notices or 
COMMENT: banners to display after prompting the user for a 
COMMENT: name and password. The TIMER: command also allows 
COMMENT: for enough time if large amounts of mail messages 
COMMENT: are extracted later in the script. 

RETRY: 4 

COMMENT: RETRY: allows the user four chances to log in to the 
COMMENT: system. These retries allow for the possibility of 
COMMENT: a timeout occurring while the emulator waits for the 
COMMENT: Username and Password prompt. 



SEND: <CR><CR> 
WAIT FOR:Username: 
SEND:MCCARRON<CR> 
WAIT FOR:Password: 
TYPE UNTIL:<CR> 
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COMMENT: These commands automatically enter the username, 
COMMENT: but require the user to type the password. 
COMMENT: Interactively typing the password prevents someone 
COMMENT: else from reading the password in a file. 

WAIT FOR:$ 
SEND: MAIL <CR> 
RETRY:O 

COMMENT: When the user is logged in, these commands invoke 
COMMENT: the MAIL utility. 

ON ERROR: 
GOTO: $NO_NEW_MAIL 

END ON ERROR: 

WAIT FOR:new message 

COMMENT: If the user has new mail, the MAIL utility displays 
COMMENT: ''You haven new messages''· The ''n'' 
COMMENT: is the number of mail messages you have. 

COMMENT: If there is no new mail, a timeout occurs while 
COMMENT: waiting for the new message. Because there is an 
COMMENT: ON ERROR: command in the script file, control 
COMMENT: passes to the $NO_NEW_MAIL label. 

WAIT FOR:MAIL> 
SEND: <CR> 
WAIT FOR:MAIL> 
SEND: EXTR/ALL NEWMAIL.TXT <CR> 
WAIT FOR:MAIL> 
SEND: EXIT <CR> 
WAIT FOR:$ 

COMMENT: If there is new mail, these commands store the mail 
COMMENT: in a file, exit the MAIL Utility, and return the 
COMMENT: user to the command level prompt. 
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SEND: PRINT NEWMAIL.TXT <CR> 
WAIT FOR:$ 
SEND:LOGOUT <CR> 
EXIT: 

COMMENT: These commands print the file containing the new 
COMMENT: mail and log out the user. 

COMMENT: ERROR ROUTINE. 

$NO_NEW_MAIL: 
DISPLAY: NO NEW MAIL. <CR><LF> 
SEND: EXIT <CR> 
WAIT FOR:$ 
SEND:LOGOUT <CR> 
EXIT: 

COMMENT: If there was no new mail, inform the user 
COMMENT: and then logout. 
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Processing a Weekly Progress Report 

The following script example is used to automate a manager's weekly 
task of receiving progress reports from his staff. 

The script covers: 

• Sending out Monday reminders to the staff 

* Collecting the mailed reports on Tuesday 

The script assumes the worksation is connected to a DECserver 100 
using a serial port. 

COMMENT: Progress Report Script 

COMMENT: This script facilitates the process of organizing 
COMMENT: the weekly progress reports a manager receives from 
COMMENT: his employees. 

TIMER: 60 
RETRY: 4 

COMMENT: Resets the timer from the default of 15 seconds to 
COMMENT: 60 seconds in case more time is needed for logging 
COMMENT: onto the host computer. If the host does not respond 
COMMENT: in 60 seconds retry 4 times before quitting. 

PORT: DATA-l 
BAUD RATE: 9600 
DISCONNECT: 2 
DATA BITS: 8 
PARITY: NONE 

COMMENT: Sets communications parameters. 

BREAK: 

COMMENT: Send a break signal to return to the DECserver 
COMMENT: 100's local mode. 

WAIT FOR: Local> 
SEND: Connect VAX <CR> 

COMMENT: Establish a connection to a valid terminal service. 

WAIT FOR: Username: 
SEND: MCCARRON<CR> 
WAIT FOR: Password: 
DISPLAY: Password: 
TYPE UNTIL: <CR> 
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COMMENT: These commands automatically enter the username, 
COMMENT: but require the user to type the password. 
COMMENT: Interactively typing the password prevents 
COMMENT: someone else from reading the password in a file. 

DISPLAY: <CR><LF> Logging into VAX ••• <CR><LF> 
WAIT FOR: $ 

COMMENT: Let the user know if the login is successful, 
COMMENT: then wait for the system prompt. 

$MAIN: 
TIMER: 15 
RETRY: 0 
ECHO: 
DISPLAY: Weekly Progress Report Script. <CR><CR><CR><LF> 
DISPLAY: Day - (M)onday, (T)uesday, (O)Exit: <CR><LF> 

COMMENT: Set the timer back to the default and end any 
COMMENT: retries, then turn on local echo allowing host and 
COMMENT: user input to display. Display the title of the 
COMMENT: script and indicate the choices available 
COMMENT: to the user for the day of the week. 

$GET_DAY: 
DISPLAY: <CR><LF> Choose day: 
READ: DAY_OF_WEEK 

COMMENT: The label ''$GET DAY'' is defined before the day 
COMMENT: of the week is entered. This allows control to 
COMMENT: return to this label if an invalid date is entered. 
COMMENT: Prompt the user for the day and store the value 
COMMENT: in DAY_OF_WEEK. 

CASE: DAY_OF_WEEK 
"M" SCRIPT: M:\VT220\TEST\MONDAY.SCR 
"m" SCRIPT: M:\VT220\TEST\MONDAY.SCR 
"T" SCRIPT: M:\VT220\TEST\TUESDAY.SCR 
"t" SCRIPT: M:\VT220\TEST\TUESDAY.SCR 
"0" GOTO: $EXIT 
DEFAULT: GOTO: $ERROR 

CASE END: 

COMMENT: Use the CASE: command to process the day of the week. 
COMMENT: If a valid choice is entered, process the matching 
COMMENT: script. MONDAY.SCR sends the reminder mail message. 
COMMENT: TUESDAY.SCR reads all the new mail and puts it 
COMMENT: in a file. 

COMMENT: If an invalid choice is entered, begin error 
COMMENT: processing. 
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GOTO: $EXIT: 

COMMENT: Perform the exit routine after the CASE: command is 
COMMENT: finished. 

COMMENT: ERROR ROUTINE. 

$ERROR: 
DISPLAY: Illegal day. Please enter correct day code.<CR><LF> 
GOTO: $GET_DAY 

COMMENT: If there are no matches for the day entered by 
COMMENT: the user, display a message indicating the problem 
COMMENT: and request the user to try again. 

COMMENT: EXIT ROUTINE. 

$EXIT: 
DISPLAY: Finished. Return to (A) VT220 or (B) MS-DOS Executive. 
READ: EXIT_CHOICE 

COMMENT: Tell the user the script is done. Ask how the user 
COMMENT: wants to leave the script by offering two choices. 

CASE: EXIT_CHOICE 
"A" EXIT: 
"a" EXIT: 
"8" EXIT EMULATOR: 
"b" EXIT EMULATOR: 
DEFAULT: EXIT: 

CASE END: 

COMMENT: When the script is finished, allow the user two 
COMMENT: return options. These options are to return to 
COMMENT: the VT220 emulator application or to the MS-DOS 
COMMENT: Executive. 

Running a Script 
This section describes how to run a script using any of the following: 

• The Script command-the VT220 emulator system menu box 
that lets you specify a script file. 

• A field in the VT220 Actions Set-Up screen-lets you specify a 
script file to run when you exit VT220 Set-Up. 

• A script file-included on the command line when running 
the emulator. The procedure is similar to specifying a default 
Set-Up file. 

This section also describes how script processing ends. 
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Starting a Script from the System Menu Box 

To start a script from the System Menu box: 

1. Click on the System Menu box. 

2. Click on the Script selection. 

3. Type the name of your script file in the dialog box. 

4. Press the Return key. 

Starting a Script from Actions Set-Up 

To start a script from the Actions Set-Up screen: 

1. Access the VT220 Actions Set-Up. 

2. Click on the Script selection. 

3. Type the name of your script file in the dialog box. 

4. Press the Return key. 

5. Exit Set-Up. 

Starting a Script from the MS-DOS Prompt 

To start a script from the MS-DOS system prompt when starting the 
VT220 emulator, type: 

C:\>WIN VT220 filename.scr IReturnl 

If this method is used, you must include the .SCR extension. 

Ending a Script Process 

A script process ends when one of the following occurs: 

• 
• 

• 

• 
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The script processor reaches the last line in a script. 

The processor reaches a timeout condition without an ON 
ERROR: command to process. 

The processor reaches the EXIT, EXIT ON, EXIT EMULATOR, 
or EXIT EMULATOR ON commands. 

You type the Ctrl/C sequence at the keyboard. The Ctrl/C 
sequence is ignored while a TYPE UNTIL command is in effect. 



Scripting for Advanced VT220 Users 

Troubleshooting Your Scripts 
After each script command is processed, it returns a status which 
records a code in the variables Error_Number and Error_Message (see 
Table 13-1 for the messages associated with these variables). These 
variables are accessed like any other variable in a script (see the SET: 
and READ: commands in this chapter). 

The Error_Number contains the returned status code, while the 
Error_Message contains a descriptive comment related to the 
Error_Number. If a command processes successfully, the Error_Number 
is 0, and the Error_Message is "Command successfully completed." 

Using these variables, you can create error handling routines to: 

• Stop the script on a specific error 

• Make some changes and continue processing 

When a script encounters an error, the screen displays: 

%SCR - Error. Check ERROR.LOG for explanation. 

The script continues processing, and an ERROR.LOG file is created and 
stored in the current directory. The file is in the following format: 

COMMAND LINE: 
ERROR MESSAGE: -- [string] -- n 

Where: 
command line: 

Error_Message: 

[string) 

n 

For example: 

DISCONCT: 60 

Is the text of the line that caused the script to fail. 

Is the message associated with the error. 

Is any text, such as an actual command, associated with 
the message. 

Is the number of the script line causing the script to fail. 

Illegal Co~nand -- DISCONCT -- Line #23 
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Table 13-1 : File Logging Messages 

Error_Number 

0 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 
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Error_Message 

Command Successfully Completed 

Illegal Command 

Timeout 

Non-numeric Parameter 

Invalid Parameter 

Incompatible Settings 

Not implemented in VT220 

Service not available 

Cannot find 

END ON ERROR not found 

ON ERROR not found 

CASE END not found 

MS-DOS command failed - Not enough memory. 

Plint Error 

Label not found 

Logfile already open 

No logfile open 

File Transfer Error 

Variable not found 

Comm Port not available 

Nested ON ERROR routines not allowed 

Error in Error routine 

Error in CASE routine 
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Scripting Commands 
Use the following syntax for script commands: 

COMMAND: [parameter] 

Where: 

ll 

COMMAND: 

parameter 

Comments 

Indicates optional items in the syntax. 

A vertical series of periods, or an e11ipsis, indicates that not 
all the data that the system would display is shown or that 
not all the data you would enter is shown. 

Is one of the script commands listed in this chapter. 
The colon must follow the last letter in the command 
to separate the command from its parameter, and each 
command must be on a separate line. You can type the 
characters in either upper or lowercase. Leading spaces are 
ignored. 

Spedfies what the script command acts upon. The script 
command definitions describe the parameter values for 
the appropriate commands. Command parameters include 
file specifications (filename), numeric values (n), strings 
(string), or variables (var). 

File spedfications are in MS-DOS format. If you do not 
spedfy a path, the script processor searches the current 
directory and then the MS-DOS path. If you omit the file 
name, the script processor uses the default file name (if one 
exists). 

Strings and assigned variable strings consist of a series of 
ASCII characters. 

The total length of the command and its parameter must not exceed 80 
characters. Valid characters include all displayable and non-displayable 
characters (see Appendix E for non-displayable character codes). 
Non-displayable characters count as one character out of the 80 allowed 
characters. 

Without the colon, the command is not recognized as a command, and 
a message is displayed indicating there is no command on the line. 
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BAUD RATE 

Sets the rate at which characters are transmitted or received. 

Format 

BAUD RATE: n 

Where: 
n Is any of the following BAUD rates: 50, 75, 110, 134, 150, 300, 600, 

1200, 1800, 2000, 2400, 3600, 4800, or 9600. 

Comments 

When Network is selected, you cannot use BAUD RATE, DATA BITS, 
DISCONNECT, PARITY, STOP BITS, and XON/XOFF commands. 
These fields are automatically set and cannot be changed. 

Example 

BAUD RATE: 4800 

Sets the rate to 4800 baud for character transmission or reception. 
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BREAK 

Sends a break signal (as if you had pressed the Break key) over the 
communication line for tenths of a second. 

Format 

BREAK: n 

Where: 
n Indicates tenths of a second. You can a1so use the logical names 

SHORT (0.24 sec) or LONG (3.5 sec). The network connection has 
a fixed break of .274 seconds. The default is SHORT. 

Example 1 

BREAK: 5 

Specifies a half second break. 

Example 2 

BREAK: SHORT 

Specifies a SHORT break. 
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CASE 
CASE END 

Uses a variable already declared and assigned through the SET or the 
READ command to select options in a script. Following the variable is 
a series of lines. Each line contains a string, surrounded by quotes, and 
followed by a sc;ript command. When processing a CASE command, 
each string is examined, and the command associated with the first 
string matching the variable is processed. All other strings are ignored. 
Strings are also case sensitive. 

Format 

CASE: [var) 
"stringn" commando 
DEFAULT: command 

CASE END: 

Where: 
var 

stringn 

commando 

command 

Comment 

Is the variable defined using the SET or READ commands. 

Is any number (n) of strings one of which matches the 
previously defined variable. Each string must be surrounded by 
quotes and associated with a script command. 

Is any number (n) of script commands to be nm when an 
associated string matches a previously defined variable. 

Is the DEFAULT command to run during script processing if 
no matches are found in the CASE construct. 

You can use a DEFAULT command to process a command if there 
are no matches. The DEFAULT command is only used within a CASE 
command construct. If neither a DEFAULT command nor a match is 
found, the whole CASE construct is ignored. The CASE construct must 
be ended by a CASE END command. 
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Example 

SET: LOANS CARS 
CASE: LOANS 

CASE END: 

"CARS" GOTO: $CARS 
"HOMES" GOTO: $HOMES 
"BUSINESS" GOTO: $BUSINESS 
DEFAULT: GOTO: $END 

Defines a varibale using the SET command, then the CASE command 
lists a series of strings with a corresponding script command to process. 

13-17 



Scripting for Advanced VT220 Users 

CHAIN 

Calls another script file that, when completed, ends all script processing 
and returns you to either the VT220 emulator or the MS-DOS operating 
system. This command is similar to the GOTO command, except the 
destination is a script file and not a string. 

Format 

CHAIN: [filename] 

Where: 
filename Is the name of the script file. 

Example 

CHAIN: TESTl.SCR 

Calls in a script called TESTl. SCR. 

CLEAR LINE 

Clear all data from the communications-line-received queue. 

Format 

CLEAR LINE: 

Example 

CLEAR LINE: 
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COMMENT 
Lets you include comments within the script. The line is ignored and 
processing continues on the next line. 

Format 

COMMENT: [string) 

Where: 
string Is ASCII text used to describe the purpose of script command 

or a series of script commands or simply to make notes in the 
script itself. Each line of the text must begin with the COMMENT 
command. The text is ignored by the script processor. 

Example 

COMMENT: This line calls in a script to run the tax percentages for the 
COMMENT: monthly payroll. 

DATA BITS 

Sets the number of data bits transmitted and received. 

Format 

DATA BITS: n 

Where: 
n Is 7 or 8 bits. 

Comments 

When Network is selected, you cannot use the BAUD RATE, 
DATA BITS, DISCONNECT, PARITY, STOP BITS, and XON/XOFF 
commands. These fields are automatically set and cannot be changed. 

Example 

DATA BITS: 8 

Sets the number of data bits to 8 bits a second. 
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DEBUG 
NO DEBUG 

Displays each line of the script file as it is processed. The default is 
NO DEBUG, which turns off DEBUG. 

Format 

DEBUG: 
NO DEBUG: 

Example 

DEBUG: 
SEND: DIR <CR> 
WAIT FOR: $ 
SEND: COPY A.TXT B.TXT <CR> 
NO DEBUG: 

Checks each line of the script file as it processes for any errors. 

DIAL 

Works like the Shift/F4 key to simplify the process of dialing a phone 
number using a modem. 

Format 

DIAL: [string) 

Where: 
string Is either a telephone number or a letter between A and J. The 

letters (A-J) correspond to phone numbers stored in the VT220 
Telephone Set-Up screen. 

Example 1 

DIAL: E 

Automatically dials a number assigned to the letter "E." 

Example 2 

DIAL: 6171300 

Automatically dials the number 617-1300. 
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DISCONNECT 

Determines the length of time between the lost carrier signal and loss of 
the modern line. Use this command with a modern. 

Format 

DISCONNECT: [n] 

Where: 
n Is either 2 seconds or 60 milliseconds. 

Example 

DISCONNECT: 60 

Drops the connection between the modern and the communications line 
after 60 milliseconds. 

Comments 

When Network is selected, you cannot use BAUD RATE, DATA BITS, 
DISCONNECT, PARITY, STOP BITS, and XON/XOFF commands. 
These fields are automatically set and cannot be changed. 

DISPLAY 

Displays a character string on the terminal screen. The string is 
displayed on the next line. 

Format 

DISPLAY: [string] 

Where: 
string Is a series of ASCII characters you enter at the terminal. 

Example 

DISPLAY: START NOW 

Displays the line "START NOW" on the workstation screen. 
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DTR 
Clears the Data Terminal Ready (DTR) signal. 

Format 

DTR CLEAR: 

Example 

DTR CLEAR: 

DTRSET 

Sets the Data Terminal Ready (DTR) signal. 

Format 

DTR SET: 

Example 

DTR SET: 

13-22 



Scripting for Advanced VT220 Users 

ECHO 
NO ECHO 

Displays all the characters transmitted or received on the 
communication line. The default is NO ECHO, which turns off ECHO 
and stops the script processor from displaying characters sent from the 
host. Use ECHO to resume the display of characters. 

Format 

ECHO: 

NO ECHO: 

Example 

WAIT FOR:Password: 
SEND:mypassword<CR> 
WAIT FOR:$ 
DISPLAY:Connected and logged in<CR> 
ECHO: 

Allows the user to enter a password when the default (NO ECHO) is 
set. Displays a message to indicate that the password was accepted and 
then sets ECHO to continue screen display. 

EXIT 

Ends processing of the current script. If the current script was run using 
the SCRIPT command, control returns to the calling script; otherwise, 
control returns to the VT220 emulation application. 

Format 

EXIT: 

Example 

EXIT: 
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EXIT EMULATOR 

Ends processing of the current script and any calling scripts. The VT220 
emulator application is closed, and you are returned toMS-Windows. 

Format 

EXIT EMULATOR: 

Example 

EXIT EMULATOR: 

EXIT EMULATOR ON 

Ends the processing of the script and any calling scripts when a string 
sent from the host computer. When the string is received, the VT220 
emulator application is closed, and you are returned toMS-Windows. 

If a timeout occurs before the matching string is sent, processing 
continues on the next line of the script. 

Format 

EXIT EMULATOR ON: (string] 

Where: 
string Is a series of ASCII characters. 

Example 

EXIT EMULATOR ON: DEBITS 
COMMENT: If no debits, continue processing 
GOTO: $CREDITS 

Ends script processing when the string "DEBITS" is received from the 
host computer. 
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EXIT ON 

Ends the processing of the current script when a string is sent from 
the remote computer. If the current script was run using the SCRIPT 
command, control returns to the calling script; otherwise, control 
returns to the VT220 emulator application. 

If a timeout occurs before the matching string is sent, processing 
continues on the next line of the script. 

Format 

EXIT ON: (string] 

Where: 
string Is a series of ASCII characters. 

Example 

EXIT ON: DEBITS 
COMMENT: If no debits, continue processing 
GOTO: $CREDITS 

Ends script processing when the string "DEBITS" is received from the 
host computer. 

FPRINT 
Prints the specified file on the printer to which your workstation is 
connected. 

Format 

FPRINT: [filename] 

Where: 
filename Is the name of the script file. If you omit the file name, the 

script processor uses the default file DEFAULT.TXT (if one exits). 

Example 

FPRINT:A:\>TEST.TXT 

Searches the specified MS-DOS path and prints the file TEST.TXT. 
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GOTO 
Goes to the line in the script containing a string and continues 
processing from that point in the script. 

Format 

GOTO: $[string) 

Where: 
string 

Example 

Is a series of ASCII characters beginning with a $ that indicates a 
destination for the GOTO command. 

GOTO: $ACCOUNTS 

Causes the script processor to search for a line containing the string 
$ACCOUNTS and to continue processing at that point in the script. 

HANG UP 

Clears the DTR signal. 

Format 

HANG UP: 

Example 

SEND: LOGOUT<CR> 
HANG UP: 
DIAL: E 

Specifies the end of one modem session and the beginning of a new 
one. 
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Prevents data from the keyboard from being used as input during script 
processing. The default is KEYBOARD ON, which allows data from the 
keyboard as input during script processing. 

Format 

KEYBOARD ON: 

KEYBOARD OFF: 

Example 

KEYBOARD OFF: 
SEND FROM: TEST2.TXT 
KEYBOARD ON: 

Disables any keyboard input while the contents of a file is sent. When 
the file has been sent, keyboard input is enabled. 

LOAD 

Replaces all existing VT220 settings with values you saved in a VT220 
Set-Up file. The default file is DEFAULT.220. 

Format 

LOAD: [ filename] 

Where: 
filename Is a VT220 Set-Up file containing new Set-Up values. For more 

information on VT220 Set-Up files, see Chapter 11. 

Example 

LOAD: NETWORK.220 

Replaces any existing VT220 Set-Up vales with a new set of values 
contained in the VT220 Set-Up file NETWORK.220. 
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NTS 
If Network is selected with the PORT command, you must select a 
Network Terminal Service (NTS) in VT220 Set-Up. 

Format 

NTS: [string] 

Where: 
string Is a selection from a list of available Network Terminal Services. 

Example 

NTS: LATCOM 

13-28 



Scripting for Advanced VT220 Users 

ON ERROR 
END ON ERROR 

Marks the beginning of a segment of script code that is to be processed 
when an error condition is discovered. The END ON ERROR command 
marks the end of the segment. The code in between is ignored during 
normal processing and is processed only after an error code is returned. 
If, when the error routine is processed, the END ON ERROR command 
is reached, processing continues on the line following the command 
that caused the error. 

You cannot use nested ON ERROR/END ON ERROR commands. If 
both the ON ERROR and RETRY commands are in the file, the retries 
are processed until the retries run out, then the ON ERROR command 
is processed. If there is no RETRY command, just the ON ERROR 
command is processed. 

Format 

ON ERROR: 

END ON ERROR: 

Example 

ON ERROR: 
GOTO: $CLEANUP 
END ON ERROR: 

If an error occurs, go to the $CLEANUP label and perform cleanups, 
then exit. 
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OPEN 
CLOSE 

Opens a log file to capture all text sent on the communications line. 
Only one log file at a time can be opened during any one script 
session. If any other log file exists, it is overwritten unless you save 
it by renaming the file. You must use the CLOSE command to close a 
session log file opened by the OPEN command. 

Format 

0 PEN: [ filename ) 

CLOSE: [filename) 

Where: 
filename 

Example 

Is the name of the log file containing text received on the 
communications line. The default file is SESSION.LOG. 

OPEN: JOHN.LOG 
PRINT SCREEN: 
CLOSE: JOHN.LOG 

Opens the file JOHN.LOG and types a file onto the screen and into the 
log file. After the file is displayed, it is closed. 
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PARITY 

Sets the parity. 

Format 

PARITY: [string] 

Where: 
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string Is any of the following selections: None, Even, Even No Check, 
Odd, Odd No Check, Mark, or Space. 

Comments 

When Network is selected, you cannot use BAUD RATE, DATA BITS, 
DISCONNECT, PARITY, STOP BITS, and XON/XOFF commands. 
These fields are automatically set and cannot be changed. 

Example 

PARITY: NONE 

Indicates to the processor that there will be no parity checking on the 
communications line. 
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PAUSE 

Suspends processing for a specified length of time. 

Format 

PAUSE: n 

Where: 
n Is the time in hours, minutes, and seconds (HH:MM:SS). You can 

omit any of the fields (HH:MM:SS) but must include the colons. If 
a field is omitted, the script processor uses the default value of 0. 

Example 1 

PAUSE: 0:0:30 

Specifies a 30 second pause. 

Example 2 

PAUSE: 0:5 

Specifies a 5 minute pause. 

Example 3 

PAUSE: 2 

Specifies a 2 hour pause. 
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PORT 

Selects the type of port. 

Format 

PORT: [string] 

Where: 
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string Is any of the following: Data-l (Port 1, data leads only), Modem-1 
(Port 1, full modem support), Data-2 (port 2, data leads only), 
Modem-2 (Port 2, full modem support), lntegral-2 (Port 2, integral 
modem), or Network 

Comments 

When Network is selected, you cannot use the BAUD RATE, 
DATA BITS, DISCONNECT, PARITY, STOP BITS, and XON/XOFF 
commands. These fields are automatically set and cannot be changed. 

Example 

PORT: DATA-l 

Sets port 1 to data leads only. 

PRINTER ON 
PRINTER OFF 

Determines whether the VT220 Auto Print Mode is set. The default is 
PRINTER OFF, which disables Auto Print Mode. 

Format 

PRINTER ON: 

PRINTER OFF: 

Example 

PRINTER OFF: 
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PRINT SCREEN 

Prints the current screen text on the printer. 

Format 

PRINT SCREEN: 

Example 

PRINT SCREEN: 

PURGE TYPE 

Clears all data from the keyboard type-ahead buffer. 

Format 

PURGE TYPE: 

Example 

PURGE TYPE: 

READ 

Assigns a string you type from the keyboard to a variable name. 

Format 

READ: [var) 

Where: 
var Assigns a variable name to string. You must type in the string 

and end it with a carriage return to tell the script processor to 
continue processing. The Any previously assigned variable name is 
overwritten by this command. 

Example 

READ: LOAN IReturnl 

Causes script processing to suspend until the user types a value for 
the variable "LOAN." Processing continues when a carriage return is 
entered. 
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RETRY 

Indicates the number of times a script command is run after a timeout. 
When a timeout occurs, control passes to the line following the RETRY 
command and script processing continues from that point. 

Format 

RETRY: n 

Where: 
n Is the number of times a command is processed after a timeout. 

The default is 0. 

Example 

RETRY: 3 
SEND: <CR> 
WAIT FOR: Username 

Make three attempts to connect to a host computer. 

,.... SCRIPT 

Opens a new script file, processes all its commands and returns control 
to the next line in the calling script. 

Format 

SCRIPT: [filename) 

Where: 
filename Is the name of a script file. 

Example 

SCRIPT: RUNTHIS.SCR 

Processes all the commands in the script file "RUNTHIS.SCR." 
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SEND 
Sends a character string to the remote computer. 

Format 

SEND: (string] 

Where: 
string Is a series of ASCII characters. 

Example 

SEND: GOODBYE <CR> 

Sends the string "GOODBYE" to the host computer. 

SEND FROM 

Sends the contents of a file to the remote computer without translating 
special or non-displayable characters. 

Format 

SEND FROM: [filename] 

Where: 
filename Is the name of a file. 

Example 

SEND FROM: TEST2.TXT 

Sends the characters contained in the file "TEST2.TXT" to the host 
computer. 
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Assigns a string to a variable. Variable and string must be separated by 
one or more spaces. 

Format 

SET: (var] (string] 

Where: 
var 

string 

Example 

Is the variable name assigned to a string you specify. 

Is a series of ASCll characters. 

SET: LOANS CARS 

Assigns the string "CARS" to the variable "LOANS." 

SKIP 

Skips over one or more lines in a script. 

Format 

SKIP: n 

Where: 
n Is the number of lines to be skipped in a script. The default is one. 

Example 

SKIP: 3 

Skips over three lines of a script file. 
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SKIP ON 
NO SKIP ON 

Skips over the next line in a script if the string in the command arrives 
before the remote computer sends a timeout. If a timeout occurs, the 
next line in the script is processed. 

If NO SKIP ON is used, the next line in the script is processed if the 
string arrives before the timeout period ends. 

Format 

SKIP ON: (string) 

Where: 
string Is a series of ASCII characters. 

Example 

SKIP ON: OWES MONEY 

If the host computer sends the string "OWES MONEY" the script 
processor skips to the next line in the file. 
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STOP BITS 

Sets the number of stop bits. 

Format 

STOP BITS: n 

Where: 
n Is either 1 or 2. 

Comments 

When Network is selected, you cannot use the BAUD RATE, 
DATA BITS, DISCONNECT, PARITY, STOP BITS, and XON/XOFF 
commands. These fields are automatically set and cannot be changed. 

Example 

STOP BITS: 2 

Sets the stop bits to two. 
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SYSTEM 
Processes the MS-DOS operating system command specified in the 
string. For more information on using MS-DOS commands in 
MS-Windows, see Chapter 3. 

Format 

SYSTEM: [string] 

Where: 
string Is an MS-DOS operating system command. 

Comments 

When you use the SYSTEM command in a script, MS-Windows creates 
a window that runs COMMAND.COM which in turn runs the DOS 
command and then ends. However, the window is still open on exiting, 
and script processing is suspended until the window is closed. 

To close the window, do one of the following: 
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• From within the MS-Windows COMMAND window, use the 
System menu CLOSE command. 

• Use PIFEDIT to create a .PIF that automatically closes 
COMMAND upon exiting. For information on creating .PIFs, 
see Appendix C. 

The COMMAND.PIF you create should contain the following: 
Program Name COMMAND 

Memory Requirements 32 

Program Switch Text 

Screen Exchange Text 

Close Window on Exit Yes 
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You must also delete the following line in the WIN .INI file 
under the [PIP] heading: 

COMMAND.COM=32 

Example 

SYSTEM: RESTORE 

Tells the script processor to run RESTORE, an MS-DOS operating 
system command. 
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TIMEOUT 

Forces an unconditional timeout. The timeout causes the script to run 
any existing error routines or to end script processing. 

Format 

TIMEOUT: 

Example 

TIMEOUT: 

TIMER 
TIMER OFF 

Sets the time in seconds that the system waits for a correct response 
from the host computer. TIMER OFF turns off the timeout period set by 
the TIMER command, which disables timeouts. 

Format 

TIMER: n 

TIMER OFF: 

Where: 
n Is the time in seconds. The default is 15 seconds. 

Example 

TIMER: 10 
WAIT FOR: Hello 

Indicates that the system is to wait 10 seconds for the string "Hello" to 
be sent from the host computer. 
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TYPE UNTIL 

Sends a string of any length from the keyboard through the 
communication line until the terminating string specified in the 
command is typed. Script processing then begins on the next line 
of the script. 

Format 

TYPE UNTIL: (string) 

Where: 
string Is a series of ASCII characters. 

Comment 

If you type the Ctrl/C sequence at the keyboard, the sequence is ignored 
if a TYPE UNTIL command is in effect. 

Example 

TYPE UNTIL: DONE 

Puts the VT220 into terminal emulation mode until the user types 
"DONE." 

WAIT FOR 

Suspends processing until the remote computer sends a string specified 
in the command or until a timeout occurs. All data sent before the 
string is found is ignored. 

Format 

WAIT FOR: (string) 

Where: 
string Is a series of ASCII characters. 

Example 

WAIT FOR: RESUME SENDING DATA 

Puts script processing on hold until the string "RESUME SENDING 
DATA"is sent by the host computer or until a timeout occurs. 
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XON/XOFF 
NOXON/XOFF 

Responds to XON/XOFF in script processing. NO XON/XOFF ignores 
XON/XOFF in script processing. 

Format 

XON/XOFF: n 

NO XON/XOFF 

Where: 
n Is the rate at which characters are received from the host. The rates 

are: 64, 256, 512, or 1024. 

Comments 

When Network is selected, you cannot use the BAUD RATE, 
DATA BITS, DISCONNECT, PARITY, STOP BITS, and XON/XOFF 
commands. These fields are automatically set and cannot be changed. 

Example 

XON/XOFF: 64 

Sets the XOFF point to 64 bits. 
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Chapter 14 
Using Notepad 

MS-Windows Notepad is a desktop application that lets you create, 
modify, and display text files. Although you usually use Notepad to 
write notes or short memos, you can also create and edit batch files. 

This chapter contains information on how to: 

• Start Notepad 

• Type and format text 

• Scroll 

• Edit Notepad text 

• Work with Notepad files 

Starting Notepad 
To start Notepad when it is neither in a window nor set aside as an icon 
in the icon area, use Run command from the File menu in the MS-DOS 
Executive window. If the MS-DOS Executive is not a window, you must 
expand its icon into a window. 

To start Notepad: 

1. Select the Run command from the File menu in the MS-DOS 
Executive window. 

MS-Windows displays a dialog box. 
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2. Type: 

NOTEPAD 

3. Select the Ok command button. 

When you start Notepad, it creates an empty, untitled window in which 
you can type text. Figure 14-1 shows the Notepad window. 

Figure 14-1: Notepad Window 

Flashing insertion point 

Typing Text 
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You can type in the Notepad window whenever it is active. Notepad 
enters text at the insertion point, which initially is displayed in the 
upper-left corner of the Notepad window. It moves to the right as you 
type. 

Text is encoded in its ANSI representation. For more information about 
ANSI text representations, see Appendix G. 
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Formatting Text 
To format text with Notepad, type the text as you want it to display. 
Figure 14-2 shows how to format text with the Return and Tab keys. 

Figure 14-2: Formatting with the Return and the Tab Keys 

Press the Return key 
twice to insert a space 
between paragraphs. 

Press the Return 
key to end a line. 

Subject: Co111pany Meeting 
Friday, Dece111ber 
8:00 Pill 
Pancho's Uilla Restaurant 

At our quarterly co111pany 111eeting this Friday, the following e111ployees 
will receive a special award for perfor111ance in the last quarter: 

lisa La Fla!ll!lle Sales 

R & D -

Press the Tab key to indent 
a line. 

50¥. over quota 

New Technique 

Press the Tab key to insert 
tab stops. 

You can also wrap text automatically at the right edge of the window to 
continue to the next line. To wrap text, use the Word Wrap command 
from the Edit menu. To cancel wrapping, use the Word Wrap command 
again. 
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Scrolling 
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If you have not set text to wrap and you type beyond the borders of the 
window, Notepad automatically scrolls the text, to the left or up, so the 
insertion point remains visible in the window. 

When text is too long or too wide to be displayed at one time, you can 
scroll through the file to view the text. 

To scroll a Notepad file, use scroll bars. Figure 14-3 shows the scroll 
bars. 

Figure 14-3: Scrolling 

The position of the scroll box corresponds to where 
you scroll in the file. To scroll to the middle of your 
file, drag the scroll box to the middle of the scroll bar. 

At our quarterly coMpany Meeting this Friday, the following eMployees 
will receive a special award for perforMance in the last quarter: 

Lisa LaFlaMMe Sales 50X over quota 
JaMes Gregory -

Chuck Silvers 

R & D -

Service -

New Technique 

20 years 
I hope you will join Me in congratulating these individuals for their 
achieveMents, and in the festivities to follow. 

Click in the gray area to scroll one screen. 
Click on the up or down scroll arrow to scroll one line. 

Click on the left or right scroll arrow to scroll one character. 
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To use the keyboard, press the arrow keys to move the insertion 
point in the direction you want to scroll. When you reach the edge 
of the window, press the arrow key again to scroll the window in that 
direction. Press the Pg Up key to scroll up one screen; press the Pg Dn 
key to scroll down one screen. 

Editing in Notepad 
To edit text in the Notepad window, use commands from the Edit 
menu. You can delete text, move or copy text to a new location, and 
search for text in a Notepad file. 

Notepad loses the first character of a line if the preceding line ends with 
a carriage return, line feed, carriage return (CR,LF,CR) sequence. 

CAUTION 
Notepad cannot always edit files created by using other text 
editors. For example, if the file contains a carriage return 
(CR) but is missing a line feed (LF), Notepad ignores the first 
character after the carriage return, assuming that it is a .line 
feed. The character is in the edit buffer, but is not djsplayed. 
If you then edit and save the file, the character is lost. 

You can also transfer text between Notepad and other applications using 
the Clipboard. When you delete or copy text with the Notepad Cut or 
Copy command, Notepad puts the text in the Clipboard. The Notepad 
Paste command copies information from the Clipboard back into your 
Notepad file. 

The following sections describe how to: 

• Move the insertion point 

• Select text 

• Edit text using the commands from the Edit menu. 
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Moving the Insertion Point 
When you open a Notepad window, an insertion point is displayed. 
When you work in another window and return to Notepad, the insertion 
point is displayed where you left it in the Notepad window. 

You can move th~ insertion point whenever there is text or spaces. To 
move the insertion point, click on the location where you want it. 

To use the keyboard, press the arrow keys. Pressing the up or down 
arrow keys once moves the insertion point up or down one line. 
Pressing the right or left arrow keys once moves the insertion point 
one character to the right or left. 

Selecting Text 
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Before selecting a command from the Edit menu, first select the text 
you want the command to affect. You select text either with the mouse 
or the keyboard or with the Select All command from the Edit menu. 
Figure 14-4 shows selected text. 

Figure 14-4: Selected Text 

To: All personnel 
Subject: Co~pany Meeting 

Friday, DeceMber 7 
8:00 p~ 
Pancho's Uilla Restaurant 

At our quarterly co~pany ~eeting this Friday, the following e~loyees 
will receive a special award for perfor~ance in the last quarter: 

Lisa LaFlaMMe Sales 50¥. over quota 
JaMes Gregory -

Chuck ~ilvers -

R & D -

Service -

New Technique 

20 years 

achieiil~~eiitsiin~illi!imirmmfjiou( individuals for their 



Selecting Text with the Mouse or Keyboard 

To select text: 

Using Notepad 

1. Point to the beginning of the text you want to select. 

2. Drag the mouse over the text you want to select. 

Notepad highlights the selected text. 

To use the keyboard: 

1. Press the arrow keys to move the insertion point to one end of 
the text you want to select. 

2. While holding the Shift key, press the arrow keys to move the 
insertion point to the other end of the text you want to select. 

Notepad highlights the selected text. 

Selecting Text with the Select All Command 

To select all the text in the file, use the Select All command from the 
Edit menu. 

("" Canceling an Edit 

To cancel the most recent edit you made, use the Undo command from 
the Edit menu. You must use this command immediately after the edit 
and before you perform any other editing function. 

Deleting Text 

To delete text: 

1. Select the text you want to delete. 

2. Select the Clear command from the Edit menu. 

To use the keyboard, press the Shift/Del keys. 

Notepad deletes the selected text. 

You can also delete text by copying it to the Clipboard. However, 
each time you put text in the Clipboard, the new text replaces any 
information already in the Clipboard. You can copy or paste this text 
later. 
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To delete text from Notepad and copy it to the Clipboard: 

1. Select the text you want to delete. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

Notepad copies the text to the Clipboard. 

To paste text from the Clipboard into any part of any document: 

1. Move the insertion point where you want the text. 

2. Select the Paste command. 

To use the keyboard, press the Ins key. 

Notepad pastes the text at the insertion point. 

Moving Text 
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To move text: 

1. Select the text you want to move. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

Notepad moves the selected text to the Clipboard. 

3. Move the insertion point where you want the text. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Notepad places the text at the insertion point. 



Copying Text 
To copy text: 

1. Select the text you want to copy. 

2. Select the Copy command from the Edit menu. 

Notepad copies the selected text to the Clipboard. 
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3. Move the insertion point where you want the copied text. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Notepad displays the text at the insertion point. 

Finding Text 

You can find and change text in a Notepad file with the commands 
from the Search menu. When you use a Search menu command, you 
can start searching for text at any point. You can also specify whether 
Notepad matches uppercase and lowercase characters. The Search 
menu commands do not search for text in the index line. 

To find text: 

1. Move the insertion point where the search begins. 

2. Select the Find command from the Search menu. 

To use the keyboard, press Ctrl/F. 

Notepad displays the Find dialog box. Figure 14-5 shows the 
Find dialog box. 
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Figure 14-5: Find Dialog Box 

Search for: 

D Match Case ( Ole ) 

(Cancel) 

3. In the Search For text box, type the text you want Notepad to 
find. 

Notepad ignores capitalization when it searches for text unless 
you tell it otherwise. 

To find occurrences of text that have the same arrangement 
of uppercase and lowercase letters, select the Match Case 
command. 

4. Select the Ok command button to start searching. 

Notepad searches forward from the insertion point and 
highlights the first occurrence of the specified text. Notepad 
tells you if the text does not occur after the insertion point. 

5. To find further occurrences of the specified text, use the Find 
Next command from the Search menu. 

To use the keyboard, press the F3 key. 

If you use the Find Next command, Notepad immediately searches 
for the last specified text. With the Find Next command, you can find 
and edit repeated occurrences of the text you specified with the Find 
command. 
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NOTE 
If you use the Find Next command without first using the 
Find command, Notepad displays the Find dialog box. Type 
the text you want Notepad to find. 
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Working With Notepad Files 
With commands from the File menu in the Notepad window, you can: 

• Open a file 

• View files in other directories 

• Save a file 

• Print a file 

You delete files with commands from the File menu in the MS-DOS 
Executive window. The following sections describe how to use Notepad 
files. 

File Size 

As you edit a file, Notepad records how large it is. Notepad shows the 
size of the file as the percentage of remaining free space. When a file 
has less than 10 percent free space, you should separate the file into 
smaller files. 

NOTE 
Free space does not refer to the amount of available memory. 
It refers only to the amount of text you can have in a file. 

To see how much free space remains, use the About command from 
the System menu. 

Notepad displays the amount of free space. 

Opening a File 
You can open new or existing files in the Notepad window. If you open 
a Notepad file when another file is already open, Notepad doses the 
file that was already opened. If you have changes that are not saved in 
the file that was already open, Notepad asks you if you want to save 
them before it doses the file. Table 14-1 shows what you can reply to 
Notepad and what the resulting action is. 
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Table 14-1: Replies for Opening a File 

Reply 

Yes 

No 

Cancel 

Action 

Saves the changes 

Discards the changes 

Continues working in the current file 

Opening a New File 

To open a new, blank Notepad file, use the New command from the 
File menu. 

Notepad opens a new file in the Notepad window. 

Opening an Existing File 

You should open only ASCII text files in the Notepad window. Text 
files generally have one of the following file extensions: .TXT, .BAT, 
or .INI. If you omit a file extension, Notepad appends the default 
file extension specified in the WIN.INI. To override the default, you 
must end the file name with a period (.). For example, to open the file 
C:TESTCHAR, you must type: 

C: \TESTCHAR. [BeturnJ 

You can open an existing file from either the Notepad window or from 
the MS-DOS Executive window. 

If you try to open a file that is not a text file, Notepad sends the message 
"Not a valid Notepad file" or a message stating the file does not contain 
text. However, if the file was created using MS-Paint, the nontextual file 
is displayed if Notepad receives a message from MS-Paint before 
another file is opened. 

To open an existing file with the Notepad Open command: 

14-12 

1. Select the Open command from the File menu. 

Notepad displays the Open dialog box. Directories and drives 
are enclosed in brackets. Figure 14-6 shows the Open dialog 
box. 
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Figure 14-6: Open Dialog Box 

File name 

~~t"'"' d;"""' File na111e: 1 

~E~O!JXf! + :\windows 
[-A-I 

y path 

[ -B-1 m ( ] [-C-1 :::::: Open 
L, I :::::: 

$ ( Cancel 1 
I + 

Drives 

2. From the list of file names, select the file name you want to 
open, or type a path name and a file name in the text box at the 
top of the dialog box. 

The file name can include wildcard characters. 

You can also double-dick on the file name you want to open. 

3. Select the Open command button. 

Notepad opens the specified file. 

To open an existing file from the MS-DOS Executive window, 
double-dick on the file name you want to open or select the file name 
and press the Return key. 

MS-Windows starts Notepad and opens the file. 

Creating a Time Log File 

Notepad can create a time log file to keep track of how you spend your 
time during the day. To create a time log file, type .LOG as the first 
line in a Notepad file and save the file. You must type .LOG in capital 
letters. Notepad automatically appends the current date and time to the 
end of the file every time you open it. 

To add the current date and time to a file you already have open, use 
the Time/Date command from the Edit menu or if you are using the 
keyboard, press the FS key. 
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To create an accurate log of how you spend your time, edit the file to 
add text after each date and time. 

Viewing Files in Other Directories 
Initially, Notepad displays only text files (.TXT), as well as drives and 
directories. You can view files other than text files in other directories 
or drives. 

To view files in other directories: 

1. Select the Open command from the File menu. 

Notepad displays the Open dialog box. 

2. In the text box, type the directory, drive, or file name you want 
to read. 

For example, you can type *.BAT to list all the files having the 
file extension .BAT. 

To move between directories, you can also double-click on the 
drive letter symbols, the directories, or the [ .. ] symbol. 

3. Select the Open command button. 

Notepad lists the specified files. 

The Open dialog box remains on the screen until you open a 
specific file or cancel the command. 

Saving a File 

When you create a new file or when you finish editing a file, you can 
save it and open it later. To save a Notepad file, you can use one of two 
commands from the File menu: 

• Save As-Saves and names a new file 

• Save-Saves a current file 

14-14 



Using Notepad 

Saving a New File 

The Save As command names and saves a new file. It can also save the 
current file under a new file name and retain the original copy of the 
file on the disk under the old file name. 

To save a new file: 

1. Select the Save As command from the File menu. 

Notepad displays the Save As dialog box. Figure 14-7 shows 
the Save As dialog box. 

Figure 14-7: Save As Dialog Box 

Save file as: C: \windows 
I._MEMO _____ ___.I [ Save ] 

(Cancel) 

2. Type a name for the file. 

If you do not type a file extension, Notepad automatically adds 
.TXT to the file name. 

3. Select the Save command button. 

Notepad saves the file on the disk. The file remains on the 
screen so that you can continue editing it. Notepad displays the 
name of the file in the title bar of the Notepad window. 

NOTE 
If you type the name of a file that already exists, Notepad asks 
if you want to replace the existing file with the file you are 
saving. To replace the existing file, select the Yes command 
button. Otherwise, select the No command button and type a 
different file name. 
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Saving Changes 

The Save command saves your changes to the current file on the disk. 
To save changes to the current file, use the Save command from the 
File menu. Notepad replaces the file on the disk with the current file. 

Printing a File 

The Print command prints your Notepad files. To print a file, use the 
Print command from the File menu. 

Deleting a File 
You can delete a Notepad file when you no longer want it or to make 
room for other files on your disk. To delete a file, use the Delete 
command from the File menu. 
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Chapter 15 
Using Cardfile 

MS-Windows Cardfile is a desktop application that organizes 
information such as names, addresses, phone numbers, and directions. 
Cardfile operates on a file of cards that are organized alphabetically. 
As you use Cardfile, the cards sort themselves automatically to remain 
alphabetized. 

This chapter describes how to: 

• Start Cardfile 

• Create a card file 

• Move through a card file 

• Edit cards in a card file 

• Work with card files 
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Starting Cardfile 
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To start Cardfile when it is neither in a window nor set aside as an 
icon in the icon area, use the Run command from the File menu in the 
MS-DOS Executive window. If the MS-DOS Executive is not a window, 
you must expand its icon into a window. 

To start Cardfile: 

1. Select the Run command from the File menu in the MS-DOS 
Executive window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

CARD FILE 

3. Select the Ok command button. 

When you start Cardfile, it displays an untitled window in which you 
create cards and edit them. Figure 15-1 shows the Cardfile window. 



Using Cardfile 

Figure 15-1: Cardfile Window. 

Flashing insertion point 

Information area 

Creating a Card File 
Cardfile displays a new file as a single, blank card. This section 
describes: 

• Index line 

• Typing text 

• Formatting text 

• Adding new blank cards 
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Index Line 

The index line is a bar at the top of each card. Cardfile uses the text 
you place in the index line to sort the cards alphabetically. 

To place text in the index line: 

1. Select the Index command from the Edit menu, or double-dick 
on the card's index line. 

Cardfile displays the Index dialog box. Figure 15-2 shows the 
Index dialog box. 

Figure 15-2: Index Dialog Box 

Index Line: I 
~--------------------~ 

I Ok J ( Cancel ) 

2. Type text in the text box. 

3. When you finish editing the text, select the Ok command button. 

The text becomes the index line. 

Typing Text 
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After you create an index line, you can add text to a card; however, the 
Cardfile window must be active. When you have more than one card in 
your file, Cardfile places the text on the front card. 

Cardfile enters text at the insertion point, which initially is displayed at 
the upper-left corner of the card. The insertion point moves to the right 
as you type. 

Text is encoded in its ANSI representation. For more information about 
ANSI text representations, see Appendix G. 
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Formatting Text 

Type the text as you want it to display. Figure 15-3 shows how to 
format text with the Return and Tab keys. 

Figure 15-3: Formatting with the Return and Tab Keys 

Press the Tab key to indent a line. 
'Press the Return key to end a line. 

Adding a Card 

You can add a new card to a file at any time. To add a new card: 

1. Select the Add command from the Card menu. 

Cardfile displays the Add dialog box. 

2. Type the text for the new card's index line. 

3. Select the Ok command button. 

Cardfile adds the new card to your file in alphabetical order and 
scrolls the file to display the new card at the front. 
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Moving Through a File 
Cardfile commands affect only the front card. To look at or act upon a 
card, you must move the card to the front of the file. 

To move through the file, you can: 

• Scroll 

• Move a specific card directly to the front 

• Search for a specific occurrence of text 

Cardfile, however, always keeps the cards in alphabetical order. 

Scrolling 
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The Cardfile window has a horizontal scroll bar at the bottom of the 
window. Figure 15-4 shows how to scroll through a file. 



Figure 15-4: Scrolling Through a File 

Corner of N.E. 8th and Main streets 
in Bellevue 

127-1958 for reservations 
-Great food 
-Reasonable prices 
-Conference facilities 
-Uery authentic at~osphere 

Click here with the 
mouse or press the 
Pg Up key to 
display the previous 
card. 

Drag the scroll box 
with the mouse to 
move within tile file. 
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Click here with the 
mouse or press the 
Pg Dn key to 
display the next card. 

The scroll box in the horizontal scroll bar shows your relative position 
in the file. When the first card of the file is displayed in front, the scroll 
box is displayed at the far left of the scroll bar. When the last card is 
displayed at the front, the scroll box is displayed at the far right. 

Moving a Card to the Front 
To move a specific card to the front of a file: 

1. Select the Goto command from the Search menu. 

Cardfile displays the Goto dialog box. Figure 15-5 shows the 
Goto dialog box. 

15-7 



Using Cardfile 

Figure 15-5: Goto Dialog Box 

Goto: ._II ___ ____, 

[ Ok I ( Cancel ) 

2. In the text box, type the index line for the card you want to 
move to the front. 

You only have to type enough text to distinguish the card from 
the other cards. 

3. Select the Ok command button. 

The card moves to the front of the file. 

If you can see a card's index line, you can move the card to the front of 
the file by clicking on the index line. 

To use the keyboard, press the Ctrl key to move a card to the front. 
When you press the Ctrl key and a letter on the keyboard, Cardfile 
scrolls to display the first card that has that letter as the first letter of its 
index line. 

Changing the Index Line 
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To change the text in the index line: 

1. Move the card you want to change to the front of the file. 

2. Select the Index command from the Edit menu, or double-dick 
on the card's index line. 

Cardfile displays the Index dialog box with the text from the 
current index line in the text box. 

3. Type the new text. 

4. Select the Ok command button. 

The new text becomes the card's index line. 

Cardfile automatically replaces the card in the correct alphabetical order 
in the file, then scrolls the file to display the card at the front. 
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Editing Cards 
You edit text in a card with commands from the Edit menu. You can 
change or delete text, or move or copy text to a new location. 

You can also transfer text between Cardfile and other applications by 
using the Clipboard and the Cut, Copy, and Paste commands. 

The following sections describe how to move the insertion point, select 
text, and edit cards. 

Moving the Insertion Point 

When you open a card file, an insertion point is displayed. When you 
work in another window, then return to the card file, the insertion point 
is displayed where you left it in the Cardfile window. 

To move the insertion point, point where you want it and click the 
mouse button. 

To use the keyboard, press the arrow keys. Pressing the up and down 
arrow keys moves the insertion point up or down one line. Pressing the 
right and left arrow keys moves the insertion point one character to the 
right or left. 

Selecting Text 
Before you use a command from the Edit menu, first select the text you 
want the command to affect. Figure 15-6 shows selected text. 

To select text: 

1. Point to the beginning of the text you want to select. 

2. Drag to the end of the text you want to select. 

Cardfile highlights the selected text .. 

To use the keyboard: 

1. Press the arrow keys to move the insertion point to the 
beginning of the text you want to select. 

2. While holding the Shift key, press the arrow keys to move the 
insertion point to the end of the text you want to select. 

Cardfile highlights the selected text. 
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Figure 15-6: Selected Text 

Canceling an Edit 
To cancel the most recent edit you made, use the Undo command from 
the Edit menu. You must use this command immediately after the edit. 

Deleting Text 
To delete text from a card: 

1. Select the text you want to delete. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

Cardfile deletes the text. 

The deleted text is placed in the Clipboard. Each time you place text in 
the Clipboard, however, the text replaces the previous information. 

To replace deleted text, use the Paste command. To use the keyboard, 
press the Ins key. 
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Moving Text 

You can move text from one place to another in a card by first deleting 
it, then pasting it into its new location. You can move text within the 
same card or to another card. 

Moving Text Within the Same Card 

To move text on the same card: 

1. Select the text you want to move. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

3. Move the insertion point where you want the text to be moved. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Cardfile moves the text to the insertion point. 

Moving Text to Another Card 

To move text to another card: 

1. Select the text you want to move. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

3. Move the card on which you want to place the text to the front. 

4. Move the insertion point where you. want to place the text. 

5. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Cardfile moves the text to the new card. 

Copying Text 
To copy text more than once in a file, copy the text to the Clipboard, 
then paste the text where and as often as you want it. 
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Copying Text to the Same Card 

To copy text to the same card: 

1. Select the text you want to copy. 

2. Select the Copy command from the Edit menu. 

Cardfile copies the selected text to the Clipboard. 

3. Move the insertion point where you want the copied text. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Cardfile copies the text at the insertion point. 

Copying Text to Another Card 

To copy text to another card: 

1. Select the text you want to copy. 

2. Select the Copy comman~ from the Edit menu. 

3. Move the card on which y~u·want to place the text to the front. 

4. Move the insertion point where you want to place the text. 

5. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Cardfile copies the text to the new card. 

Finding Text 

You can locate and change text in cards with the Find commands from 
the Search menu. When you select a Find command, you can begin 
searching for text at any place in the file. When locating text, Cardfile 
ignores capitalization. 

To find text: 

15-12 

1. Move the card from which you want the search to begin to the 
front. 

2. Move the insertion point where you want the search to begin. 

3. Select the Find command from the Search menu. 
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Cardfile displays the Find dialog box. Figure 15-7 shows the 
Find dialog box. 

Figure 15-7: Find Dialog Box 

Find: l"-1 ____ ..... 

Ok ( Cancel ) 

4. In the text box, type the text you want Cardfile to find. 

5. Select the Ok command button to start searching. 

Cardfile searches from the insertion point to the end of the file 
and highlights the first occurrence of the specified text. Cardfile 
tells you if the text does not occur in the file. 

After Cardfile has found the first occurrence of the specified text, you 
can find further occurrences by using the Find Next command from the 
Search menu. 

If you use the Find Next command, Cardfile immediately searches for 
the last specified text. With the Find Next command, you can find and 
edit repeated occurrences of the text specified with the Find command. 

Adding Information from Other Applications 

Cardfile can transfer both text and artwork between a card and another 
application. For example, you can create a small map in MS-Paint, 
then transfer it to a card containing a friend's address. The amount of 
information you can transfer is limited by the size of the card. 

To add information from other applications: 

1. Place the information in the Clipboard. 

Usually, you select the Cut or Copy command from the Edit 
menu of the other application. 

2. If you are transferring artwork, move to the Cardfile window 
and select the Picture command from the Edit menu. 

After you transfer a picture, you must use the Text command 
from the Edit menu to process text again. 
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3. On the card, move the insertion point where you want the 
information. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Cardfile moves the information to the insertion point. 

Restoring a Card 
You can restore a card to its original condition as long as it remains at 
the front of the file. Once you scroll, you cannot reverse any changes. 

To restore a card, use the Restore command from the Edit menu. 

Deleting a Card 
You can delete a card from a file. However, you can only replace a 
deleted card by retyping the entire card. 

To delete a card: 

1. Move the card you want to delete to the front of the file. 

2. Select the Delete command from the Card menu. 

Cardfile deletes the front card. 

Copying a Card 
To copy the information in a card to another card: 
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1. Move the card you want to copy to the front of the file. 

2. Select the Duplicate command from the Card menu. 

Cardfile appends an exact copy of the front card to the front of 
the file. 
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Working With Card Files 
• 
With commands from the File menu, you can: 

• Open a file 

• View files in other directories 

• Save a file 

• Print a card or a file 

• Merge files 

You delete files with the File menu in the MS-DOS Executive window. 

File Size 

As you edit a file, Cardfile records its size. Cardfile shows the size of a 
file as the number of cards in the file. 

To find out how many cards are in a file, use the About command from 
the System menu. 

Opening a File 

You can open a new or existing file in the Cardfile window. If you open 
a file when another is already open, Cardfile closes the current file. If 
you have changes that are not saved in the current file, Cardfile asks if 
you want to save them before it closes the file. Table 15-1 shows what 
you can reply to Cardfile and what the resulting action is. 

Table 15-1: Replies for Opening a File 

Reply 

Yes 

No 

Cancel 

Opening a New File 

Action 

Saves the changes 

Discards the changes 

Continues working in the current file 

To create a new file from the Cardfile window, use the New command 
from the File menu. 

Cardfile opens a new file in the Cardfile window. The name "untitled" 
is displayed in the title bar of the window. 
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Opening an Existing File 

You can open an existing file from either the Cardfile window or from 
the MS-DOS Executive window. 

To open an existing file from the Cardfile window, use the Open 
command or double-click on the file name in the list box. Usually, 
these files have the file extension . CRD. 

To open an existing file with the Open command: 

1. Select the Open command from the File menu. 

Cardfile displays the Open dialog box. Directories and drives 
are enclosed in brackets. Figure 15-8 shows the Open dialog 
box. 

Figure 15-8: Open Dialog Box 
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File name 
Current directory path 

File nm: Iii Ul!l I 

[-A-1 
,\;KIJ' + ~:\windows 

£-C-1~ 

' [ I ~i '] Open 
B1N1 I ( Cancel ) 

+ 

Drives 
Parent director y 

2. From the list of file names, select the file name you want to 
open, or type a path name and a file name in the text box at the 
top of the dialog box. 
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3. Select the Open command. 

Cardfile opens the specified file. 

To open an existing file from the MS-DOS Executive window, double­
click on the file name you want to open or select the file name and press 
the Return key. Generally, you can open files with the file extension 
.CRD. 

Viewing Files in Other Directories 

Initially, Cardfile displays only the names of the card files as well as 
drives and directories. You can view files, other than card files, in other 
directories or drives. 

To view files in other directories or drives: 

1. Select the Open command from the File menu. 

Cardfile displays the Open dialog box. 

2. In the text box, type the directory, drive, or file name you want 
to read. For example, you can type *.TXT to read all the files 
having the file extension .TXT. 

To move between directories, you can also double-click on the 
drive letter symbols, the directories, or the [ .. ] symbol. 

3. Select the Open command. 

Cardfile lists the specified files. 

The Open dialog box remains on the screen until you open a specific 
file or cancel the command. 

Saving a File 
When you create a new file, or when you finish editing a file, you can 
save it and open it later. To save a card file, you can use one of two 
commands: 

• Save As-Saves and names a new file 

• Save-Saves a current file 
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Saving a New File 

The Save As command names and saves a new file. It can also save the 
current file under a new file name and retain the original copy of the 
file on the disk under the old file name. 

To save a new file: 

1. Select the Save As command from the File menu. 

Cardfile displays the Save As dialog box. Figure 15-9 shows the 
Save As dialog box. 

Figure 15-9: Save As Dialog Box 
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Save file as: C: \windoiiS 
r.:;IBU;;;;Siw.NE:;;;;S~,--------,1( Save ) 

(Cancel) 

2. Type a name for the file. 

If you do not type a file extension, Cardfile automatically adds 
.CRD to the file name. 

3. Select the Save command button. 

Cardfile saves the file on the disk. The file remains on the 
screen so that you can continue editing it. Cardfile displays the 
name of the file in the title bar of the Cardfile window. 

NOTE 
If you type the name of a file that already exists, Cardfile asks 
if you want to replace the existing file with the file you are 
saving. To replace the existing file, select the Yes command 
button. Otherwise, select the No command button and type a 
different file name. 
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Saving Changes 

The Save command saves the changes to the current file on the disk. 

To save changes to the current file, use the Save command from the 
File menu. 

Cardfile replaces the file on the disk with the current file. 

Printing in Cardfile 

You can print a single card or an entire file (all the cards). 

Printing a Card 

To print a single card: 

1. Move the card you want to the front of the file. 

2. Select the Print command from the File menu. 

Cardfile prints the card on the default MS-Windows printer. 

Printing an Entire File 

To print an entire file (all the cards), select the Print All command from 
the File menu. 

Cardfile prints the file on the default MS-Windows printer. 

Deleting a File 

You can delete a card file when you no longer want it or when you want 
to make room for other files on your disk. To delete a cardfile, use the 
Delete command from the File menu in the MS-DOS Executive window. 

Merging Files 
To consolidate your information, you can merge another file into the 
current file. 

To merge two files: 

1. Select the Merge command from the File menu. 

Cardfile displays the Merge dialog box. Figure 15-10 shows the 
Merge dialog box. 
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Figure 15-1 0: Merge Dialog Box 

File naMe: IZW I 
[-A-l 

,(.lW + C:\windows r-
1-C-l t; I ] ["] Merge 
I BINI ~~~ 

~ ( Cancel ) 
+ 

2. Select the file you want to merge with the current file. 

3. Select the Merge command. 

Cardfile merges the cards from the other file with the cards in 
the current file and sorts all the cards alphabetically. 

Viewing a File as a List 
You can view a file as a list as well as a series of cards. When the cards 
are listed, Cardfile displays the index line of every card in the file. For 
example, you can create a phone directory by including a name and 
phone number in the index line of each card in a file, then display the 
file as a list. 

To display the file as a list, use the List command from the View menu. 

Automatic Dialing 
Automatic dialing works through a DIGITAL PCSO-MA or a 
Hayes-compatible modem. These may not be available in your country. 

If you have a DIGITAL PCSO-MA or a Hayes-compatible modem, 
Cardfile can dial a number for you. 
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To dial a number: 

1. Select the entry you want. 

You can display a list of the cards in the file or move the card 
you want to the front in the Card view. 

2. Select the Autodial command from the Card menu. 

Cardfile displays the Autodial dialog box. Figure 15-11 shows 
the Autodial dialog box. 

Figure 15-11: Autodial Dialog Box 

Dial: l.mJ 
Dial llfpe ®Tone 0 Pulse 

Port ®COMl OCOM2 

Baud Rate ®1288 0388 

00 (Cancel) 

3. Change the dialog box options if necessary. 

Table 15-2 describes the dialog box options. 

4. Select the Ok command button. 

Cardfile dials the number in the Dial text box. 
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Table 15-2: Autodlal Options and Functions 

Option 

Baud rate 

Dial 

Dial Type 

Port 
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Function 

Represents the speed of transmission for your telephone. 
The baud rate is determined by your modem and the 
communications line or network. For the correct setting, 
consult the owner's manual for your modem. 

Searches for a phone number in the specified card, 
beginning with the index line, then places the first phone 
number found into the Dial text box. 

To locate a number other than the first number on the 
card, select the number before you select the Autodial 
command. To change the number in the Dial text box, 
retype or edit the number. 

Selects the dial type of your phone. If you normally hear a 
tone for each number you dial, you have a tone telephone. 
If you hear a clicking sound, you probably have a pulse 
telephone. Generally, push button telephones have tone 
dialing; rotary dial telephones have pulse dialing. 

Selects the port to which your modem is connected. 



Chapter 16 
Using Calendar 

MS-Windows Calendar is a desktop application that resembles a 
desktop calendar or an appointment book. Calendar gives you two 
views of time. In the Day view, you enter, display, or edit your 
appointments for each day. In the Month view, select the day for 
which you want to see appointments. 

You can maintain more than one Calendar file; for example, you can 
view or edit more than one person's appointments. You can also set 
alarms to remind you of particular appointments. 

This chapter describes how to: 

• Start Calendar 

• Edit the day view 

• Set the alarm for your calendar 

• View different times or days 

• Customize your calendar 

• Work with Calendar files 
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Starting Calendar 
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To start Calendar when it is neither in a window nor set aside as an 
icon in the icon area, use the Run command from the File menu in the 
MS-DOS Executive window. If the MS-DOS Executive is not a window, 
you must first expand its icon into a window. 

To start Calendar: 

1. Select the Run command from the File menu in the MS-DOS 
Executive window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

CALENDAR 

3. Select the Ok command button. 

When you start Calendar, the daily appointment window (the Day view) 
is displayed for the current date. Calendar uses the date and time set 
when you started your workstation. Figure 16-1 shows the Day view 
that is displayed when you open the Calendar window. 
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Figure 16-1: Calendar Window: Day VIew 

Click on an arrow to view the appointments 
for the next or previous day. 

Date line 

Appointment area 

Editing the Day View 
You enter appointments in the Day view. If you are in the Month view, 
use the Day command from the View menu. 
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Selecting a Time 
The Day view initially lists times at one-hour intervals, beginning with 8 
a.m. Before typing the description of an appointment, you must select 
the appointment time. 

To select a time: 

1. Point to the desired time. 

2. Click on the mouse button. 

Calendar highlights the selected time. 

To use the keyboard, press the down arrow key to move to the next 
hour. Press the up arrow key to move to the previous hour. 

To schedule an appointment for a time not displayed on the screen, 
scroll the display before selecting the time. For details on scrolling, see 
"Viewing Different Times" in this chapter. 

Entering an Appointment 
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To enter an appointment in the Day view: 

1. Select the time of the appointment. 

2. Type a description of the appointment. 

You are limited to 40 characters. 

For example, you can type: 

Lunch with Lydia 

3. Press the Return key to select the time for the next appointment 
you want to enter. 

Text is encoded in its ANSI representation. For more information about 
ANSI text representations, see the Overview. 
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Selecting Text 

You can change any existing entry for an appointment. However, many 
editing features require that you first select the text of the entry. 

To select text: 

1. Point to the first character of the text to be selected. 

2. Drag to the end of the text. 

Calendar highlights the selected text. 

To use the keyboard: 

1. Press the arrow keys to move the insertion point to the 
beginning of the text you want to select. 

2. While holding the Shift key, press the arrow keys to move the 
insertion point to the end of the text you want to select. 

Calendar highlights the selected text. 

Editing an Entry 

You can edit an existing entry that is selected. To edit the text of an 
entry: 

1. Select the text of an entry. 

2. Type the new text. 

Calendar deletes the old entry when you type the first character 
of the new one. 

Copying an Entry 
To place the same entry more than once in a calendar, copy the text to 
the Clipboard, then paste the text where you want it in the calendar. 
You can copy text from either the appointment area or the scratch pad. 

To copy text: 

1. Select the text. 

2. Select the Copy command from the Edit menu. 

Calendar copies the text to the Clipboard. 

3. Move the insertion point where you want the copied text. 
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You can move it to a time in the appointment area or to the 
scratch pad. 

4. Select the Paste command from the Edit menu. 

Calendar displays the text at the insertion point. 

Deleting an Entry 
You can delete text from either the appointment area or the scratch pad. 
You replace a deleted entry only by retyping it. 

To delete an entry: 

1. Select the text. 

2. Select the Cut command from the Edit menu. 

Calendar copies the text to the Clipboard, then deletes it from 
Calendar. 

Setting the Alarm 
You can set the alarm for as many appointments in your calendar as you 
want. The alarm sounds at the time you specify. 

Turning On the Alarm 
To set the alarm: 
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1. Select the time at which you want an alarm to ring. 

2. Select the Set command from the Alarm menu. 

Calendar sets the alarm. 

The alarm clock symbol, a small bell, is displayed to the left of the 
selected time. When the alarm sounds, Calendar displays a dialog box 
reminding you of the appointment. If the Calendar window is inactive, 
the title bar at the top of the Calendar window flashes. If Calendar is 
an icon when the alarm sounds, the icon flashes. 
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Setting the Alarm for Sound 

You can control whether the alarm makes a sound. Initially, the alarm 
is set for sound; it rings unless you set it to be silent. 

To turn off the sound or to reset the sound for an alarm: 

1. Select the Controls command from the Alarm menu. 

2. Select the Sound option. 

3. Select the Ok command button. 

If the alarm is set for sound, Calendar sets it for silence. If you 
select the Sound option again, Calendar resets the sound. 

Setting the Alarm to Ring Early 

To set the alarm to ring early: 

1. Select the Controls command from the Alarm menu. 

2. Select the Early Ring text box. 

3. Type a number between 0 and 10. This number represents 
the number of minutes before your appointment that the alarm 
rings. 

4. Select the Ok command button. 

Calendar sets the alarm. 

Turning Off the Alarm 

When the Calendar box is active, Calendar displays the Alarm Dialog 
box. If the Calendar window is inactive, the title bar flashes. If 
Calendar is an icon, the icon flashes. 

You can turn off an alarm, letting the time remain set. You can turn on 
the alarm again later. 

To turn off the alarm: 

• If the Calendar window is active, select the Ok command button 
in the Alarm dialog box. 

• If the window is inactive, or if Calendar is an icon, select the 
window or icon. 

After Calendar displays the Alarm dialog box, select the Ok 
command button. 
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To use the keyboard: 

• If the Calendar window is active, press the Return key. 

• If the window is inactive, or if Calendar is an icon, press Alt/Tab 
until Calendar is selected. 

After Calendar displays the Alarm dialog box, press the Return 
key. 

Removing an Alarm 
To remove an alarm: 

1. Select the time the alarm is set for. 

2. Select the Set command from the Alarm menu. 

Calendar cancels the alarm you previously set. 

Viewing Different Times or Dates 
You can move through Calendar to display the appointments you have 
entered or to select a day other than the one currently displayed in the 
Day view. 

Viewing Different Times 
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The Day view displays only a few of the day's appointments. Therefore, 
to see a particular appointment, scroll through the Day view. Table 16-1 
describes how to scroll to view different times with the mouse and 
keyboard. 
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Table 16-1: Scrolling to View Different Times 

To view .•• 

Different appointments 

The next screen 

The previous screen 

Viewing Different Dates 

With the Mouse •.• 

Click on the arrows at 
the end of the scroll bar 

The list of appointments 
scroll in the direction 
the arrow points. 

Click below the scroll 
box 

Click above the scroll 
box 

Using Calendar 

With the Keyboard .•• 

Press the up and down 
arrow keys 

When you reach the last 
visible appointment, 
press the up or down 
arrow key to scroll the 
window to the next or 
previous appointment. 

Press the Pg Dn key 

Press the Pg Up key 

To change the date or month that is displayed, use the commands from 
the Show menu. These commands apply to dates when in the Day 
view, and to months when in the Month view. Table 16-2 describes 
how to scroll to view different dates. 

Table 16-2: Scrolling to View Different Dates 

To display ... 

Current date ot· month 

Previous date or month 

Next date or month 

With the Mouse ... 

Select the Today 
command from the 
Show menu 

Select the Previous 
command from the 
Show menu 

Select the Next 
command from the 
show menu 

With the Keyboard ... 

Press the Home key 

Press Ctrl/Pg Up 

Press Ctrl/Pg Dn 
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Viewing Different Dates Using the Month View 

In the Month view, select the day for which you want to enter, edit, or 
display appointments. 

To display the Month view, use the Month command from the View 
menu or click on the date line. 

Table 16-3 describes how to move in the Month view and select with 
the mouse a day you want to view. 

Table 16-3: Moving In Month VIew with the Mouse 

To select .•• 

Another day 

Next month 

Previous month 

Next year 

Previous year 

Click on ... 

Desired day 

Scroll arrow at the bottom of the vertical scroll bar 

Scroll arrow at the top of the vertical scroll bar 

Gray area below the scroll box 

Gray area above the scroll box 

Table 16-4 describes how to move in the Month view and select with 
the keyboard a day you want to view. 
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Table 16-4: Moving In Month VIew with the Keyboard 

To Select .•• 

Next date 

Previous date 

Date clirectly below the current date 

Date clirectly above the current date 

Next month 

Previous month 

Press .•. 

Right arrow key 

Left arrow key 

Down arrow key 

If the current date is in the bottom 
row of the calendar, pressing the 
down arrow key selects the next 
month. 

Up arrow key 

If the current date is in the top 
row of the calendar, pressing the 
up arrow key selects the previous 
month. 

Pg Dn key 

Pg Up key 

Once you select the day you want, you return to the Day view by 
double-clicking on the selected day, pressing the Return key, or using 
the Day command from the View Menu. 

Viewing a Specific Date 
To display a specific date: 

1. Select the Date command from the Show menu. 

2. In the text box, type the date you want Calendar to display. 

3. Select the Ok command button. 

Calendar displays the date. 

You can type any date between January 1, 1980 and December 31, 2099. 
Type dates in the following format: mm/dd/yyyy or mm-dd-yyyy. You 
do not need to type leading zeros for days or months. 

NOTE 
You can specify the date format that is prevalent in your 
country through the Control Panel. 
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If you type a two-digit number for the year, Calendar assumes the 20ieth 
century. Table 16-5 shows acceptable entries. 

Table 16-5: Acceptable Entries for Dates 

Date Typed Representation 

January 19, 1985 

November 7, 1985 

January 1, 2010 

1/19/85 

11-7-85 

1/1/2010 

Customizing Your Calendar 
You can customize the Day view of your calendar with commands from 
the Options menu. For example, you can change the day settings or 
add notes to your appointments. 

Changing Day Settings 

The day settings control the display of the Day view. 

To change the day settings: 

1. Select the Day Settings command from the Options menu. 

Calendar displays the Day Settings dialog box. Figure 16-2 
shows the Day Settings dialog box. 

Figure 16-2: Day Settings Dialog Box 
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Day Settings 

Interval 0 15 0 30 ® iB 
Hour ForMat ® 12 0 24 

Starting Tine: I 8: OOa111 
I Ok ) 

(Cancel) 

2. Select the options you want: Interval, Hour Format, or Starting 
Time. 
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Interval controls the interval for daily appointments. You can 
select 15-minute, 30-minute, or 60-minute intervals. 

Hour Format represents the Calendar clock: a standard 12-hour 
clock or a 24-hour clock. 

Starting Time is the earliest displayed time when the Day view 
is displayed. 

3. Select the Ok command button. 

Calendar changes the day setting to the option you specified. 

Using Special Times 

You can enter appointments for special times. A special time is any 
time that falls between the intervals set with the Day Settings command 
on the Options menu. For example, 11:10 is a special time. 

Adding Special Times 

To add a special time: 

1. Select the Special Time command from the Options menu. 

Calendar displays the Special Time dialog box. 

2. Type the desired time in the text box. 

3. Select the Insert command. 

Calendar adds the new time. 

Deleting Special Times 

To delete a special time: 

1. Select the time you want to delete. 

2. Select the Special Time command from the Options menu. 

Calendar displays the Special Time dialog box with the selected 
time in the text box. 

3. Select the Delete command. 

Calendar deletes the selected time. 
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Adding Notes 
The daily appointment window has a scratch pad, located at the bottom 
of the Calendar window, to which you can add notes. 

To add notes: 

1. Move the insertion point to the scratch pad area and click. 

To use the keyboard, press the Tab key. 

Calendar displays an insertion point. 

2. Type your notes. 

3. To return to the appointment area, move the insertion point. To 
use the keyboard, press the Tab key to move the insertion point. 

Calendar displays the notes in the scratch pad. 

Marking Dates 
You can mark dates in the Month view. For example, you can mark 
dates of special occasions. · 

Marking a Date 

To mark a date in the Month view: 

1. Point to the date you want to mark and click, or press the arrow 
keys to move to the date. 

2. Select the Mark command from the Options menu. 

Calendar puts a small box around the number. 

Unmarking a Date 

When a marked date is highlighted, the Mark command from the 
Options menu has a check mark next to it. 

To unmark a marked date: 

1. Select the date you want to unmark. 

2. Select the Mark command from the Options menu. 

Calendar removes the box around the number. 
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Working With Calendar Files 
With commands from the File menu in the Calendar window, you can: 

• Open a file 

• View files in other directories 

• Save a file 

• Print a file 

• Remove appointment dates 

You delete Calendar files with commands from the File menu in the 
MS-DOS Executive window. 

Opening a File 
You can have many different Calendar files. For example, you can have 
two files to record two different people's appointments. 

Opening a New File 

To create a new calendar file, use the New command from the File 
menu. 

Opening an Existing File 

You can open an existing file from either the Calendar window or from 
the MS-DOS Executive window. 

To open an existing file with the Open command: 

1. Select the Open command from the File menu. 

Calendar displays the Open dialog box. Directories and drives 
are enclosed in brackets. Figure 16-3 shows the Open dialog 
box. 
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Figure 16-3: Open Dialog Box 

File name 
Current directory path 

File na1t1n 11:1 Ill! I >"!"!l"·]\, llildoiS [-A-1 
[-8-J~ I [ -c-J .;!§ [ Open 
.{,) :~ 

+ ( Cancel ) 

Drives 

2. From the list of file names, select the file name you want to 
open, or type a path name and a file name in the text box at the 
top of the dialog box. 

You can also double-click on the file name you want to open. 

3. Select the Open command button. 

Calendar opens the specified file. 

To open an existing file from the MS-DOS Executive window, double­
click on the file name you want to open or select the file name and 
press the Return key. Usually, these files have the file extension .CAL. 

MS-Windows starts Calendar and opens the file you selected in the 
MS-DOS Executive window. 
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Viewing Files in Other Directories 

Initially, Calendar displays only the names of the calendar files as well 
as drives and directories. You can view files, other than calendar files, 
in other directories or drives. 

To view files in other directories: 

1. Select the Open command from the File menu. 

Calendar displays the Open dialog box. 

2. In the text box, type the directory, drive, or file name you want 
to read. For example, you can type *.CAL to list all the files 
having the file extension .CAL. 

To move between directories, you can also double-dick on the 
drive letter symbols, the directories, or the ( .. ] symbol. 

3. Select the Open command. 

Calendar lists the specified files. The Open dialog box remains 
on the screen until you open a specific file or cancel the 
command. 

Saving a File 

When you create a new file, or when you finish editing a file, you 
can save it and open it later. To save a calendar file, use one of two 
commands from the File menu: 

• Save As-Saves and names a new file 

• Save-Saves a current file 

When using Calendar, keep the size of the .CAL file smaller than 32K 
bytes. Use the Remove option to remove past months. You may have 
to restart your workstation if you try to save a calendar file that is larger 
than 32K bytes. 

Saving a New File 

The Save As command names and saves a new file. You can also save 
the current file under a new file name and retain the original copy of 
the file on the disk under the old file name. 
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To save a new file: 

1. Select the Save As command from the File menu. 

Calendar displays the Save As dialog box. Figure 16-4 shows 
the Save As dialog box. 

Figure 16-4: Save As Dialog Box 

Save file as: C: \windo\6 
II"':':Jo=HN=so~N -----,1 [ Save ] 

(Cancel) 

2. Type a file name for the file. If you do not type an file 
extension, Calendar adds .CAL to the file name. 

3. Select the Save command button. 

Calendar saves the file on the disk. The file remains on the 
screen so that you can continue editing it. Calendar displays the 
name of the file in the title bar of the Calendar window. 

NOTE 
If you type the name of a file that already exists, Calendar 
asks if you want to replace the existing file with the file 
you are saving. To replace the existing file, select the Yes 
command button. Otherwise, select the No command button 
and type a different file name. 

Saving Changes 

To save changes to the current file, use the Save command from the 
File menu. 

Calendar replaces the file on the disk with the current file. 
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Printing Appointments 
To print appointments: 

1. Select the Print command from the File menu. 

Calendar displays the Print dialog box. Figure 16-5 shows the 
Print dialog box. 

Figure 16-5: Print Dialog Box 

Print Appoint111ents 

FroM: I~Hm I [ Ok ] 

To: I (Cancel) 

2. In the From text box, type the first date you want to print. 

3. Press the Tab key to move the cursor to the To text box. 

4. Type the last date you want to print. 

To print a single date's appointments, leave the To text box 
blank. 

5. Select the Ok command button. 

Calendar prints the text for the selected dates. 

Removing Appointment Dates 
You can delete a single date or a range of dates to make room for other 
dates on your disk. 

To remove appointment dates: 

1. Select the Remove command from the File menu. 

Calendar displays the Remove dialog box. Figure 16-6 shows 
the Remove dialog box. 
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Figure 16-6: Remove Dialog Box 

ReMOve AppointMents 

FroM: I~Hm [ Ok I 
To: I I (Cancel) 

2. In the From text box, type the first date you want to remove. 

3. In the To text box, type the last date you want to remove. 

To remove a single date's appointments, leave the To text box 
blank. 

4. Select the Ok command button. 

Calendar removes the text for the dates you selected. 

Deleting a File 

You can delete a file to make room for other files on your disk. To 
delete a file, use the Delete command from the File menu in the 
MS-DOS Executive window. 
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Using Calculator 

The MS-Windows Calculator is a desktop application that works as 
a hand-held calculator. It has many basic arithmetic functions and a 
memory. 

This chapter describes how to: 

• Start Calculator 

• Use Calculator 

Starting Calculator 
To start Calculator when it is neither in a window nor set aside as an 
icon in the icon area, use the Run command from the File menu in the 
MS-DOS Executive window. If the MS-DOS Executive is not a window, 
you must first expand its icon into a window. 

To start Calculator: 

1. Select the Run command from the File menu in the MS-DOS 
Executive window. 

The MS-DOS Executive window displays a dialog box. 
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2. Type: 

CALC 

3. Select the Ok command button. 

When you start Calculator, it creates a window with a calculator in it. 
Figure 17-1 shows the Calculator window. 

Figure 17-1: Calculator Window 

Using Calculator 
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Calculator performs standard calculations. It also has access to the 
Clipboard. 

To use Calculator, point to the keys in the Calculator window and click. 

To use the keyboard, use the keys shown in Figure 17-2. You can type 
the digits 0 through 9 and the plus, minus, multiplication, division, and 
equal signs on the keyboard or on the numeric keypad. If you use the 
numeric keypad, the Num Lock key must be enabled. 
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Figure 17-2: Using Calculator with the Keyboard 

M and C 

M and R 

M and+ 

M and-

Using the Memory 

Q 

% 

c 

Calculator has its own memory, which initially is set to zero. You can 
add to or subtract from this value. You can also display or dear the 
memory. Table 17-1 shows the mouse and keyboard procedures for 
using memory. 

Table 17-1: Using Memory with the Mouse and Keyboard 

To ... 

Clear the memory 

Display the value in memory 

Add the displayed value to 
memory 

Subtract the displayed value 
from memory 

Using the Clipboard 

With the 
Mouse ... 

Click on MC 

Click on MR 

Click on M+ 

Click on M-

With the Keyboard •.. 

Press M/C 

Press M/R 

Press M/+ 

Press M/-

You can use the Clipboard to copy numbers from other applications 
into the Calculator display, and from the Calculator display into other 
applications. 
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Copying to the Clipboard 

To copy the displayed value to the Clipboard, use the Copy command 
from the Edit menu. 

Calculator copies the displayed value to the Clipboard. 

Copying from the Clipboard 
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To add data from the Clipboard to the displayed Calculator value, use 
the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Calculator adds the data from the· Clipboard to the displayed Calculator 
value. If the Clipboard does not contain a number, Calculator does 
nothing. If the Clipboard contains a formula, that is, a legitimate series 
of calculatory entries such as 2X3-4, Calculator pastes the result of the 
formula. 



Chapter 18 
Using Clock 

The MS-Windows Clock is a desktop application that acts as a standard 
clock and shows the current time. 

This chapter describes how to: 

• Start Clock 

• Set Clock 

Starting Clock 
To start Clock when it is neither in a window nor set aside as an icon in 
the icon area, use the Run command from the File menu in the 
MS-DOS Executive window. If MS-DOS Executive is not a window, you 
must first expand its icon into a window. 

To start Clock: 

1. Select the Run command from the File menu in the MS-DOS 
Executive window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

CLOCK 

3. Select the Ok command button. 
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When you start Clock, it displays a window that contains a clock. 
Figure 18-1 shows the Clock window. 

Figure 18-1: Clock Window 

E3 Clock :1 

•• •• 
• • 

• • 

• • 
•• • • 

Setting the Clock 
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Clock displays the time from your hardware clock or the time you 
entered when you started your workstation. You can reset the Clock 
from the Control Panel. 

Clock continues to show the correct time even if you shrink it into an 
icon. When Clock is an icon, you can display the current time without 
using any of the screen's workspace. 



Chapter 19 
Using Reversi 

MS-Windows Reversi is a desktop application that is a game you play 
with your workstation. To win Reversi, you try to finish the game with 
more squares of your color on the board than the workstation has of its 
color. 

This chapter describes how to: 

• Start Reversi 

• Follow the rules of Reversi 

• Play Reversi 

• Use Reversi's hints 

• Start a new game of Reversi 

Starting Reversi 
To start Reversi when it is neither in a window nor set aside as an icon 
in the icon area, use the Run command from the File menu in the 
MS-DOS Executive window. If the MS-DOS Executive is not a window, 
you must first expand its icon into a window. 

To start Reversi: 

1. Select the Run command from the File menu in the MS-DOS 
Executive window. 

The MS-DOS Executive window displays a dialog box. 
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2. Type: 

REVERS! 

3. Select the Ok command button. 

When you start Reversi, it displays a window that contains the Reversi 
game. Figure 19-1 shows the Reversi window. 

Figure 19-1 : Reversi Window 

El Revers! :J 
Ga~e Skill 

- ' 
I . . ' . , ~ ' 

With a black and white screen, your squares are white; the workstation's 
squares are black. The following sections describe how to play Reversi 
using the black and white screen. 
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Rules of the Game 
The rules of Reversi are: 

• You try to turn black squares white by trapping them between 
two white squares. To trap a black square, the three squares 
must form a straight line: horizontal, vertical, or diagonal. 

• If you can trap a black square, you must do so. 

• If you cannot move, select the Pass command from the Game 
menu. 

• When neither you nor the workstation can move, the game is 
over. 

The one with the most squares wins. 

Playing Reversi 
To play Reversi: 

1. Select one of the four skill levels from the Skill menu. 

Skill levels range from Beginner, the easiest, to Master, the 
hardest. The higher the skill level, the longer your workstation 
spends calculating its moves. 

2. Point or press the arrow keys to move to a gray square. 

The mouse cursor displays as a cross when you can make a 
move. 

3. Click on the mouse button or press the spacebar to make your 
1nove. 

4. Wait for the workstation to make its move. 

The mouse cursor may change to an hourglass while the 
workstation calculates its move. 
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Reversi Hints 
You can ask Reversi for hints. When you use the Hint command from 
the Game menu, Reversi shows you where it would move if it had your 
turn. You can accept the hint or move somewhere else. 

Starting a New Game 
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You can start a new game at any time, even in the middle of the current 
game. 

To start a new game, use the New command from the Game menu. 



This chapter describes: 

• MS-Paint 

• Preliminary information 

• Paint definitions 

Defining MS-Paint 

Chapter 20 
Introducing MS-Paint 

MS-Paint is a drawing tool designed for use with MS-Windows. With 
MS-Paint, you can create, enhance, save, and print artwork. 

MS-Paint helps you create art that best suits your needs. Whether you 
create flow charts or freehand illustrations, you can find all the tools 
you need on MS-Paint's tools and shapes palette. Special commands 
such as Zoom In, Copy, and Invert let you enhance your work. You 
can transfer text and graphics from other programs to MS-Paint for 
alteration and enhancement, or create MS-Paint graphics to use in other 
applications such as Cardfile. 

You do not need to memorize complex commands or instructions. With 
MS-Paint, you can create art quickly. Although MS-Paint is designed 
for use with a mouse, you can use it with the keyboard. For more 
information on using the keyboard, see Appendix G. 
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Preliminaries 
Before using MS-Paint, you should become familiar with your 
workstation, its operating system, and MS-Windows. 

Definitions 
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The following definitions are helpful for learning MS-Paint: 

• The canvas is the area available for a drawing. It matches the 
maximum printable surface area of your printer or display 
device. Figure 20-1 shows an MS-Paint canvas for a printer in 
portrait mode. 

Figure 20-1: MS-Paint Canvas 

Paint - HORSUISP • 

_______ I-------
!canvas 

Figure 20-2 shows an MS-Paint canvas that is displayed on your 
screen. This canvas is called the MS-Paint window. 
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Figure 20-2: MS-Palnt Window 

Current status box 
Tool 

Paint pattern 

j Tools and shapes palette 

Brush shape 

Drawing window 
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I Title bar 
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• The drawing window frames the portion of a canvas that is 
displayed on the screen. 

• The title bar contains the title of your canvas. 

• The menu bar contains the names of MS-Paint's command 
menus. 

• The tools and sltapes palette contains the implements for drawing 
and refining your artwork. 

• The current status box shows the tool, paint pattern, brush shape, 
and line width that MS-Paint uses when you draw. 

• The mouse cursor selects menus, commands, tools, and shapes. 
The mouse cursor changes shape in the drawing area when you 
select a different tool or a shape. 
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MS-Paint Tools and Shapes Summary 

This chapter describes: 

• The functions of MS-Paint's tools 

• The functions of MS-Paint's shapes 

This chapter shows the icons for the tools and shapes that are located 
in the tools and shapes palette. You use these icons to follow the 
procedures in Chapter 22 and Chapter 23. 
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MS-Paint Tools and Shapes Summary 

Tools 

r;-:;1 Selection 
~Rectangle 
Defines a rectangular area 

"" edid"" ) 

lal Selection 
~Net 
Defines a nonrectangular 
area for editing. ~ 

/r'l." ,,.,U~' 
'-.._______./ 

ITI Text 

Enters text in the selected 
font, size, and style. 

~ ANTIQUE 
TOY 

COMPANY 

~~~ Fill 

Fills an enclosed area with 
the current pattern. 
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1+1 Scroll 

Slides the canvas under the 
drawing window. 

+ ~.r---. 

[]]Pencil 

Draws a thin line. 

111 Eraser 

Erases the features of a draw­
ing along the pointer path. 

I~ 
lool curve 

Creates a curved line. 

1......-1 Line 

l_f I Brush 

Paints in the current pattern. 

rtiil 
~3-D 
Displays axes to follow when 
creating 3-D drawings. 

1'1:·1 Airbrush 

Sprays paint in the current 
pattern. 



Shapes 

lol Box 

Draws a box with square 
corners. 

H Rounded 
~Box 
Draws a box with rounded 
corners. W'llll//1/1/lll/111111111/1/lllllll/~ 

~ . - - - m 
m =·- C·- ·• m 

~llllllllllllllll/lllltii/J 

lol Circle 

Draws a circle. 

MS-Paint Tools and Shapes Summary 

lol Oval 

Draws an oval. 

···~ 

Q Freehand 
~Polygon 
Draws shapes that are closed 
with a straight line upon 
release of the mouse button. 

16.1 Polygon 
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Chapter 22 
Getting Started With MS-Paint 

This chapter contains the information you need to: 

• Start MS-Paint 

• Draw with MS-Paint 

• Save a canvas 

• Use MS-Paint's palettes 

• Print a canvas 

• Finish MS-Paint 

Starting MS-Paint 
To start MS-Paint when it is neither in a window nor set aside as an 
icon in the icon area, use the Run command from the File menu in the 
MS-DOS Executive window. If the MS-DOS Executive is not a window, 
you must first expand its icon into a window. 
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To start MS-Paint: 

1. Select the Run command from the File menu in the MS-DOS 
Executive window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

PAINT 

3. Select the Ok command button. 

MS-Paint creates an untitled canvas and opens the drawing 
window over it. 

Before you begin drawing, if you intend to print your canvas, select 
the For Printer command from the Options menu. You must also 
be connected to your printer before you can print a drawing. If this 
command is not selected, you will not be able to print any of your 
screens. The canvas is intended for the printer that is the default when 
you create the canvas. 

Select the For Screen command from the Options menu if you have no 
printer, no printer is selected, you only want to display the drawing, or 
you want to transfer the canvas to other MS-Windows applications. 

Once you select a For Printer or For Screen command, you cannot 
change the setting unless you use the New command from the File 
menu. 

Drawing 
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You draw by selecting the drawing tools from the tools and shapes 
palette. The default tool, the Pencil, draws thin lines for sketches. The 
Brush paints an area with the current brush pattern. You erase segments 
of your drawing with the Eraser. Double-clicking on the Eraser, dears 
the whole canvas. 
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Drawing with the Pencil 
To use the Pencil: 

1. Select the Pencil from the tools and shapes palette if it is not the 
current tool. 

The Pencil is displayed in the current tool status box. 

2. Drag the Pencil within the drawing window to sketch. 

Figure 22-1 shows an example of the Pencil drawing Old Man Winter. 

Figure 22-1: Drawing with the Pencil 

Drawing with the Brush 
To draw with the Brush: 

Pencil cursor 

1. Select the Brush from the tools and shapes palette. 

The Brush is displayed in the current tool status box. 

2. Drag the mouse cursor within the drawing window to draw. 
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Figure 22-2 shows an example of the Brush giving Old Man Winter dark 
hair. 

Figure 22-2: Drawing with the Brush 

Brush cursor 

Using the Eraser 

22-4 

You erase mistakes and parts of the drawing that you no longer want 
with the Eraser. 

To use the Eraser: 

1. Select the Eraser from the tools and shapes palette. 

The Eraser is displayed in the current status box. 

2. Drag the mouse cursor within the drawing window to erase. 
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Figure 22-3 shows the Eraser erasing some of Old Man Winter's hair. 

Figure 22-3: Using the Eraser 

Eraser cursor 

Saving a Canvas 
The Save As command saves the contents of your canvas. 

To save your canvas: 

1. Select the Save As command from the File menu. 

A dialog box prompts you to name your canvas. The text box is 
empty when your canvas is untitled. 

Figure 22-4 shows the Save As dialog box. 

Figure 22-4: Save As Dialog Box 

Save File As: C: \windows 

II I ( Save ) 

(Cancel) 

Text box 

Insertion point 
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2. Type a name for your canvas. MS-Paint adds the file extension 
.MSP if you don't provide one. 

3. Select the Save command button. 

MS-Paint writes the contents of your canvas to your disk. 

Once you have created MS-Paint files that have the file extension 
.MSP, you can start MS-Paint by double-clicking on the file name in the 
MS-DOS Executive window. This loads both MS-Paint and the file. 

Using MS-Paint's Palettes 
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To specify patterns, line widths, and brush shapes in MS-Paint, select 
options from the Palette menu. 

For example, to change the current MS-Paint pattern: 

1. Select the Patterns command from the Palette menu. 

The pattern palette is displayed in the drawing window and 
highlights the current pattern. 

Figure 22-5 shows the patterns palette. 

Figure 22-5: Patterns Palette 
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2. Select the pattern you want. 

The pattern palette vanishes, and the new pattern is displayed 
in the current pattern status box. 

Once a palette is displayed on the screen, you must make a selection 
before you can return to your canvas. If you decide not to change the 
selection, select the item currently highlighted. 

Printing a Canvas 
To print an MS-Paint canvas: 

• Your printer must be connected and turned on. 

• The For Printer command from the Options menu must be 
selected when you start MS-Paint, indicating that the printer is 
connected. 

To print your canvas, select the Print command from the File menu. 
MS-Paint prints the canvas on the printer. 

Finishing MS-Paint 
The System menu's Close command finishes an MS-Paint session and 
closes the drawing window. 

To finish an MS-Paint session: 

1. Select the Close command from the System menu. 

If your canvas has changed, MS-Paint displays a dialog box. 

2. Specify whether you want to save the changes before quitting. 

When MS-Paint quits, you are returned to the applications directory in 
MS-Windows. 
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Chapter 23 
Creating a Drawing 

This chapter describes how to: 

• Add shapes, text, and patterns to your canvas 

• Use MS-Paint's selection tools 

• Use several of MS-Paint's editing commands 

Drawing a Box 
To draw a box: 

1. Select the Box tool from the tools and shapes palette. 

The Box is displayed in the current status box. 

2. Point to the drawing window. 

The mouse cursor is displayed as a cross. 

3. Hold down the mouse button to mark a corner, then drag the 
cross diagonally to create the box. 
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Figure 23-1 shows a box with the Box mouse cursor. 

Figure 23-1: Box 

I L.......------------------1 -.-
1 Box cursor 

Drawing Other Shapes 

23-2 

Table 23-1 describes how to use the tools that draw other shapes. 

Table 23-1: Tools for Drawing Shapes and How to Use Them 

Tool 

Une 

3-D 

Curve 

Airbrush 

Rounded Box, 
Circle, Oval 

Freehand Polygon 

Polygon 

Procedure 

Drag to draw straight line segments. 

Drag along the axes that create shapes with a 
three-dimensional appearance. 

Draw a line segment, then dick to the side of it. 
MS-Paint turns the segment into a curve. 

Drag to spray paint in the current pattern. 

Drag to draw the shape. 

Drag to draw. MS-Paint closes the image with a 
straight line when you release the mouse button. 

Click to mark the corners of the image. MS-Paint 
draws the lines. Double-click on the final corner. 



Creating a Drawing 

Adding Text 
The Text tool adds text to a drawing. The text's display is determined 
by the selected commands from the Font and FontSize menus. 

To add text: 

1. Select the Text tool from the tools and shapes palette. 

The Text tool is displayed in the current tool status box. 

2. Point to the drawing window. 

3. Click to mark where you want your text to begin. 

4. Type the desired text. 

Figure 23-2 shows the heading LEGEND, which labels a legend box. 

Figure 23-2: Box with Text 

LEGEND 

Adding Patterns 
The Fill and Filled Box tools add symbolic patterns to a drawing. 
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Drawing a Filled Box 
To create a filled box: 

1. Select the Patterns command from the Palette menu. 

2. Select a pattern for the filled box. 

The pattern is displayed in the current status box. 

3. Select the Filled Box tool from the tools and shapes palette. 

The Filled Box is displayed in the current status box. 

4. Draw a box. 

The pattern fills the box when you release the mouse button. 

Figure 23-3 shows a filled box that is drawn and labeled to represent 
rain. 

Figure 23-3: Filled Box 

LEGEND 

~rain 

Filling a Shape 
To fill a shape: 
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1. Select the Patterns command from the Palette menu. 

2. Select a pattern to fill the shape. 

The pattern is displayed in the current status box. 

3. Select a tool from the tools and shapes palette to draw the 
shape. For example, you can select the Box or the Polygon 
tools. 

The tool is displayed in the current status box. 
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4. Draw a shape. 

5. Select the fill tool from the tools and shapes palette, place the 
tip of the pouring paint in the empty shape, and click on the 
mouse. 

The patt~rn fills the shape when you release the mouse button. 

Figure 23-4 shows a box that is labeled and filled to represent hail. 

Figure 23-4: Filling a Shape 

Fill cursor 

LEGEND 

hail 

Editing a Selection 
You can edit a selection of a drawing. The following sections describe 
how to select part of a drawing, and how to edit with special effects and 
in detail. 

Making a Selection 
To edit a drawing, you must define areas of your canvas with the 
Selection Rectangle and the Selection Net tools. 

To select an area of a drawing: 

1. Select the Selection Rectangle tool or the Selection Net tool 
from the tools and shapes palette. 

2. Drag the cursor to enclose a selection of your drawing. 

The selected area is enclosed within a box if you are using the 
Selection Rectangle tool. The selected area is enclosed within a 
net if you are using the Selection Net tool. 
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Figure 23-5 shows a selected butterfly wing. 

Figure 23-5: Selection Rectangle 
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Copying a Selection 
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Once you select an area of the canvas, you can copy it to the Clipboard, 
leaving the original still displayed. After you paste the area back to the 
canvas, you can move it to where you want. 

To copy a selection: 

1. Select the Copy command from the Edit menu. 

The selected area is copied to the Clipboard. 

2. Select the Paste command from the Edit menu. 

The Clipboard contents are copied to the canvas inside a 
Selection Rectangle. 

The mouse cursor changes to an arrow, indicating that you can 
drag the selection. 

3. Drag the Selection Rectangle inside the drawing window, then 
release the mouse button. 
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Editing with Special Effects 

The special effects commands from the Edit menu enhance a selected 
area of your drawing. 

For example, the Flip Horizontal command mirrors the selected area. 
For descriptions of other special effects commands, see Chapter 24. 

To mirror and paste a selection: 

1. Select an area or object. 

2. Select the Flip Horizontal command from the Edit menu. 

The selected area, still enclosed in the Selection Rectangle, flips 
from left to right. 

3. Drag the selected area into position. 

4. Move the cursor out of the Selection Rectangle, then click the 
mouse button. 

The Selection Rectangle disappears, and the copy is pasted to 
your canvas. 

Figure 23-6 shows a butterfly wing that is selected and mirrored. 

Click the mouse button outside the Selection Rectangle to paste the 
copied wing in place. 

Figure 23-6: Results of the Flip Horizontal Command 
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Editing in Detail 
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To perform detailed editing on a part of your drawing, use the Zoom In 
command and the Pencil. 

To edit a drawing in detail: 

1. Select the Pencil, then click to mark where you want to edit. 

The Pencil makes a mark at the point where you click. 

The mark is white if you click on a black area; it is black if you 
click on a white area. 

2. Select the Zoom In command from the Options menu. 

MS-Paint zooms in to where you last released the mouse button. 
This view of the screen is called a zoomed-in drawing window. 

3. Click to remove or add paint. Drag to make larger changes. 

The results of your editing appear in the upper-left corner of 
your canvas. 

Figure 23-7 shows an example of editing in detail. 

Figure 23-7: Editing in Detail 

Zoomed-in drawing window 

Pmt - CPBUTTER.t1SP • 

/.00DDQ0(5/:J. 

'-~~rr~:···••cA 

- ' \ " ' ' 
. . . . ' . . . 



Creating a Drawing 

4. When you are finished editing, select the Zoom Out command 
from the Options menu. 

The regular drawing window is displayed again. 

Scrolling the Canvas 
The Scroll tool can move the canvas under the drawing window. 

To scroll to a lower area of a canvas: 

1. Select the Scroll tool from the tools and shapes palette and 
move the tool to the bottoin of the drawing window. 

2. Drag the Scroll pointer upward. 

The original area of the canvas scrolls up as the lower part of 
the canvas is displayed. 

The mouse cursor is displayed whenever MS-Paint adjusts the 
window display. 

Figure 23-8 shows a butterfly that is scrolled to reveal the lower part of 
the canvas. 

Figure 23-8: Scrolling the Canvas 

Scroll cursor 
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Chapter 24 
MS-Paint Command Summary 

The MS-Paint commands that help you create, illustrate, and edit your 
canvasses are displayed in menus. You access menus through the menu 
bar near the top of the MS-Paint window. 

This chapter describes the command menus in the order they are 
displayed in the menu bar: 

• File 

• Edit 

• Font 

• FontSize 

• Style 

• Palette 

• Options 
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File Menu 

24-2 

The File menu commands create, save, and print your canvasses. 
Figure 24-1 shows the File menu commands. Table 24-1 describes the 
commands. 

Figure 24-1: File Menu 

Hew 
Open. 
Saue 
Saue As. 
Pt·int 

. . 

Table 24-1: File Menu Commands and Descriptions 
Command 

New 

Open 

Save 

Save As 

Print 

Description 

Clears the drawing window, then opens a new canvas. The 
status of the selected tool, pattern, brush shape, and line 
width is unchanged. 

Opens the drawing window over a previously created 
canvas. The status of the selected tool, pattern, brush 
shape, and line width is unchanged. 

A clialog box prompts you to either select a title from the 
list box or type the title of the canvas you want. 

Saves the current canvas on djsk under the existing name. 
This command prompts you for a name if the file is 
untitled. 

Saves the current canvas on djsk. You can save either new, 
untitled canvases or a new version of a canvas under a 
clifferent name. The original version remains unchanged. 

Prints the canvas. The Print command is clisabled if you 
have not installed a printer through the Setup utility or 
on the Control Panel, or if you selected the For Screen 
command from the Options menu. 

Both the Open and New commands let you save any changes to the 
current canvas before proceeding. 
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Edit Menu 
The Edit menu commands let you edit a canvas. Figure 24-2 shows the 
Edit menu commands. Table 24-2 describes the commands. 

Figure 24-2: Edit Menu 
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Except for the Erase, Undo, and Paste commands, all of the Edit menu 
commands require that you first select what you want to edit. The 
Selection Rectangle or the Selection Net tools select an area. The Paste 
command is disabled if the Clipboard is empty. 

Several commands in the Edit menu are disabled until you select an 
area for editing. 
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Table 24-2: Edit Menu Commands and Descriptions 

Command 

Undo 

Erase 

Cut 

Copy 

Paste 

Oear 

Invert 

Trace Edges 

Flip Horizontal 

Flip Vertical 

Description 

Cancels the most recent drawing action or edits performed 
on a selected area. Selecting Undo a second time restores 
these actions. 

· Erases the contents of the drawing window. 

You can also double-click on the Eraser to erase the drawing 
window. 

Removes selected material from the canvas, and places it 
on the Clipboard. 

Copies selected material to the Clipboard. 

Copies the Oipboard contents into a selection box on the 
drawing window. The items you paste remain selected 
(and movable) until you click outside the selected area, 
make another selection with the Selection Rectangle or the 
Selection Net, or begin to draw again. 

You can paste the contents of the Clipboard as many times 
as you want. 

Erases the selected item from the drawing window. 

Changes the appearance of the selected area. This 
command changes a black area to white, and a white 
area to black. 

Traces the edges of the patterns, text, and shapes within a 
selected area. This command acts on selections made with 
the Selection Rectangle tool. 

Flips the selected area from left to right around a vertical 
axis. This command acts on selections made with the 
Selection Rectangle tool. 

Flips the selected area from top to bottom around a 
horizontal axis. This command acts on selections made 
with the Selection Rectangle tool. 



MS-Paint Command Summary 

Font Menu 

The Font menu contains the commands that select the text typeface. 
The Font menu commands vary according to the fonts installed for your 
system. 

You can continue to change the typeface of a new text sequence only 
until you click again within the drawing window or select another tool. 

FontSize Menu 
The FontSize menu sets the size of your text. The FontSize menu 
commands vary according to the font sizes installed for your system. 

You can continue to change the font size of a new text sequence only 
until you click again within the drawing window or select another tool. 

Style Menu 
The Style menu commands modify the appearanc-:: of text. Figure 24-3 
shows the Style menu commands. Figure 24-4 shows the Style menu 
typefaces. Table 24-3 describes the other Style menu commands. 

Plain is the default typeface. 

You can continue to change the style of a new text sequence only until 
you click again within the drawing window or select another tool. 

Figure 24-3: Style Menu 
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Figure 24-4: Style Menu Typefaces 

~lain Unoerline 

Bold 

Italic ~tri~ee~t 

Table 24-3: Style Menu Commands and Descriptions 

Command 

Align Left 

Align Center 

Align Right 

Opaque 

Transparent 

Description 

Aligns rows of text using an invisible column marker in the 
drawing window as a left margin. Your text moves to the 
right as you type. This is the default setting. 
Click on the text pointer to mark another location or to 
change the location of the invisible column marker. 

Centers text on both sides of the invisible column. 

Aligns text using the column as a right margin. Your text 
moves to the left as you type. 

Provides a solid white background for text. This is the 
default setting. 

Lets the current background pattern show through text. 

Figure 24-5 shows examples of the Align Left, Align Center, and Align 
Right commands. 



MS-Paint Command Summary 

Figure 24-5: Example Align Commands 
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Palette Menu 
The Palette menu commands select: 

• Paint patterns 

• Line widths for shapes 

• Brush shapes 

Figure 24-6 shows the Palette menu commands. 

Figure 24-6: Palette Menu 
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Tools ... 

The Tools command selects MS-Paint's tools when they are concealed 
by another drawing window. 
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Options Menu 
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The Options menu commands: 

• Control the alignment and placement of your drawings, 

• Edit with greater detail 

• Enhance the display of patterns in the patterns palette for the 
current session 

Figure 24-7 shows the Options menu commands. Table 24-4 describes 
the commands. 

Figure 24-7: Options Menu 
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Table 24-4: Options Menu Commands and Descriptions 

Command 

Zoom In 

Zoom Out 

No Grid 

Fine Grid, 
Medium Grid, 
Coarse Grid 

Edit Pattern 

For Printer 

For Screen 

Description 

Zooms in on your canvas at the point where you last 
released the mouse button. Zoom In also returns a 
zoomed-out drawing window to its normal size. 

MS-Paint's zoomed-in drawing window has a view finder 
in the upper-left corner. You view the effects of magnified 
editing in your canvas in this area. 

You can also double-click on the Pencil to zoom in or return 
from a zoomed-in drawing window to the normal drawing 
window. 

Displays the entire canvas with the current drawing 
window outlined. Zoom Out also returns a zoomed-in 
drawing window to its normal size. 

You can also double-click on the Scroll tool to zoom out to 
the full canvas or return from the full canvas to the normal 
drawing window. 

Turns off any active setting. This is the default setting. 

Lay an invisible grid on the drawing window. These 
commands let you align the shapes and lines. 

Opens a dialog box to allow revision of the current 
MS-Paint pattern. 

Informs MS-Paint that the canvas is targeted for the default 
MS-Windows printer. 

Informs MS-Paint that the canvas is targeted for the screen. 
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Chapter 25 
Messages 

This chapter lists and discusses: 

• Disk and device messages 

• MS-Windows messages 

Many of the MS-Windows messages are displayed in dialog boxes with 
an Ok and a Cancel option. To make the dialog box and the message 
disappear before you proceed, select the Ok option. Some dialog boxes 
include a Retry option. To retry an operation, select the Retry option. 

These messages can be displayed while running any MS-Windows 
application. The messages are listed alphabetically, followed by an 
explanation and action to correct the problem. 

Each message has an abbreviation after it, capitalized and enclosed in 
parentheses, to indicate the program that generated the message. The 
following abbreviations are used for messages in this chapter: 

(TE) 

(WIN) 

Messages generated by the VT220 emulator. 

Messages generated by MS-Windows. 
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Disk and Device Errors 
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If a disk or device error occurs at any time during a command or 
program, the MS-DOS operating displays the following message: 

(type) (action) drive x 
Abort, Retry, Fail ? 

Where: 
type Is one of the following: 

action 

drive 

Bad call format error 

Bad unit error 

PCB unavailable 

Invalid disk change 

Non-DOS disk error 

Not ready error 

Sector not found error 

Sharing violation 

Write protect error 

Is either reading or writing. 

Is the drive in which the error occurred. 

Bad command error 

Data error 

General failure 

Lock violation 

No paper error 

Read fault error 

Seek error 

Write fault error 

The MS-DOS operating system waits for you to respond in one of the 
following ways: 

A Aborts the program requesting the disk read or write. 

R Retries the operation. Use this response after you correct the error. 

F Retries the operation. Use this response after you correct the error. 

For more information about disk and device errors, see the MS-DOS 
Refereuce Guide. 



Messages 

Messages 
%SCR- Error. Check ERROR.LOG for explanation. (TE) 

Cause: You have an error in your script file. 

Action: Access the ERROR.LOG file to see what line in your script file 
generated the error. For more information on the ERROR.LOG file, see 
Chapter 13. 

Application still active (WIN) 

Cause: You tried to end the MS-Windows session while a standard 
application is still running. 

Action: Close any standard applications that are running. For 
most applications, this means using the application's QUIT or EXIT 
command. 

Cannot Access Comm Port 'portnumber' [-Exit Set-up?) (TE) 

Cause: The indicated serial communications port is not installed or 
cannot be initialized. 

Action: Make sure the port is properly connected to the modem or 
communications line. 

If this message occurs while trying to exit Set-Up, you have the option 
of remaining in Set-Up or exiting Set-up, in which case no connection is 
made. 

Cannot Access Network [-Exit Set-up?) (TE) 

Cause: The requested Network Terminal Service cannot be initialized. 

Action: Make sure the hardware is properly connected and the network 
is operational. 

Make sure the requested Network Terminal Service is currently available 
, from the host. 

On rare occasions this message can indicate that some limited resource 
of the network or host (such as maximum number of simultaneous 
sessions) has been exceeded. 

If this message occurs while trying to exit Set-Up, you have the option 
of remaining in Set-Up or exiting Set-up, in which case no connection is 
made. 
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Cannot access printer port (TE) 

Cartse: The VT220 terminal emulator cannot open the printer port 
LPTl. The printer may be unable to allocate the necessary queue or the 
hardware may not be present. 

AcHon: Make sure there is a printer port LPTl. You may have to close 
some of your applications to use the printer. 

Cannot change directory to 'directoryname' (WIN) 

Cause: You specified a file name instead of a directory name using the 
Change Directory command. 

AcHon: Select or type a directory name, then retry the Change Directory 
command. 

Cannot copy file to itself (WIN) 

Cartse: You tried to copy a file to the same file name either on the same 
disk or in the same directory. This is not allowed. 

AcHon: Copy the file again, specifying a different destination file name. 

Cannot copy more than one file to a single file (WIN) 

Cause: You selected more than one file name and specified a single file 
as the destination. 

AcHon: Select the file you want to copy and start again. To copy 
multiple files, specify a directory to copy them into. 

Cannot create 'filename' (WIN) 

Cartse: Either of two things occurred: 

1. You tried to save your work to a read-only file. 

2. You tried to create a file on a network drive that is read-only. 

AcHon: Specify another file name or drive name when you save your 
work. 
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Cannot create directory (WIN) 

Cnrtse: Any of the following things occurred: 

1. You tried to create a directory using a name that already exists 
in the current directory or the drive is not ready. 

2. You tried to create a directory on a disk that is write-protected. 

3. You tried to create a directory on a disk that is read-only. 

Action: Try one of the following: 

1. Retry the command with a unique directory name. 

2. If the disk is read-only, use the A TTRIB command to change its 
attributes. 

3. If you tried to create the directory on a diskette that is 
write-protected, remove the write-protection tab. Retry the 
command. 

Cannot delete 'filename' (WIN) 

Cnrtse: Either of two things occurred: 

1. You tried to delete a file on a write-protected diskette. 

2. You tried to delete a read-only file. 

Action: Try one of the following: 

1. Remove the write-protection tab and retry the command. 

2. Use the ATTRIB command to change the file's attributes so that 
you can delete it. 

Cannot delete the current directory (WIN) 

Cnrtse: You tried to delete the current directory. This is not allowed, 
even if the directory is empty. 

Action: Move to the directory above your current directory and retry 
the RMDIR command. 
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Cannot find 'filename' (WIN) (TE) 

Cause: The MS-DOS Executive cannot find the file in the directory or 
on the disk. 

Action: Make sure you typed the file name correctly. You may need 
to change directories to locate the file, or you may need to type a path 
name before the file name. If the file is not on the diskette, insert the 
diskette containing the file in the drive. Select the command and try 
again. 

If the file contains special characters, try the operation through the 
MS-DOS operating system. 

Cannot format diskette (WIN) 

Cause: The diskette is defective or a read-only diskette or the drive is 
not ready. 

Action: Try one of the following: 

1. Be sure the drive door is closed. 

2. Replace the diskette if it is defective and retry the command. 

3. Remove the write-protect tab and retry the command. 

Cannot Open 'filename' (TE) 

Cause: The MS-DOS operating system cannot find the file you 
specified, or you tried to open a file that is in a read-only access area. 

Action: Make sure the file exists. If the file exists, make sure the path is 
a valid path. Make sure you typed the file name correctly. 

Cannot Open Printer (TE) 

Cause: MS-Windows cannot allocate the memory needed for a print 
operation. 

Action: Reduce the number of processes you are running or close some 
of your applications in MS-Windows. 

Cannot print (WIN) 

Cause: You did not properly install your printer (this includes having 
proper settings in the WIN.INI file). 

Action: Check the printer connections and Control Panel printer 
settings. Set your printer up properly and start again. 
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Cannot put MS-DOS system on the diskette (WIN) 

Cause: The diskette cannot be initialized with the system files. 

AcHon: Put a blaqk, formatted diskette in the drive and retry the SYS 
command. 

The source diskette must contain the following: 

1. COMMAND.COM in the root directory 

2. IO.SYS 

3. MSDOS.SYS 

The destination diskette must meet these requirements: 

1. The first two directories are empty. 

2. The first n clusters are free, where n is enough room for IO.SYS 
and MSDOS.SYS. 

3. There is enough room on the disk for IO.SYS, MSDOS.SYS, 
and COMMAND.COM. 

Or, the destination diskette must meet these requirements: 

1. The first two directory entries are IO.SYS and MSDOS.SYS. 

2. The first n clusters are allocated to these files, where n is enough 
room for IO.SYS and MSDOS.SYS. 

3. There is enough room on the disk for IO.SYS, MSDOS.SYS, 
and COMMAND.COM after deleting the original files. 

Cannot Read 'filename' (TE) 

Cause: An error occurred while reading the specified file. 

AcHon: Try again. 

Cannot read from device 'devicename' (WIN) 

Cause: Either of two things occurred: 

1. MS-Windows could not read from the specified device. 

2. The specified device was not available for input. 

AcHon: Make sure the device is properly set up (and, if appropriate, 
turned on). Select Retry to try the operation again, or Cancel to end the 
operation. 
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Cannot read from drive 'drivename' (WIN) 

Cause: Any of the following things occurred: 

1. There was no disk in the specified drive. 

2. The disk drive door was open or the disk was not inserted 
properly. 

3. MS-Windows could not read the disk in the drive you specified. 

4. The disk was defective, damaged, or not formatted. 

5. There was a network error or disconnect from the device. 

Action: Select Retry to try the operation again. If a floppy drive is 
specified, make sure the diskette is properly inserted. If you continue 
to receive this message, select the Cancel option. 

Cannot rename 'filename' (WIN) 

Cause: The specified file does not exist in the current directory or on 
the disk. 

AcHon: Make sure the file name exists, then retry the command. You 
cannot rename a directory. 

Cannot run 'filename' (WIN) 

Cause: An error occurred while you were running a program. 

Action: Retry the Run command. If the command still does not work, 
make sure you are trying to run the correct file. Make sure the file is 
a program or invokes a program through the extension settings in the 
WIN.INI file. 

Cannot run with other applications (WIN) 

Cause: The program you selected is a special application that loads and 
stays resident and has the Modifies Memory option set in its .PIF file. 

AcHon: Close all applications except the MS-DOS Executive before you 
can start this program. 



Messages 

Cannot set volume name (WIN) 

Cause: Any of the following things occurred: 

1. The diskette is write protected. 

2. The diskette is full. 

3. The drive is a network device. 

AcHon: Try one of the following: 

1. If you are trying to set the volume name for a diskette, remove 
the write-protect tab. Retry the command. 

2. Check the directory to see if any files can be removed, then try 
again. 

Cannot Write 'filename' (TE) 

Cause: An error occurred while writing the specified file or the device 
is full. 

AcHon: Try again. Make sure there is enough room on the device. 

Cannot write to device 'devicename' (WIN) 

Cause: Any of the following things occurred: 

1. MS-Windows cannot write to the specified device. 

2. The specified device is not available for output. Be sure the 
device is properly set up (and, if appropriate, turned on). 

3. There was a network error or disconnect from the device. 

AcHon: Select Retry to try the operation again, or Cancel to end the 
operation. 
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Cannot write to drive 'drivename' (WIN) 

Ca11se: Any of the following things occurred: 

1. There is no disk in the specified drive. 

2. The floppy drive door is open, or the diskette is improperly 
inserted. 

3. MS-Windows cannot write to the diskette in the drive you 
specified. 

4. The diskette is defective, damaged, or not formatted. 

5. There was a network error or disconnect from the device. 

Action: Select Retry to try the operation again. If a floppy drive is 
specified, be sure the diskette is properly inserted. If you continue to 
receive the message, select Cancel. 

Change Filename to 'filename' (TE) 

Cause: You tried to redirect the printer output to a file that does not 
have an extension of .PRN. MS-Windows requires this extension. 

Action: To accept the indicated file name, click on the Yes button or 
press the Return key. To cancel the print request, click on the No 
button or press the Escape key. 

COM1 and COM2 is not available (WIN) 

Cause: Either of two things occurred: 

1. The application that you select requires access, but cannot 
access, the serial communications port 1 (COMl) or serial 
communications port 2 (COM2). 

2. You do not have a serial communications card installed as 
COMl or COM2. 

Action: To run the program you selected, you must close any other 
application that accesses the COMl or COM2 port. If you do not have 
a serial port, you cannot run the selected program. 
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COM1 is not available (WIN) 

Cause: Either of two things occurred: 

1. The application you have select requires access, but cannot 
access, the serial communications port 1 (COM1). 

2. You do not have a serial communications card installed as 
COMl. 

AcHon: To run the program you selected, you must close any other 
application that accesses the COM1 port. If you do not have a serial 
port, you cannot run the selected program. 

COM2 is not available (WIN) 

Cause: Either of two things occurred: 

1. The application that you select requires access, but cannot 
access, the serial communications port 2 (COM2). 

2. You do not have a serial communications card installed as 
COM2. 

AcHon: To run the program you selected, you must close any other 
application that accesses the COM2 port. If you do not have a serial 
port, you cannot run the selected program. 

Comm Port (n) Is In Use [-Exit Set-up?] (TE) 

Cause: The indicated serial communications port is in use by some 
other application. 

Action: Select another port or exit the application currently using the 
port. 

If this message occurs while trying to exit Set-Up, you have the option 
of remaining in Set-Up or exiting Set-up, in which case no connection is 
made to the indicated port. 

Comm Port 'number' unavailable (TE) 

Cause: No communications port exists. 

AcHon: Do not try to use this port for communications. 
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Directory is not empty (WIN) 

Cause: The directory still contains files. 

Action: Delete the files from the directory, or move them to a different 
location and start again. 

'Directoryname' has no files in it (WIN) 

Cause: You tried to copy files from an empty directory. 

Action: Make sure you are using the correct directory name. 

Disk is full (WIN) 

Cause: You tried to save a file, or carry out an action that requires 
creating a new file, and the disk is full. 

This message is also displayed at system start-up time if the MS-DOS 
operating system cannot open a file. 

Action: Insert another disk, or delete any unwanted files and directories 
from the disk, and try again. 

Do You Wish to Reconnect to 'servicename' (TE) 

Cause: The prior Network Terminal Service session timed out. 

Action: To reestablish the prior terminal service, click on Ok (or press 
the Return key). You can now log in to the host. 

Error in EXE file (WIN) 

Cause:You attempted to run an application that directly modifies 
memory from within a standard application. 

Action:You must run this application outside of MS-Windows. 

Initial directory not found (WIN) 

Cause: The initial directory for this program could not be found or was 
invalid. 

Action: Check the PIF file for the program and be sure that the initial 
directory setting is correct. 
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Insert 'programname' or 'diskname' in drive 'drivename' (WIN) 

Cnrtse: MS-Windows needed a program or file that was not on the disk 
in the active drive. 

AcHon: Insert the specified disk and select OK. 

Invalid set-up file (TE) 

Cause: The set-up configuration file was not the same version as the 
terminal emulator. The information stored was invalid. 

AcHon: Delete the set-up configuration file and create a new one. 

Multiple destinations not allowed (WIN) 

Cnrtse: You tried to copy a single file to more than one new file, or tried 
to rename a single file with more than one new name. 

AcHon: Copy or rename the file to a single destination. 

Multiple files not allowed (WIN) 

Cnrtse: You specified too many file names for a command. 

AcHon: Retry the command and specify only one file name. 

Need more disk space (WIN) 

Cnrtse: You tried to load a standard application that required 
MS-Windows to swap another application to disk. There was 
insufficient disk space for swapping. 

AcHon: Close one of the other standard applications you have running. 
Retry the command. If there is still limited space remaining on the 
swap disk, you may have to delete some files. 

Need WINOLDAP files to run program (WIN) 

Cnuse: The program you selected requires the 
MS-Windows system files WINOLDAP.MOD and WINOLDAP.GRB to 
run. 

AcHon: These files should be in the same directory as your other MS­
Windows system files. If this message is displayed again, check the 
directory to make certain that they are available, and then try running 
the program again. 
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Network Is In Use [-Exit Set-up?] (TE) 

Cnuse: You tried to open a fifth session. Only four simultaneous 
Network Terminal Service sessions are allowed. 

Action: Find another application using a Network Terminal Service 
(usually another instance of the VT220 terminal emulator) and log out of 
the host or exit the application. 

If this message occurs while trying to exit Set-Up, you have the option 
of remaining in Set-Up or exiting Set-up, in which case no connection is 
made to the network. 

Network Terminal Services driver not installed (TE) 

Cnuse: The Network Terminal Services driver was not installed prior to 
starting MS-Windows. 

Action: Close the session, install the driver, and restart the session. To 
install the driver, type: 

A:>NET START LAT lReturnl 

No more files can be opened (WIN) 

Cause: The MS-DOS operating system is already running the maximum 
number of files. 

Action: Close one or more of the applications you are running and try 
running the selected program again. 

Not enough memory (WIN) 

Cause: You initiated an action, such as copying a file, that required 
more memory than MS-Windows currently had available. 

Action: Close one or more application programs and retry the 
command. 

Not enough memory to display entire directory (WIN) 

Cause: The MS-DOS Executive required more memory than was 
currently available to display the full directory. 

Action: Close one or more application programs. 
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Not enough memory to run (WIN) 

Cause: MS-Windows tried to run a standard application that required 
more memory than was currently available. 

Action: Close an application, then select the Run command. If this 
message is displayed again, continue closing applications and selecting 
the Run command until either the message is no longer displayed or 
until the MS-DOS Executive is the only remaining application. The 
program will now run after enough memory has been freed by closing 
other applications, and if the MS-DOS Executive is the only application 
running. 

Not enough memory to run 'filename' (WIN) 

Cause: Either of two things occurred: 

1. MS-Windows tried to run a program that required more memory 
than was currently available. 

2. Your version of MS-Windows does not support one or more of 
the run-time routines. 

Action: Try one of the following: 

1. Close one or more applications. Select the Run command again. 

2. If this message is displayed and only the MS-DOS Executive 
window is running, you cannot run the specified file with this 
version of MS-Windows. 

Printer not ready (WIN) 

Cause: Either of two things occurred: 

1. The printer is out of paper. 

2. The printer is off or not ready. 

Action: Make sure the printer paper is properly installed. If the paper 
is properly installed, make sure the printer is connected and turned on. 

Printer port is in use (TE) 

Cause: While using the VT220 terminal emulator, you tried to use 
printer-controller mode, but another application is using the printer. 

Action: Try again after the current print job is finished. 
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Set-Up file 'filename' is incompatible and will be ignored (TE) 

Cause: You tried to load a Set-Up configuration file which was of the 
wrong format or wrong version. This can occur when starting the VT220 
emulator or using the 'Recall Set-Up Parameters' option in Set-Up. 

Action: Make sure the file is not damaged. Make sure that when you 
run a new version of the VT220 emulator that your Set-Up files are 
compatible with the new version. Delete or update the old file by 
entering Set-Up, making the parameter settings you desired, and saving 
them with the 'Save Set-Up Parameters' option. 

Start session error (TE) 

Cause: There was an error accessing the Network Terminal service. The 
service cannot be initiated. 

Action: Contact your system administrator. 

To activate Compose, use KEYB to load an ISO or MCS keyboard file 
(TE) 

Cause: You pressed the Compose key without first loading the ISO or 
MCS keyboard map file. 

Action: Use the DECKEYB command to load the ISO or MCS keyboard 
map file. Now you can use the Compose key. 

Too many docks or timers (WIN) 

Cause: You tried to run a program that requires a system clock but no 
more are available. 

Action: Exit or close one of the other application programs. Try running 
your program again. 

Unable to connect to 'servicename' (TE) 

Cause: You entered an invalid or inaccessible network name. 

Action: Make sure you entered a valid service name. If the service is 
not available, try again later. 

Write protected disk in drive 'drivename' (WIN) 

Cause: The disk in the specified drive was write-protected. 

Action: Remove the write-protect tab and select Retry. Otherwise, 
select Cancel. 
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Appendix A 
Information About the WIN .INI File 

This appendix describes the WIN.INI file, which contains some 
applications and settings for many MS-Windows features and 
applications. MS-Windows checks the WIN.INI file and uses these 
settings each time you start MS-Windows or an MS-Windows 
application. 

NOTE 
You rarely need to change the WlN .IN I file. The 
Configuration Aide creates the WlN.INI file on the key 
diskette. This appendix provides the instructions primarily for 
special system customization. The settings in your WIN.INI 
can vary from those shown here. 

You should print a copy of the WIN .INI file before you change it, using 
the Print command from the MS-DOS Executive window. 

MS-Windows searches for the WIN.INI file in the directory from which 
you start MS-Windows. If MS-Windows does not find the WIN.INI file 
in that directory, MS-Windows searches the directories given in the 
path. 

You can place comments in the WIN.INI file by making the first 
nonspace character a semicolon (;). Comments cannot contain equal 
signs. 
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Table A-1 describes the sections of the WIN.INI file that affect MS­
Windows settings. 

Table A-1: Sections of the WIN.INI File 

Section 

Windows 

Extensions 

Colors 

PIF (Program 
Information File) 

Ports 

International 

DECLAT 

DECKeybd 

DECinfo 

Devices 

Fonts 

Setting 

Controls the loading of the spooler. 

Sets double-dick speed. 

Sets cursor blink speed. 

Specifies the file extensions listed in the MS-DOS 
Executive window with the Programs command. 

Defines the name for the null port. 

Starts applications as icons. 

Starts applications in windows. 

Defines default printer device. 

Swaps the action of the mouse buttons. 

Starts an application when you select a file with the 
specified file extension. 

Specifies the shades of gray in the MS-Window's display 
screen. 

Defines swap disk and swap size. 
Specifies program information entries for applications 
used with MS-Windows. 

Defines the communications ports you can use. 

Defines MS-Windows for operation in foreign countries. 

Redirects the communications ports to a network 
terminal service. 

Sets the keyboard operations settings. 

Defines the location of the on-line Information System. 

Defines the output devices recognized by MS-Windows. 

Defines the display fonts MS-Windows can use. 



". \ 

Information About the WIN.INI File 

Changing the WIN .INI File 

Before you change the WIN .INI file, you should be familiar with 
MS-Windows and MS-Windows applications such as Notepad. 

To change the WIN.INI settings, use: 

• The MS-Windows Control Panel 

This is the preferred method for making changes, because 
MS-Windows edits the file for you. Any changes made with the 
Control Panel take effect immediately. 

• The Notepad application to edit the WIN.INI file 

Any changes made with an editor do not take effect until 
MS-Windows is restarted. 

NOTE 
You can use any text editor that produces an ASCII file to 
edit the WIN.INI file. Do not use any editors that include 
special formatting characters in addition to the standard 
ASCII formatting commands. 

Edits made with a text editor do not take effect until 
MS-Windows is restarted. 

The following sections describe the sections of the WIN .INI file. 

Windows Section 
The Windows section contains settings that take effect when 
MS-Windows is started. 

NOTE 
In the Windows section, you change some settings with 
the Control Panel and some with an editor. To change the 
double-click speed, cursor blink rate, default device, and swap 
mouse button settings, use the Control Panel. To change 
the programs, load, run, spooler, and null port settings, use 
Notepad. 
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Format 
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(windows) 
spooler=setting 
DoubleClickSpeed=speed 
CursorBlinkRate=speed 
programs= list 
NullPort=port 
load= list 
run= list 
device=name,driver,port 
SwapMouseButtons=setting 

Where: 

spooler= setting 

Determines whether the spooler is used when printing. The setting 
can be: 
Yes 

No 

The spooler is used when printing. 

The spooler is not used when printing. 

DoubleClickSpeed =speed 

Sets the speed in milliseconds for the double-click operation of the 
mouse. Speed can be 0 to 65535 ms. 

CursorBlinkRate =speed 

Sets the speed in milliseconds for the cursor blinking action. Speed can 
be 0 to 65535 ms. 

programs= list 

Specifies the files displayed in the MS-DOS Executive window when 
you select the Programs command from the View menu. The list 
contains the file extensions without the period. Separate the file 
extensions with spaces. 
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NullPort =port 

Defines the name for the null port to a specified port. The Control 
Panel, Spooler, and other applications use this port when an output 
device is installed, but is not connected to any port. 

load=list 

Starts the specified applications as icons when you start MS-Windows. 
The list contains the application file names as they are displayed in the 
MS-DOS Executive window without the file extension. (For example, 
Calculator is CALC, because CALC.EXE is the application file name.) 
Include a space between the file names. MS-Windows first searches the 
current drive, the directory, then the path. Otherwise, specify a path 
name. 

The MS-DOS Executive starts automatically as an icon, if it is not started 
in a window. 

You can create an icon that starts an application and opens a data or text 
file by adding the file name and the file extension to the load setting. 

To use this option, you must define the application in the Extensions 
section of the WIN .INI file. 

For example, DOTHIS.TXT starts Notepad because .TXT is in the 
Extensions section, starting the Notepad application. 

run=list 

Starts the specified applications in windows when you start 
MS-Windows. You list the file names exactly as they are displayed in 
the MS-DOS Executive window without the file extension. (For example, 
enter Calculator as CALC, because CALC.EXE is the application file 
name.) 

Include a space between the file names. MS-Windows first searches the 
current drive, the directory, then the path. Otherwise, specify a path 
name. 

You should not specify a file name either for a special application or for 
an application that uses a large amount of memory; otherwise, you will 
enter an endless loop when you exit from the application. 

You can arrange windows by using spaces to designate windows within 
the same column, and commas to designate a new column. 
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You can start an application and open a data or text file in a window 
when you start MS-Windows by adding the file name and the file 
extension in the run setting. To use this option, you must define the 
application in the Extensions section of the WIN.INI file. 

device= name,driver,port 

Defines the default printer (or plotter): 
name Is the name of the default device. You must also specify this 

default device in the Devices section. 

driver Is the file containing the device's printer file name without the 
file extension. 

port Is the port to which the device is connected. You must also 
specify this port in the Ports section. 

SwapMouseButtons ... setting 

Swaps the functions performed by the left and right mouse buttons. 
Setting can be: 
No 

Yes 

The left mouse button controls the mouse functions. This is the 
default. 

The right mouse button controls the functions. 

Windows Section Example 

The following Windows section: 

• Enables the spooler when printing. 

• Sets the mouse double-click speed to 900 ms. 

• Sets the cursor blink rate to 550 ms. 

• Specifies that files with the .COM, .EXE, and .BAT file 
extensions are displayed in the MS-DOS Executive window 
when you use the Programs command. 

• Specifies None as the null port. 

• Using no file specifications, starts Notepad and Calculator as 
icons, and starts Notepad with the text file ONGOING.TXT. 
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• Starts Clock in the first window of the first column, Calculator 
in the second window of the first column, Notepad in the 
first window of the second column, and Notepad with the file 
specification K:\MEMOS\ONGOING.TXT in the second window 
of the second column. 

• Sets the default printer to a DIGITAL LA75, which is connected 
to the LPTl: port. 

• Does not switch the left and right mouse buttons. 

Example 

(windows] 
spooler=yes 
DoubleClickSpeed=900 
CursorBlinkRate=550 
program=com exe bat 
NullPort=None 
load=notepad calc ongoing.txt 
run=clock calc,notepad K:\memos\ongoing.txt 
device=Digital LA75,LA75,LPT1: 
SwapMouseButtons=No 
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Extensions Section 
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In the Extensions section, you can specify file extensions that let you 
start an application and open a file in a single operation. When you 
select a file with the specified file extension, MS-Windows starts the 
application and opens the file in one step. 

NOTE 
To change the Extensions section, use the Notepad application. 

Format 

(extensions] 
extension=application filename 

Where: 
extension 

application 

parameter 

Is the file extension that starts the specified application. 

Is the name of the application that is started. You must 
include the application's extension (.EXE). 

Is the name and extension of the file (optional) for the 
application to open. You can use a caret 0 to represent 
any file with that extension (for example, A.TXT). Then 
you can select any file with the specified extension, and 
MS-Windows starts the application with that file. 

Extensions Section Example 

The following Extensions section: 

• Starts the Notepad application when you use the MS-Windows 
Run command with a file containing a .TXT file extension. 

• Starts the Notepad application when you use the MS-Windows 
Run command with a file containing an .INI file extension. 

• Starts the MS-Paint application when you use the MS-Windows 
Run command with a file containing an .MSP file extension. 

Example 

[extensions) 
txt=notepad.exe ~.txt 
ini=notepad.exe ~.ini 
msp=paint.exe ~.msp 
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\ Colors Section 

Purpose 
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The Colors section specifies the shading for various components of the 
MS-Windows screen. 

NOTE 
To change the Colors section, use the Control Panel. 

Format 

[colors] 
component=redvalue greenvalue bluevalue 

Where: 

component 

Specifies the component of the MS-Windows screen. The component 
can be: 
Window 

WindowText 

Scrollbar 

Active Title 

Inactive Title 

Title Text 

Window Frame 

Menu 

Menu Text 

Background 

redvalue 

Is the nontextual background of the window work area. 

Is the textual display in the window work area. 

Is the scroll bar. 

Is the background of the active title bar. 

Is the background of the inactive title bar. 

Is the application title's text. 

Is the set of lines that form the frame of the window and 
the nontextual part of the application's title background. 

Is the nontextual background of the menu area. 

Is the textual display in the menu area. 

Is the icon area and screen background. 

Is a number that specifies the intensity of red used. The number can be 
0 to 255. 

greenvalue 

Is a number that specifies the intensity of green used. The number can 
be 0 to 255. 
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bluevalue 
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Is a number that specifies the intensity of blue used. The number can 
be 0 to 255. 

NOTE 
Because you have a monochrome screen, the redvalue, 
greenvalue, and bluevalue settings affect the gray scale of 
the MS-Windows components. The low end of the gray scale 
is 0, and the high end of the gray scale is 255. Therefore, if 
all three settings are 0 (setting=O 0 0), the color is black. If 
all three settings are 255 (setting=255 255 255), the color is 
white. Settings between 0 and 255 produces varying shades of 
gray. 

Color Section Example 

The following Colors section: 

• 

• 
• 
• 
• 
• 
• 

• 
• 
• 

Sets the nontextual background of the window work area to 
white. 

Sets the textual display in the window work area to black . 

Sets the scroll bar to a shade of gray . 

Sets the active title bar background color to black . 

Sets the inactive title bar background color to a shade of gray . 

Sets the application title to white . 

Sets the lines that form the frame of the window and the 
nontextual part of the application's title background to black. 

Sets the nontextual background of the menu area to white . 

Sets the textual display in the menu area to black . 

Sets the icon area and screen background to a shade of gray . 



Example 

[colors) 
Window=255 255 255 
WindowText=O 0 0 
Scrollbar=192 192 192 
ActiveTitle=O 0 0 
InactiveTitle=128 128 128 
TitleText=255 255 255 
WindowFrame=O 0 0 
Menu=255 255 255 
MenuText=O 0 0 
Background=128 128 128 

Information About the WIN.INI File 

A-11 



Information About the WIN.INI File 

PIF Section 
Purpose 
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The PIF section lists the information that MS-Windows uses to 
swap programs to disk. MS-Windows uses the swap area to swap 
applications that cannot operate in a window. Two settings (SwapDisk 
and SwapSize) determine where MS-Windows swaps an application and 
the minimum swap space. 

The PIF section creates a program information entry for standard 
applications used in a window. MS-Windows uses the program 
information entry rather than a program information file (PIF). The 
preferred method is to create a PIF. For more information on PIPs, see 
Appendix B. 

NOTE 
To change the PIF section, use Notepad. 

Format 

[pif] 
swapdisk=setting 
swapsize=setting 
program=memory 

Where: 

Swap Disk= setting 

Is the disk to which MS-Windows swaps the application. The setting 
can be: 
? 

drv 

0 

NOTE 

Swaps to the first fixed disk on the system. This is the 
default. 

Swaps to that drive. Drv is any valid drive letter. 

Disables swapping. 

Do not set a diskette drive as the swap disk. 
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SwapSize =setting 

Is the amount of memory MS-Windows uses to swap an application. 
The setting can be: 
0 Is the amount of memory based on the size of the first 

application that MS-Windows swaps. You should start the 
largest application first. This is the default. 

size Is the reserved minimum amount of memory in Kbytes 
that MS-Windows uses to swap applications. When you 
determine the size, consider the application size, the space 
for screen exchange, the space for screen switching, and 
2K bytes of overhead for saving information about the 
application's current state. 

program= memory 

Is the application name for which you want to create a program 
information entry. Memory is the amount of memory in Kbytes 
required to start the application. See the application documentation 
to find the memory requirements for the application. 

When memory is 1, it indicates a special application. 

MS-Windows assumes the following default settings for a program 
information entry: 
Program Title File name without extension 

Initial Directory None 

Parameters None 

Memory Specified to the right of the equal sign 
Required 

Memory Desired Same as memory required 

Screen Exchange Text 

Program Switch Text 

Directly None 
ModHies 

Close Window No 
on Exit 
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PIF Section Example 

The following PIP section: 

• Sets the swap disk to the default. 

• Sets the swap size to the default. 

• Creates a program information entry for COMMAND.COM 
with a 32K byte memory requirement. 

Example 

[pif] 
swapdisk=? 
swapsize=O 
collUUand.com=32 
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Ports Section 
Purpose 

The Ports section lists the available communication ports for a 
workstation and defines the default modes or settings. The Ports 
section can include up to eight entries. 

NOTE 
To change the Ports section, use the Control Panel. 

Format 

(ports] 
port:=baudrate,parity,wordlength,stopbits 
filename.PRN= 

Where: 

port: 

Is the name of the available communication port. Port can be LPTl:, 
LPT2:, LPT3:, COMl:, or COM2:. 

If the port is COMl: or COM2:, you must specify in order the: 
baud rate 

parity 

word length 

stop bits 

retry 
(print/send) 

filename.PRN = 

Is the port's baud rate. 

Is the parity setting: o (odd), e (even), or n (none). 

Is the length of a word, in bits. 

Is the number of stop bits. 

Controls continuous retry on a timeout. This option is used 
if the port is used only for a serial printer. If you leave this 
option blank, the current setting does not change. 

The retry options are: 

p which enables continuous retry on a timeout 

- which disables continuous retry on a timeout 

Sends printer output to a file rather than to a printer device. 
MS-Windows prints the information in the file name you specify. You 
must include the .PRN file extension. MS-Windows overwrites the file 
with each print job. 
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Ports Section Example 

The following Ports section: 

• Defines the LPT1: communication port. 

• Defines the LPT2: communication port. 

• Defines the COM1: communication port with 9600 baud rate, 
no parity check, 8 bit word length, 1 stop bit, and enabled retry. 

• Defines the COM2: communication port with 2400 baud rate, 
no parity check, 8 bit word length, 1 stop bit, and disabled retry. 

• Defines OUTPUT.PRN as a file for printer output. 

Example 
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[ports] 
LPTl:= 
LPT2:= 
COM1:=9600,n,8,1,p 
COM2:=2400,n,8,1 
OUTPUT.PRN= 
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International Section 

Purpose 
The International section tells MS-Windows how to display dates, times, 
dollar amounts, and other items in countries other than the United 
States. 

NOTE 
To change the International section, use the Control Panel. 

Format 

[intl] 
dialog=setting 
itemname=setting 

Where: 

dialog= setting 

Allows changes to the International section through the Control Panel. 
The setting can be: 
Yes 

No 

itemname 

Enables the international dialog box. 

Disables the international dialog box. 

Is the item you want to set. The setting can be: 
iCountry 

iDate 

iCurrency 

Defines the country code. 

Defines the format for the date where: 

0 for month-day-year 

1 for day-month-year 

2 for year-month-day 

Defines the format for currency where: 

0 for currency symbol prefix, no separation 

1 for currency symbol suffix, no separation 

2 for currency symbol prefix, 1 character separation 

3 for currency symbol suffix, 1 character separation 
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iDigits 

iTime 

iLzero 

s1159 

s2359 

sCurrency 

sThousand 

sDecimal 

sDate 

sTime 

sUst 

Defines the number of significant decimal digits in the 
currency. 

Defines the format for the time where: 

0 for 12-hour clock 

1 for 24-hour clock 

Defines the use of leading zeros where: 

0 for no leading zeros 

1 for leading zeros 

Defines trailing string from 0:00 to 11:59. 

Defines trailing string from 12:00 to 23:59. 

Defines currency symbol. 

Defines thousands separator. 

Defines decimal separator. 

Defines date separator. 

Defines time separator. 

Defines list separator. 

International Section Example 

The following International section: 

• Allows changes to the International section through the Control 
Panel. 

• Defines the country as the U.S. 

• Defines a month-day-year date format. 

• Defines a 0 currency symbol prefix with no separation for the 
currency format. 

• Defines two significant decimal digits in the currency. 

• Defines a 12-hour clock. 

• Defines the use of no leading zeros. 

• Defines an AM to be attached to time from 0:00 to 11:59. 

• Defines a PM to be attached to time from 12:00 to 23:59. 
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• Defines $ as the currency symbol. 

• Defines I as thousand separator. 

• Defines . as decimal separator. 

• Defines I as date separator. 

• Defines : as time separator. 

• Defines I as list separator. 

Example 

[intl] 
dialog=yes 
iCountry=l 
iDate=O 
iCurrency=O 
iDigits=2 
iTime=O 
iLzero=O 
sll59=AM 
s2359=PM 
scurrency=$ 
sThousand=, 
soecimal=. 
sDate=/ 
sTime=: 
sList=, 
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DECLAT Section 
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Purpose 

The DECLAT section redirects the communication ports to a network 
terminal service. 

NOTE 
To change the DECLAT section, use the Control Panel. 

Format 

[DECLAT] 
port=service 

Where: 
port Is the communication port that you want to redirect. Port 

can be COMl: or COM2:. Service is the network terminal 
service to which you want to connect. You do not have to 
specify a particular network terminal service. 

DECLAT Section Example 

The following DECLAT section: 

• Defines the COMl: communication port. It is not redirected to 
any network terminal service. 

• Defines the RANGER network terminal service to the COM2: 
communication port. 

Example 

[DECLAT] 
COM!:= 
COM2:=RANGER 
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DECKeybd Section 

Purpose 

The DECKeybd section specifies the keyboard settings. 

NOTE 
To change the DECKeybd section, use the Control Panel. 

Format 

[DECKeybd] 
keyclick=setting 
repeat=setting 
lock=setting 

Where: 

keyclick =setting 

Specifies the volume of sound generated by the keyboard. The setting 
can be from 0 to 3 where 0 is no volume and 3 is maximum volume. 
The default is 2. 

repeat= setting 

Specifies whether the repeat key feature is· used. The setting can be: 
0 Turns off the repeat key feature. 

1 Turns on the repeat key feature. 

lock= setting 

Specifies the caps lock or shift lock feature of the keyboard. The setting 
can be: 
0 Sets the caps lock feature, which capitalizes the letters on 

the keyboard when you press the Lock key. 

1 Sets the shift lock feature, which acts as if the Shift key is 
always pressed. 
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DECKeybd Section Example 

The following DECKeybd section: 

• Sets the key click to medium volume. 

• Turns on the repeat key feature. 

• Sets the caps lock feature. 

Example 

[DECKeybd] 
keyclick=2 
repeat=! 
lock=O 
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DECinfo Section 
Purpose 

The DECinfo section specifies toMS-Windows the location of the 
on-line Information System files. You should not need to change any of 
these settings. 

NOTE 
To change the DECinfo section, use the Notepad application. 

Format 

[DECinfo] 
DBpath=pathname 
DBname=database 
BMpath=pathname 

Where: 
DB path Specifies the location of the on-line Information System 

database files by the specified path name. 

DB name Specifies the name of the on-line Information System 
database. 

BMpath Specifies the location of user specific information regarding 
the on-line Information System by the specified path name. 
For example, the Bookmark file contains information 
specific to you. 

DECinfo Section Example 

The following DECinfo section: 

• Defines the location of the on-line Information System data files 
as drive H in the DECAPP subdirectory. 

• Defines the name of database as INFOUSER. 

• Defines the location of your specific information regarding the 
on-line Information System as drive I. 

Example 

[DECinfo] 
DBpath=H:\DECAPP 
DBname=INFOUSER 
BMpath=I: \ 

A-23 



Information About the WIN.INI File 

Devices Section 
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Purpose 

The Devices section identifies a workstation's output devices, the printer 
files, and the port connections. 

NOTE 
To change the Devices section, use the Control Panel. 

Format 

[devices] 
device=driver,port[,port] 

Where: 
device 

driver 

port 

Devices Section Example 

Is the name of the output device where: 

Is the file name of the device's printer 
driver. 

Is the name of the communication port or 
print file to which the device is connected 
(optional). Port can be LPTl, LPT2, LPT3, 
COMl, or COM2. If a device is not 
currently connected, the port should be the 
port specified in the NuliPort setting of the 
Windows section. 

• Defines the DIGITAL LN03 printer as connected to the null port 
and to the LPT3: communication port. 

• Defines the DIGITAL LA75 printer as connected to the LPTl: 
communication port. 

• Defines the IBM Graphics printer as the null port. 

Example 

[devices] 
Digital LN03=LN03,None,LPT3: 
Digital LA75=LA75,LPT1: 
IBM Graphics=IBMGRX,None 
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Fonts Section 

Purpose 

The Fonts section identifies one or more font types that MS-Windows 
applications can use for display. 

NOTE 
To change the Fonts section, use the Control Panel. 

Format 

(fonts) 
fontname=fontfile 

Where: 
fontname Is the descriptive name of a font. The fontfile is the name 

of the file containing the font resources. Do not use the file 
extension. 

Fonts Section Example 

The following Fonts section: 

• Defines the Courier font. 

• Defines the Helvetica font. 

Example 

[fonts) 
Courier 8,10,12 (Set #3)=COURC 
Helv 8,10,12(Set#3)=HELVC 
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Appendix B 
Program Information Files 

This appendix describes how to: 

• Use Program Information Files (PIFs) 

• Use the PIF editor 

• Select PIF options 

• Use default settings 

• Decide what to put in a PIF 

• Change PIFs 

• Give applications more memory 

Using Program Information Files 
A program information file (PIF) is a file that contains information about 
a standard application. It has the file extension .PIF. When you run 
a standard application, MS-Windows looks for a PIF to configure the 
application. 

PIFs for most popular standard applications are included with your 
MS-Windows software package. During setup, the Installation Aide 
installs PIFs in the PIF subdirectory to establish a PIF library. You 
probably will not enter information into a PIF unless you use a standard 
application that does not have a PIF. 
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NOTE 
If you try to run a standard application that does not have 
a PIF, MS-Windows automatically uses a set of default 
application characteristics. MS-Windows displays a dialog 
box asking if it should "Continue with default settings." 
You should create a PIF, using the correct values from your 
application documentation. 

If you run an application by selecting the file name of the application 
(files that have the file extension .EXE, .COM, or .BAT), the PIF must 
have the same file name and the file extension .PIF. For example, if you 
use dBASE II, its application file name is DBASE.EXE, and its PIF must 
be DBASE.PIF. 

You can also run an application by selecting its PIF in the MS-DOS 
Executive window. This automatically loads and runs the application 
named in the PIF. In this case, the PIF does not have to have the same 
file name as the application. 

The preferred method is to run a standard application by selecting its 
PIF. This allows you to have customized PIFs, which are several PIFs 
containing different settings for the same application. Therefore, you 
can customize an application to the needs of different users, each with 
their own specific MS-Windows environment. 

For example, one version, APPLARGE.PIF, may need a large amount 
of memory for those that use all of its features, and a second version, 
APPSMALL.PIF, may need less memory for those who use only a few 
of its features. 

Additionally, each user can have customized values for the Program 
Parameters or Initial Directory fields in their PIFs. Customized PIFs 
must be in the user's personal directory. 

The PIF must be in your directory or in your path. It should be copied 
from the PIF subdirectory to the directory from which you run the 
application. 

In some cases, different applications use the same file name to start up. 
Therefore, some PIFs can have names that differ from their applications. 
If you are not sure which application a PIF works with, run the PIF 
editor and open the PIF to see which application the PIF was designed 
for, then copy the PIF to the appropriate drive and directory, and 
rename the file. 

Some applications can have more than one .EXE, .COM, or .BAT file 
on their disk. You need a separate PIF for each file. 
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Using the PIF Editor 
To create or edit a PIF, use the PIF editor. For example, you can change 
the application settings to increase the amount of memory available to 
the application or to set its initial directory. 

To get on-line help about using the PIF editor: 

1. Select the About command from the System menu. 

A dialog box is displayed that lists topics about PIFs. 

2. Select a topic from the list box. 

3. Select the Help command button. 

Information about the selected topic is displayed in the dialog 
box. You may need to scroll to see all the information. 

By using the command buttons in the dialog box, you can obtain 
information about other PIF topics. 

When you finish using the PIF help feature, select the Cancel command 
button. 

~ Creating a PIF 
To create a new PIF: 

1. Use the Run command in the MS-DOS Executive window to 
start the PIF editor application. The file name of the PIF editor 
is PIFEDIT .EXE. 

The Program Information Editor window is displayed. 
Figure B-1 shows the Program Information Editor window. 
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Figure B-1: Program Information Editor Window 
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2. Type the file name of the application to be associated with the 
PIP in the Program Name text box. Include the file extension 
(.EXE, .COM, or .BAT). 

3. Select the options or values that apply to the application. (For 
more information, see the section "Selecting PIP Options" in 
this appendix.) 

4. Select the Save command from the File Menu to save the new 
PIP. 

To create another PIP, select the New command from the File Menu to 
reset the PIP editor screen. 
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Editing PIFs 

To edit an existing PIF: 

1. Use the Run command in the MS-DOS Executive window 
to start the PIF editor. The file name of the PIF editor is 
PIFEDIT .EXE. 

2. Select the Open command from the File Menu. 

3. Select the PIF you want to change from the list box or type the 
name of the PIF in the text box. 

4. Select the Open button. 

5. Make the desired changes by selecting the PIF options you want. 

6. Select the Save command from the File Menu to save the 
changes. 

Selecting PIF Options 
PIF options are organized into these categories: 

• Program Name 

• Program Title 

• Program Parameters 

• Initial Directory 

• Memory Requirements 

• Directly Modifies 

• Program Switch 

• Screen Exchange 

• Close Window on exit 

Program Name 

Every application (program) must have a file name assigned. 

Type the path and file name of the application, including the file 
extension .EXE, .BAT, or .COM. For example, DBASE.COM is a file 
for the application DBASE. What you enter is displayed in the MS-DOS 
Executive window directory. 
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Program Title 

You can enter a descriptive title for the application to help the user 
identify it on the screen. 

What you enter is displayed in the title bar of the window, if the 
application runs in a window. This same title is also displayed above 
the icon of the application when you highlight the icon in the icon area. 

NOTE 
The PIF editor lets you enter 37 characters in the text box; 
however, it displays only 29 characters in the title box. 

Program Parameters 

The Program Parameters option lets you pass information to an 
application when you start the application. In the Program Parameters 
test box, you can type either of the following: 

• Question mark (?) 

If you type a question mark, MS-Windows displays a dialog box 
when you start the application. The dialog box prompts you for 
application parameters. You can enter up to 126 characters in 
the dialog box, and PIFEDIT accepts up to 126 characters. Any 
extra characters are ignored. 

• Specific program parameters 

If you type specific parameters, those application parameter 
values are used every time the application is started. You can 
enter up to 37 characters in the Program Parameters text box. 

You should not redirect input and output or use piping. For more 
information on piping, see the MS-DOS Reference Guide or the DOS 
reference manual that comes with your DOS software. 

If your application requires no parameters, or if you are uncertain, leave 
this option blank. 
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Initial Directory 

If you have several directories, this option changes to a specific 
directory when the application starts. 

Type the drive and directory you want MS-Windows to change to when 
you start the application. This directory is usually the location of the 
application's data files. 

You can use the Initial Directory field and the Program Name field to 
make a customized PIF for applications shared on a file server. In the 
Program Name field, enter the drive and directory of the application. 
In the Initial Directory field, enter the drive and name of your personal 
directory. (Complete the other PIF fields as needed.) Make sure this 
customized PIF is in your personal directory. 

When you select the customized PIF to run an application, MS-Windows 
copies the application from its drive and directory and starts it in your 
personal directory where the data files are. The application can then 
use the data files. When you close the application, the updated data 
files remain in your personal directory. 

If the data files are in the same directory as the application, leave this 
option blank. In this case, MS-Windows does not change the directory 
when you start the application. 

Memory Requirements 

Two fields for Memory Requirements allocate memory for your 
applications: 

• KB Required 

Type the minimum amount of memory required (in kilobytes) 
by your application. 

Memory requirements for your application should be in the 
application documentation. 

If you do not know how much memory is required, use the 
default setting of 52K bytes. 

If MS-Windows cannot provide the specified amount of 
memory, and if no application is running other than the 
MS-DOS Executive application, MS-Windows reduces its space 
requirements so that the application has room to operate. In 
this case, you cannot switch back toMS-Windows with the 
Alt/Tab keys; you must use the application's Exit command, or 
its equivalent, to return toMS-Windows. 
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• KB Desired 

Type the maximum amount of memory your application can 
use. Some applications run better if you assign more memory. 

The value entered in this field should at least equal the value 
entered in the KB Required field. If the application allocates 
memory, you should increase the value in the KB Desired field, 
and you may also need to increase the value in the KB Required 
field. 

If you enter zero (0), MS-Windows allocates all available 
MS-Windows memory to the application. 

If you leave this field blank, MS-Windows uses the default 
setting of 52K bytes. 

CAUTION 
Do not run the CHKDSK (Check Disk) utility program 
from MS-Windows; it can provide invalid messages 
about memory availability. If you select the IF 
qualifier of CHKDSK, you can destroy all data stored 
on your virtual disk. 

Directly Modifies 

Some applications use workstation resources such that applications 
cannot share them. Select any options that apply to your application: 

• Screen 

Select this box if the application writes directly to the screen 
(video buffer) or if the application has a .BAT extension and 
uses redirected 1/0. All standard applications that display 
graphics write directly to the screen. 

Selecting this option gives the application exclusive access to 
the full screen, rather than running it in a window. If you are 
uncertain, select this option. 

• Keyboard 

Select this box if the application accesses the keyboard buffer. 
This buffer saves keystrokes until they can be processed. 
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Selecting this option prevents the application from running in a 
window (the application has exclusive access to the full screen) 
and prevents returning toMS-Windows with Alt/Tab. If you are 
uncertain, do not select this option. 

• COMl 

Select this box if your application accesses serial 
communications port 1 (COMl). If you select this option, 
MS-Windows reserves COMl for the application. When the 
application is running, MS-Windows cannot run any other 
application using COMl until you stop running the first 
application. Generally, you select this option only if you are 
running a communications application. 

Selecting this option prevents two applications from trying 
to access the same communications port at the same time. 
Because only one application with the COMl option selected 
can be running at a time, only one application attempts to access 
COMl. 

Selecting this option also prevents the application from being 
swapped to a disk. This type of application must remain in 
memory at all times. 

• COM2 

Select this box if your application accesses serial 
communications port 2 (COM2). If you select this option, 
MS-Windows reserves COM2 for the application. When the 
application is running, MS-Windows cannot run any other 
application using COM2 until you stop running the first 
application. Generally, you select this option only if you are 
running a communications application. 

Selecting this option prevents two applications from trying to 
access the same communications port at the same time. Since 
only one application with the COM2 option selected can be 
running at a time, only one application attempts to access 
COM2. 

Selecting this option also prevents the application from being 
swapped to a disk. This type of application can remain in 
memory at all times. 
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• Memory 

Select this box only if your application loads and remains 
resident (using a Terminate and Stay Resident system call). 
Many pop-up applications do this. These applications generally 
load and remain in memory, and are activated while other 
applications are running. Generally, this type of application 
must be loaded before MS-Windows. In this case, you do not 
need a PIF for the application. If you are uncertain, do not 
select this option. 

Program Switch 

If your application uses the entire screen, these options determine 
whether you can switch back toMS-Windows with Alt/Tab. If you are 
uncertain which option to select, select Text. 

• Prevent 

Select this option to conserve memory for the application, or if 
you find that the application does not switch toMS-Windows 
correctly. Selecting this option means you can stop running 
the application only by executing its Exit command, or the 
equivalent command, to return toMS-Windows. You cannot use 
the Alt/Tab procedure to return toMS-Windows. 

• Text 

Select this option if your application works in text mode only, or 
if it runs in text and graphics modes, and you want to conserve 
memory. When you select this option, MS-Windows reserves 
4K bytes to save the screen. 

If you select this option, you can switch back to MS-Windows 
only when your application is in text mode. If the application 
is in graphics mode, MS-Windows beeps when you press 
the Alt/Tab keys, to let you know it is not a valid action; you 
must use the Exit command of the application to return to 
MS-Windows. 
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• Graphics/Multiple Text 

Select this option if your application works in graphics mode. 
If you select this option, MS-Windows allocates extra memory 
(64K bytes) for you to switch back toMS-Windows when the 
application is in text or graphics mode. 

Due to extensive memory requirements, program switching is 
not supported for applications using IBM EGA high-resolution 
color modes. 

Screen Exchange 

These options let you specify the kind of data exchange between 
applications that require exclusive access to the screen. 

You press Alt/Prt Sc to copy information into the Clipboard. This 
requires MS-Windows to allocate memory to save the screen image in 
the Clipboard. Text screens generally do not require much memory 
(2K bytes). However, graphics screens can require up to 64K bytes of 
memory. You should select options with this in mind. 

If you are uncertain which option to select, select Text. 

• None 

Select this option to prevent screen exchange and conserve 
memory. 

• Text 

Select this option to allocate memory to copy text screens. If 
your application runs in a window, you can select this option. 

• Graphics/Text 

Select this option to allocate memory to copy text and graphics 
screens. 

Close Window On Exit 

Select this option to close the standard application window when you 
use the application's Exit command, or its equivalent. 

When you exit from some standard applications, they display 
information in the window for you to look at or copy. Do not select this 
option, because the window closes automatically, and the information is 
not displayed on the screen long enough for you to read it. 
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Using Default Settings 
If you run an application, and MS-Windows cannot find a PIF, 
MS-Windows uses the following settings: 

• Program Title: The application file name is displayed in the title 
bar. 

• Initial Directory: You stay in your current directory. 

• Memory Required: 52K bytes 

• Memory Desired: All available memory 

• Directly Modifies: Screen 

• Program Switch: Prevent 

• Screen Exchange: Text 

Deciding What to Put in a PIF 
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How an application is displayed on the screen depends on: 

• How the application uses workstation resources and hardware 

• How the application is configured 

• The amount of memory reserved for the application 

If MS-Windows cannot run a standard application in a window, it runs 
the application outside a window, and the application uses the entire 
screen. 

Use the following guidelines to help determine whether your standard 
application can run in a window: 

• Does the application write directly to the screen (video buffer)? 

Many standard applications write directly to the screen 
instead of using DOS or other system conventions to display 
information (such as ANSI calls). These applications cannot 
run in a window. You must select the Directly Modifies screen 
option if your application writes to the screen. 

• Does the application display graphics? 

Standard applications that display bit-mapped graphics (not 
character-based) write directly to the screen and cannot run in a 
window. 
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Does the application provide an installation option for running 
under different screen conventions? 

Standard applications that support ANSI screen drivers can run 
in a window. 

• How much memory does the application require? 

If the memory requirements of the standard application and 
MS-Windows together exceed the amount of available memory, 
the application cannot run in a window. MS-Windows "steps 
aside" and gives the application the maximum amount of 
memory available. 

• Does the application use the alarm? 

Applications that use the alarm function of the real-time clock 
must run outside MS-Windows. At the minimum, you should 
select the Directly Modifies keyboard option. 

For standard applications that run in a window, MS-Windows 
does not support the following ANSI escape sequences: 

Cursor Position Report 

Set Mode 

Keyboard Reassignment 

Set Graphics Renditions subsets: 

Faint on 
Italic on 
Rapid blink on 
Subscript 
Superscript 

Select the Directly Modifies screen option in the PIF for any 
application that uses these. 

To experiment, run the application without setting the Directly Modifies 
screen option. If the application writes information outside its window, 
or you see unexpected results on the screen, edit the PIF and select the 
Directly Modifies screen option. 
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Changing PIFs 
Generally, you do not have to change the information in the PIFs. 
However, to change any parameters for a particular application by 
editing a PIF, you can tailor the performance characteristics of its 
application. 

For example, to give Lotus 1-2-3 the maximum amount of available 
memory in your workstation, change the amount in the KB Required 
and KB Desired options to 640K bytes and select None for the Screen 
Exchange option and Prevent for the Program Switch option. Close 
all other applications except for the MS-DOS Executive, then run the 
application. 

Some applications provide an option to install and run the application 
with an ANSI device driver (ANSI.SYS). If the application offers this 
option, you can usually run it in a window. 

Since the application can now run in a window, you must alter the PIF. 
You should cancel the Directly Modifies Screen option. (Do this for all 
related .COM or .EXE files included in the application.) 

If you run an application, and it does not load properly or is not 
operating as expected, check your PIF settings. You may need to 
increase the memory requirements of the application. 

Giving Applications More Memory 
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When you run a standard application, MS-Windows allocates memory 
based on the settings in the PIF of the application. MS-Windows 
allocates memory for screen exchange (copying the screen) and for 
program switching (switching between the application and 
MS-Windows). 

You can reduce the memory requirements for an application by 
selecting options that require less memory: 

• The Screen Exchange Text option 

• The Screen Exchange None and the Program Switch Prevent 
options. 
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To give an application the maximum amount of memory: 

• Change the amount in the KB Required and the KB Desired 
boxes in the PIF to 640K bytes. MS-Windows steps aside to free 
up all available memory for the application. 

• Select the Prevent option for Program Switch. 

• Select the None option for Screen Exchange. 

• Save the modified PIF. 

• Close all other applications except the MS-DOS Executive. 

• Run the application. 
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Appendix C 
The MS-Windows Setup Utility 

This appendix discusses: 

• Nonstandard hardware options 

• MS-Windows Setup utility 

Nonstandard Hardware Options 
The workstation software installed on a server allows you to use 
MS-Windows with the VAXmate workstation hardware by default. The 
standard workstation hardware for a VAXmate includes: 

• DIGITAL graphics display 

• DIGITAL mouse 

• DIGITAL United States keyboard 

To use MS-Windows with nonstandard hardware options, (for example, 
a French keyboard or a Logitech mouse; a PC workstation with a 
VAXmate keyboard), you must create a version of MS-Windows for 
each nonstandard hardware configuration. 
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The MS-Windows Setup Utility 
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The MS-Windows Setup utility creates a version of MS-Windows for the 
hardware configuration that you specify. You select a specific hardware 
option for: 

• A country keyboard 

• A pointing device 

• A graphic display adapter 

NOTE 
You must use the Setup utility and create the new version 
of MS-Windows before you configure the nonstandard 
workstation. 

To use the Setup utility: 

1. From your workstation insert the system administrator's key 
diskette into drive A and turn on (or reset) the workstation. 

2. Be sure MS-Windows is running and the MS-DOS Executive 
window is displayed. 

3. Change to the \WIN\DRV directory on the system source drive 
(driveL by default). Be sure the system source drive contains 
the correct software for the workstation you are configuring. 
For example, to configure a PC workstation when your default 
system source drive contains VAXmate workstation software, 
connect another drive to the PC workstation software and 
change to the \WIN\DRV directory on this drive. 
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4. Double-dick on the "SETUP.EXE" in the directory list. 

MS-Windows displays the Setup utility main screen. Press C to 
continue. 

NOTE 
To wn the Setup utility from the MS-DOS operating 
system, change to the I WIN\DRV directory and type: 

SETUP !Relllrnl 

5. Specify a directory to contain the nonstandard version of 
MS-Windows for the specified hardware configuration. The 
directory must be a subdirectory of the \WIN directory. The 
directory name should reflect the hardware configuration to be 
used with the new version of MS-Windows. If the directory you 
specify does not exist, the Setup utility creates it. 

NOTE 
Copy all files in the .DRV directories to the directory 
you create; otherwise, the Setup utility may not allow 
you to continue. 

It is recommended that you name the directory in the form 
kkmmdd. 

Where: 
kk 

mm 

dd 

Is an abbreviation for the DIGITAL keyboard. Table C-1 
lists the abbreviations and the keyboard for both the 
VAXmate workstations and the PC workstations. 

Is an abbreviation for the pointing device. 
Table C-2 lists the abbreviations, the device names, and 
the workstation for which the device is available. 

Is the .abbreviation for the graphics display adapter. 
Table C-3 lists the abbreviations, the adapter names, 
and the workstation for which the adapter is available. 
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Table C-1: Industry Standard Keyboards 

Abbrev. Keyboard 

us United States 

UK United Kingdom 

FR French 

DE German 

IT Italian 

ES Spanish 

SF Swiss French 

so Swiss German 

CA Canadian 

OK Danish 

FI Finnish 

NO Norwegian 

SE Swedish 

AT AT & T 6300 or 6300 PLUS 

BE Belgian 

LA Latin American 

PO Portuguese 
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Table C-2: Pointing Devices 

Abbrev. 

DM 

MS 

LT 

NO 

Ml 

M2 

JM 

FD 

LP 

AM 

Device Name 

DIGITAL mouse 

Microsoft mouse 

Logitech mouse 

No mouse 

Mouse systems or VisiOn mouse (COMl:) 

Mouse systems or VisiOn mouse (COM2:) 

Kraft Joystick mouse 

FTG Data Systems Ught Pen and Single Pixel Board 

Ute-Pen Company Ught Pen 

AT & T Mouse 6300 

Table C-3: Graphics Display Adapters 

Abbrev. 

OM 

CG 

HE 

EM 

EW 

EC 

EX 

AT 

AP 

Graphics Adapter 

DIGITAL Graphics Driver 

IBM Color Graphics Adapter 

Hercules Card with monochrome display 

EGA with Monochrome Personal Computer Display 

EGA with Enhanced Color Display (B&W only) 

EGA with Enhanced Color Display or IBM Color Display 

EGA (more than 64K) with Enhanced Color Display 

AT & T Display Enhancement Board 

AT & T PC 6300 or PC 6300 PLUS Display Adapter 

Type the name of the directory and press the Return key. 
For example, if a PC workstation has an IBM Color Graphics 
Adapter, a Logitech mouse, and a DIGITAL United States 
keyboard, create a directory called CGLTUS. 
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6. The Setup utility displays a menu for each of the three types of 
hardware options. Select the hardware option from the menu 
and press the Return key. 

NOTE 
For PC workstations that are not V AXmates, you are 
asked whether you have a DIGITAL keyboard before 
the keyboard menu is displayed. 

If the workstation has the standard option for one of the three 
types of hardware, press the Return key to select the standard 
option, which is the default. 

The Setup utility builds MS-Windows with the hardware device 
drivers and copies it to the directory you specified. 

7. The Setup utility asks which video mode it should set for 
the screen; normal video, which is dark characters on a light 
background, or reverse video, which is light characters on a 
dark background. 

When the Setup utility is complete, it tells you that MS-Windows 
is setup for the workstation. 

When you configure the workstation, you must specify to the 
Configuration Aide the directory you created fore the 
''MS-Windows Directory.'' 



Appendix D 
Using a Keyboard with the VT220 Emulator 

This appendix covers in table format the keys that can be used with the 
VT220 emulator. It is assumed that you know: 

• How to use MS-Windows keyboard techniques 

• The purpose of the actions you want to take as explained in the 
VT220 emulator chapters 

Table D-1 lists the keys used with the VT220 emulator and their 
functions. 

NOTE 
To access and use the arrow keys with the VT220 emulator 
you must press the Alt/spacebar keys. The first time you press 
this key combination, you get the Set-up System menu. To 
access the arrow keys, type this key combination a second 
time. 
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Table D-1: Keys and Their VT220 Emulator Functions 

Key VT220 Emulator Function Key 

Alt/right arrow When used after pressing Alt/spacebar, it moves the 
Alt/left arrow highlight right or left to the next Set-Up settings. 

Alt/spacebar The first time you use this key combination, you get the 
Set-Up System menu. To access the arrow keys, type the 
key combination a second time. 

Alt/up arrow Moves the highlight up or down within a Set-Up drop-down 
Alt/down arrow menu. 

Next Used in Set-Up to display the next Set-Up screen from the 
menu at the top of the screen. 

Prev Used in Set-Up to display the previous Set-Up screen from 
the menu at the top of the screen. 

Right arrow Moves the cursor right or left in the tab column display. 
Left arrow 

F3 (Set-Up) Enters or exits Set-Up. 

Enter Sets or resets a tab stop in Set-Up. 



Appendix E 
Non-Displayable Characters 

This appendix lists the non-displayable characters for scripting. 

Nonprintable characters are represented as: 

Carriage Return < CR > 1 <RET> 1 or <RETURN> 

Escape 

Form Feed 

Une Feed 

Tab 

Delete 

<ESC> 

<FF> 

<LF> 

<TAB> 

<DEL> 
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Control characters are represented as follows: 

Control A 

Control B 

Control Z 

<CTRLIA> 

<CTRLIB> 

<CTRLIZ> 

Function keys are represented as: 

F6 

F7 

F20 

<F6> 

<F7> 

<F20> 

PFl through PF4 are represented as: 

PFl 

PF2 

PF3 

PF4 

<PFl> 

<PF2> 

<PF3> 

<PF4> 

Any number within angle brackets, ( < > ), converts to its DEC MCS 
equivalent. For example, < 103 > converts to a lowercase g. Numbers 
between 0 and 255 are valid. 



Appendix F 
Special Key Actions forMS-Paint 

This appendix describes how to use the Ctrl and Shift keys with the 
mouse to enhance or restrict some of MS-Paint's functions. 

Using The Ctrl Key: Copying A Selection 

To copy a selection with the Ctrl key: 

1. Hold down the Ctrl key. 

2. Drag the selection. 

MS-Paint creates a copy of the selection; the original remains in place. 

Using The Shift Key: Creating Multiple Copies 

To make multiple copies with the Shift key: 

1. Hold down the Shift key. 

2. Drag a selection. 

MS-Paint makes copies of the selection where the mouse cursor 
was dragged. 
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Using The Shift Key: Scrolling A Zoomed-In Canvas 

To scroll a zoomed-in canvas with the Shift key: 

1. Hold down the Shift key in the zoomed-in drawing window. 

2. Drag. 

MS-Paint scrolls the canvas. 



Appendix G 
Using MS-Paint with the Keyboard 

This appendix describes how you can use the keyboard to: 

• Select tools and shapes 

• Draw lines and shapes 

• Draw curves 

• Draw polygons 

• Use the fill tool 

• Make selections 

• Move selection 

• Copy and move selections 

• Make multiple copies of a selection 

• Scroll 

• Zoom in, zoom out, and erase by using the Return key 

You must select the proper tool before performing the sequence. 

Selecting Tools and Shapes 

To select from the tools and shapes palette, press Tab/Shift/Tab. 

To move the highlight and select a tool or shape, you can also hold 
down the Shift/Ctrl keys and press an arrow key. 
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Drawing Lines and Shapes 

To draw with the Pencil, Line, Freehand Polygon, Brush, Air Brush, 3-D, 
and Shapes tools: 

1. Hold down the spacebar. 

2. Press an arrow key in the direction you want to draw. 

3. Release the spacebar to finish drawing. 

Drawing Curves 

To draw a curve: 

1. Hold down the spacebar. 

2. Press an arrow key in the direction you want to draw. 

3. Move the cursor to one side of the line, and press the spacebar 
to mark the peak of the curve. 

4. Release the spacebar to draw the curve. 

Drawing Polygons 

To draw a polygon: 

1. Mark each corner with the spacebar and the arrow keys. 

MS-Paint draws the lines, connecting each corner. 

2. Press the Return key at the final corner to close the polygon. 

Using the Fill Tool 

To fill a shape: 

1. Press an arrow key to move the cursor over the shape. 

2. Press the spacebar. 

The interior is filled. 
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Making a Selection 

To select an area of the canvas: 

1. Hold down the spacebar. 

2. Press the arrow keys to indicate the area to be selected. 

3. Release the spacebar. 

Moving a Selection 

To move a selection: 

1. Press an arrow key to move the cursor into the Selection 
Rectangle or netted area. 

2. Hold down the spacebar. 

3. Press an arrow key until the selection is moved where you want 
it. 

Copying and Moving a Selection 

To move a copy of a selection: 

1. Hold down Ctrl/spacebar. 

2. Press an arrow key. 

Making Multiple Copies 

To make multiple copies of a selection: 

1. Hold down Shift/spacebar. 

2. Press an arrow key to move the selection. 

Multiple copies are made where the arrow key moves. 

Scrolling 

To scroll the screen: 

1. Hold down the spacebar. 

2. Press an arrow key. 
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To scroll a zoomed-out canvas: 

1. Hold down the spacebar. 

2. Press an arrow key to move the outline of the drawing window. 

When you return to the regular drawing window, the outlined 
selection of canvas is displayed. 

To scroll the canvas under a zoomed-in drawing window: 

1. Hold down Shift/spacebar. 

The Scroll cursor replaces the Pencil cursor during the scrolling 
action. 

2. To scroll the canvas, move the Scroll cursor by pressing the 
arrow keys. 

Using the Return Key 

You can use the Return key to zoom in, zoom out, and erase. 

Zooming In To zoom in: 

1. Select the Pencil tool. 

2. Press the spacebar to mark the target area for editing. 

3. Press the Return key to zoom in for editing. 

4. Press the Return key again to return to the regular drawing 
window. 

Zooming Out To zoom out: 

1. Follow the procedures for scrolling and press the Return key. 

2. Press the Return key again to return to the regular drawing 
window. 

Erasing To erase the entire drawing window: 

1. Select the Eraser tool. 

2. Press the Return key. 



A 
About command, 1-7, 3-4, 14-11, 

15-15, B-3 
Active window, 2-6 
Add command, 15-5 
Add dialog box, 15-5 
Adding 

cards in Cardfile, 15-5 
fonts, 8-12 
information from other 

applications in Cardfile, 
15-13 

notes in Calendar, 16-14 
patterns, 23-3 
printers, 8-6, 8-7, 8-9 
text, 23-3 

Add New Font command, 8-6, 8-12 
Add New Printer command, 8-6, 

8-7 
Airbrush, 23-2 
Alarm, 16-6 

early ring, 16-7 
in Calendar, 16-6 
removing, 16-8 
setting the sound, 16-7 
turning off, 16-7 

Alarm menu, 16-7 
Align Center command, 24-6 
Align command, 24-6 
Align Right command, 24-6 
All command, 3-7 

Index 

Alt/Prt Sc keys, 7-7, 7-10 
Alt/Return keys, 6-16 
Alt/spacebar keys, 6-2, 6-4, 6-5 
Alt/Tab/Shift keys, 6-2 
Alt/Tab keys, 6-2, 6-7, 6-9, 7-6 
Alt key, 6-2, 6-3 
Applications 

closing, 1-15 
keyboard procedure, 6-9 

finishing 
keyboard procedure, 6-8 

flashing title bar, 6-16 
loading 

keyboard procedure, 6-6 
menus, 1-8 
messages, 2-16, 6-16 
more memory, B-14 
multiple, 2-2 
PIF, B-2 
running, 1-4 

keyboard procedure, 6-7, 6-8 
three, 2-5 
two, 2-4 

running standard, 7-3 
shrinking, 1-15 
shrinking standard, 7-3 
spedal, 7-11 
standard, 7-1 

closing, 7-4 
closing windows, 7-4 
finishing MS-Windows, 7-5 
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Applications 
standard (cont'd.) 

multiple, 7-6 
outside windows, 7-6 
running large, 7-10 

transferring information, 7-7 
keyboard procedure;, 7-7 

Arrow/Shift keys, 6-3 
Arrow keys, 6-2, 6-4, 6-6, 6-8, 

6-10, 6-13 
ASCII, 2-16, 7-9, A-3 
Autodial command, 15-21 
Autodial dialog box, 15-21 
Automatic dialing 

in Cardfile, 15-20 
Autotyping characters 

VT220 emulator 

B 

enabling HOSTSYNC, 12-4 
to the host, 12-4, 12-5 

Box, 23-1 
Brush, 22-4 
By Date command, 3-7 
By IGnd command, 3-7 
By Name command, 3-7 
By Size command, 3-7 

c 
Calculator 

introducing, 17-1 
memory, 17-3 
starting, 17-1 
using, 17-2 
window, 17-2 

Calculator commands 
Copy, 17-4 
Paste, 17-4 

Calendar 
adding notes, 16-14 
alarm, 16-6 

early ring, 16-7 
removing, 16-8 
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Calendar 
alarm (cont'd.) 

setting the sound, 16-7 
turning off, 16-7 

changing day settings, 16-12 
copying text, 16-5 
customizing, 16-12 
deleting files, 16-20 
deleting text, 16-6 
editing in Day View, 16-3 
editing text, 16-5 
entering an appointment, 16-4 
introducing, 16-1 
marking dates, 16-14 
opening files, 16-15 
printing files, 16-19 
removing days, 16-19 
saving changes, 16-18 
saving files, 16-17 
selecting text, 16-5 
selecting times, 16-4 
special times, 16-13 
starting, 16-2 
unmarking dates, 16-14 
viewing appointments, 16-8 
viewing dates, 16-9, 16-11 
viewing different times, 16-8 
viewing files, 16-17 
window, 16-3, 16-15 

Calendar commands 
Controls, 16-7 
Copy, 16-5 
Cut, 16-6 
Date, 16-11 
Day, 16-3 
Day Settings, 16-12 
Delete, 16-20 
Mark, 16-14 
Month, 16-10 
New, 16-15 
Open, 16-15, 16-17 
Paste, 16-6 
Print, 16-19 
Remove, 16-19 



Calendar commands (cont'd.) 
Save, 16-18 
Save As, 16-17 
Set, 16-8 
Special Time, 16-13 
Unmark, 16-14 

CaJendar files, 16-15 
deleting, H~-20 
opening, 16-15 
saving, 16-17 
saving changes, 16-18 
viewing, 16-17 

Canceling 
commands 

keyboard procedure, 6-6 
files 

keyboard procedure, 6-13 
Canceling edits 

in Cardfile, 15-10 
in Notepad, 14-7 

Canvas 
definition, 20-2 
saving, 22-5 
scrolling, 23-9 

Cardfile 
adding cards, 15-5 
adding information from other 

applications, 15-13 
automatic dialing, 15-20 
canceling edits, 15-10 
changing index line, 15-8 
copying cards, 15-14 
copying text, 15-11 
creating, 15-3 
deleting cards, 15-14 
deleting files, 15-19 
deleting text, 15-10 
editing text, 15-9 
finding text, 15-12 
formatting text, 15-5 
index line, 15-4 
insertion point, 15-9 
introducing, 15-1 
merging files, 15-19 

Cardfile (cont'd.) 
moving cards, 15-7 
moving text, 15-11 
moving through files, 15-6 
opening files, 15-15, 15-16 
printing cards, 15-19 
printing files, 15-19 
restoring cards, 15-14 
saving changes, 15-19 
saving files, 15-17, 15-18 
scrolling, 15-6 
selecting text, 15-9 
starting, 15-2 
typing text, 15-4 
viewing files, 15-17, 15-20 
window, 15-3, 15-16 

Cardfile commands 
About, 15-15 
Add, 15-5 
Autodial, 15-21 
Copy, 15-12, 15-13 
Cut, 15-10, 15-11, 15-13 
Delete, 15-14 
Duplicate, 15-14 
Find, 15-12 
Find Next, 15-13 
Goto, 15-7 
Index, 15-8 
List, 15-20 
Merge, 15-19 
New, 15-15 
Open, 15-16, 15-17 
Paste, 15-ll, 15-12, 15-13 
Picture, 15-13 
Print, 15-19 
Restore, 15-14 
Save, 15-19 
Save As, 15-18 
Text, 15-14 
Undo, 15-10 

Card files, 15-15 
deleting, 15-19 
file size, 15-15 
merging, 15-19 
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Card files (cont'd.) 
opening, 15-15, 15-16 
printing, 15-19 
saving, 15-17, 15-18 
saving changes, 15-19 
viewing, 15-17, 15-20 

Card menu, 15-5 
Change Directory command, 3-8, 

5-2 
Changing 

Cardfile index line, 15-8 
day settings in Calendar, 16-12 
directories, 5-2, 5-3 
PIFs, B-14 
time, 8-3 
VT220 settings, 11-4 
WIN.INI, A-3 
window size, 2-8 

Changing Country settings, 8-26 
Changing cursor blink rate, 8-5 
Changing date, 8-4 
Changing default printer, 8-16 
Changing double-dick rate, 8-5 
Changing Keyboard settings, 8-23 
Changing Mouse settings, 8-25 
Changing Screen colors, 8-21 
CHKDSK, B-8 
Clear command, 14-7, 24-4 
Click 

action defined, 1-3 
Click on 

action defined, l-3 
Clipboard, 7-7, 7-8, 14-5, 15-9, 

16-5, 17-3, 17-4, 23-6 
defined, 2-15 
VT220 emulator, 9-4 

Clock 
introducing, 18-1 
setting, 18-2 
starting, 18-1 
window, 18-2 

Close command, 1-7, 1-15, 4-12, 
7-4 

application closing, 1-15 
keyboard procedure, 6-9 
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Close Window on exit option, B-11 
Closing, 1-15 

applications 
keyboard procedure, 6-9 

dialog box 
keyboard procedure, 6-11 

windows 
standard applications, 7-4 

Coarse Grid command, 24-8 
Commands 

MS-Paint summary, 24-1 
special effects, 23-7 

Communications Port command, 
8-14 

Concatenating files, 4-6 
Configuration Aide, A-1 
Configuration files 

Actions Set-Up screen 
VT220 emulator, 12-2, 12-3 

DEFAULT.220 
VT220 emulator, 12-1, 12-2 

file names 
VT220 emulator, 12-2 

Recall Set-Up Parameters 
VT220 emulator, 12-2 

VT220 emulator, 12-1 
Connections command, 8-7, 8-14, 

8-15 
CONTROL.EXE, 8-2 
Control menu, 4-9, 4-10 
Control Panel, 8-1, A-3 

adding fonts, 8-6 
adding printers, 8-6 
changing country settings, 8-20, 

8-26 
changing cursor blink rate, 8-5 
changing date, 8-4 
changing default printer, 8-14, 

8-16 
changing double-click rate, 8-5 
changing keyboard settings, 8-20, 

8-23 
changing mouse settings, 8-20, 

8-25 



Control Panel (cont'd.) 
changing printer connections, 

8-15 
changing printer port connections, 

8-14 
changing screen colors, 8-20, 8-21 
changing time, 8-3 
defined, 8-2 
deleting fonts, 8-6 
deleting printers, 8-6 
dialog box, 8-3 
in Cardfile, 16-2 
in Clock, 18-2 
running, 8-2 
window, 8-2 

Control Panel menus 
Preferences, 8-20 
Setup, 8-14, 8-15, 8-16 

Controls command, 16-7 
Copy command, 2-15, 3-5, 4-3, 4-4, 

4-5, 5-4, 7-7, 7-8, 14-5, 14-9, 
15-12, 15-13, 16-5, 17-4, 23-6, 
24-3 

Copying, 2-15 
cards in Cardfile, 15-14 
files, 4-4, 4-5 
text 

in Calendar, 16-5 
in Cardfile, 15-11 
in Notepad, 14-9 

to the Clipboard, 7-8 
VT220 emulator, 9-4 

Country settings command, 8-20, 
8-26 

Create command, 24-2 
Create Directory command, 3-8, 5-3 
C.·eating 

card files, 15-3 
PIFs, B-3 

Ctrll Arrow keys, 6-2 
Ctrl/Break keys, 6-2, 6-11 
Current directory, 3-2, 5-1 
Current status box, 20-3 
Cursor, 3-2 
Cursor blink rate, 8-5 

Customizing 
in Calendar, 16-12 

Cut command, 2-15, 14-5, 14-8, 
15-10, 15-11, 15-13, 16-6, 
24-3 

Cutting, 2-15 

D 
Data diskette, 5-7 
Date command, 16-11 
Day command, 16-3 
Day settings 

changing, 16-12 
Day Settings command, 16-12 
Day Settings dialog box, 16-12 
Day view, 16-2, 16-11 
DECinfo section, A-23 
DECKeybd section, A-21 
DECLA T section, A-20 
Default printer, 8-16 
Definitions 

canvas, 20-2 
current status box, 20-3 
drawing window, 20-3 
menu bar, 20-3 
mouse cursor, 20-3 
MS-Paint, 20-2 
terminal emulator, 9-1 
title bar, 20-3 
tools and shapes palette, 20-3 

Delete command, 3-5, 4-3, 4-6, 5-6, 
14-16, 15-14, 16-20 

Delete Font command, 8-6, 8-14 
Delete Printer command, 8-6, 8-10 
Deleting 

cards in Cardfile, 15-14 
files 

in Cardfile, 15-19 
in Notepad, 14-16 

fonts, 8-14 
text 

in Calendar, 16-6 
in Cardfile, 15-10 
in Notepad, 14-7 
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Deleting files, 4-6 
in Calendar, 16-20 

Devices section, A-24 
Dialog box 

check boxes, 1-13 
closing, 1-13 
command button, 1-11 

Cancel, 1-13 
default, 1-13 
Ok, 1-13 
Reset, 1-13 

command buttons 
keyboard procedure, 6-10 

defined, 1-9 
insertion point, 1-11 
keyboard procedure, 6-10, 6-11 
Jist box, 1-11 
option buttons, 1-11 

keyboard procedure, 6-10 
System menu box, 1-13 
text box, 1-11 

Directly Modifies option, B-8 
Directories, 5-1 

change listing, 5-4 
changing, 5-2, 5-3 
creating, 5-3 
current, 3-2, 5-1 
defined, 5-1 
deleting, 5-6 
displaying multiple, 5-5 
listing, 3-2, 5-1, 5-4 
MS-DOS Executive window, 5-1 
path name, 5-1 
printing, 5-6 
printing listings, 5-6 
subdirectory, 5-1 

Diskettes, 5-7 
data, 5-7 
preparing, 5-7, 5-8 
system, 5-8 

Disks, 5-1 
displaying, 5-10 
drive A, 5-10 
drive H, 5-10 
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Disks (cont'd.) 
naming, 5-9 

Displaying 
disks, 5-10 
multiple directories, 5-5 

Double-click 
rate, 8-5 

Double-click on 
action defined, 1-3 

Drag 
action defined, 1-3 

Drawing, 22-2 
box, 23-1 
brush, 22-4 
circle, 23-2 
curve, 23-2 
3-D, 23-2 
eraser, 22-4 
filled box, 23-4 
lines, 23-2 
oval, 23-2 
pencil, 22-3 
rounded box, 23-2 
window, 20-3 

Drive icons, 3-2 
Drop-down menu, 1-7 
Duplicate command, 15-14 

E 
Early ring text box, 16-7 
Editing 

a selection, 23-5 
detailed, 23-8 
in day view 

in Calendar, 16-3 
in Notepad, 14-5 
PIF, B-5 
special effects, 23-7 
text 

in Calendar, 16-5 
in CardfiJe, 15-9 

Edit menu, 14-5, 14-13, 15-10, 24-3 
commands, 24-3 

Clear, 24-4 



Edit menu 
commands (cont'd.) 

Copy, 24-3 
Cut, 24-3 
Erase, 24-3 
Flip Horizontal, 24-4 
Flip Vertical, 24-4 
Invert, 24-4 
Paste, 24-3 
spedal effects, 24-4 
Trace Edges, 24-4 

Edit Pattern command, 24-9 
End key, 7-5 
End Session command, 3-8 
Entering 

VT220 Set-Up, 11-1 
F3 (Set-Up), 11-1 
Set-Up command, 11-1 

Entering appointments in Calendar, 
16-4 

Erase command, 24-3 
Eraser, 22-4 

double-clicking, 22-2 
Esc key, 6-2, 6-6 
Exiting 

VT220 Set-Up, 11-5 
Expand defined, 1-4 
Extensions section, A-8 

F 
File menu, 3-3, 3-4, 3-5, 4-3, 14-11, 

14-12, 14-14, 14-15, 15-15, 
15-16, 15-17, 22-7, 24-2 

commands, 3-5, 24-2 
NEW, 24-2 
OPEN, 24-2 
Print, 24-2 
Save, 24-2 
Save As, 24-2 

File name 
keyboard procedure, 6-8 

File names, 6-6 
Files, 4-1 

batch, 3-12 

Files (cont'd.) 
canceling selected, 4-2 
canceling selected files, 6-13 
concatenating, 4-6 
copying, 4-4, 4-5 
defined, 4-1 
deleting, 4-6 
extension 

defined, 3-5 
View menu, 3-7 

in Calendar, 16-15 
in Cardfile, 15-15 
in Notepad, 14-11 
keyboard procedure, 6-13 
listing, 5-4 
name, 7-6 
naming, 4-1 
printing, 4-7 
renaming, 4-11 
selecting, 4-2 

keyboard procedure, 6-13, 
6-14 

selecting multiple, 4-2 
temporary, 3-12 

Filling a shape, 23-4 
Find command, 14-9, 15-12 
Find dialog box, 14-9, 15-12 
Finding text 

in Cardfile, 15-12 
in Notepad, 14-9 

Find Next coptmand, 14-10, 15-13 
Fine Grid command, 24-8 
Finishing 

applications 
keyboard procedure, 6-8, 6-9 

MS-Paint, 22-7 
MS-Windows 

standard applications, 7-5 
Flip Horizontal command, 23-7, 

24-4 
Flip Vertical command, 24-4 
Font menu, 24-5 

commands, 24-5 
Fonts 

Index-7 



Fonts (cont'd.) 
adding, 8-12 
deleting, 8-14 
device, 8-13 
raster, 8-12 
stroke, 8-12 
vector, 8-12 

FontSize menu, 24-5 
commands, 24-5 

Fonts section, A-25 
Format Data Disk command, 3-8, 

5-7 
Formatting 

text 
in Cardfile, 15-5 

Formatting text 
in Notepad, 14-3 

Freehand polygon, 23-2 

G 
Get Info command, 3-5, 4-3, 4-12 
Goto command 

in Cardfile, 15-7 
Goto dialog box, 15-7 

H 
High command, 4-10 
Highlight, 1-8, 3-2 
Hints for Reversi, 19-4 
Home key, 7-5 
hourglass, 3-12 
Hourglass, 5-9 

1/0 activities, 7-2 
Icon area, 3-2 
leon command, 1-7, 2-13 

keyboard procedure, 6-7, 6-9 
Icons, 2-13, 3-2 

expanding, 7-6 
names, 2-3 
shrinking 

keyboard procedure, 6-9 

l1tdex-8 

Icons (cont'd.) 
standard applications, 7-3 

Index command, 15-8 
Index dialog box, 15-4, 15-8 
Index line 

in Cardfile, 15-4 
Information System, 1-5 
Initial Directory option, B-7 
Insertion point 

in Cardfile, 15-9 
in Notepad, 14-6 

Installation Aid, B-1 
·Installation menu, 8-3, 8-6 
International section, A-17 
Invert command, 24-4 

K 
KB Desired, B-8 
KB Required, B-7 
Keyboard labels 

VT220 emulator, 10-2 
Keyboard procedure, 6-1 

canceling commands, 6-6 
canceling selected files, 6-13 
changing window sizes, 6-15 
closing applications, 6-9 
commands, 6-4 
dialog box, 6-10 

closing, 6-11 
features, 6-1 
finishing applications, 6-8 
loading applications, 6-6 
menus, 6-4 
moving windows, 6-16 
multiple windows, 6-14 
receiving messages, 6-16 
removing menus, 6-6 
running applications, 6-7, 6-8 
scrolling, 6-11 

standard applications, 7-5 
selecting commands, 6-5 
selecting files, 6-13, 6-14 
shrinking icons, 6-9 
size box, 6-15 



Keyboard procedure (cont'd.) 
Size command, 6-15 
switching windows, 6-14 
transferring information;, 7-7 
Zoom command, 6-15 

Keyboards 
Alt key sequences, 10-5, 10-6 
country, 10-1 
edit keypad, 10-5 
function keys, 10-5, 10-6 
IBM Enhanced keys, 10-5 
numeric keypad, 10-5, 10-7 
PC/AT keys, 10-5 
PC/XT keys, 10-6, 10-7 
VT220 emulator, 10-2 

Keyboard setting command, 8-20 
Keyboard settings command, 8-23 
Key diskette, 3-2 
Keys 

Alt, 6-2, 6-3 
Alt/Prt Sc, 7-7, 7-10 
Alt/Return, 6-16 
Alt/spacebar, 6-2, 6-4, 6-5 
Alt/Tab, 6-2, 6-7, 6-9, 7-6 
Alt/Tab/Shift, 6-2 
arrow, 6-13 
Arrow, 6-2, 6-4, 6-6, 6-8, 6-10, 

6-11, 7-5 
Arrow/Shift, 6-3 
Ctri/Arrow, 6-2 
Ctri/Break, 6-2, 6-11 
End, 7-5 
Esc, 6-2, 6-6 
function keys 

Ctrl/F5 
VT220 emulator, 10-2 

F1 (Hold) 
VT220 emulator, 10-2 

F11 (ESC) 
VT220 emulator, 10-2 

F12 (BS) 
VT220 emulator, 10-2 

F2 (Print Screen) 
VT220 emulator, 10-2 

Keys 

L 

function keys (cont'd.) 
F3 (Set-Up) 

. VT220 emulator, 10-2 
F4 (data/Talk) 

VT220 emulator, 10-2 
FS (Break) 

VT220 emulator, 10-2 
Shift/F5 

VT220 emulator, 10-2 
VT220 emulator, 10-2 

Home, 7-5 
Page Down (Pg Dn), 7-5 
Page Up (Pg Up), 7-5 
Return, 6-2, 6-6, 6-8, 6-10 
Return/Shift, 6-3 
Shift, 4-2, 6-2 
Shift/Prt Sc, 6-17 
Shift/Tab, 6-10 
spacebar, 6-2, 6-9 
Tab, 6-3, 6-10, 8-4 
Word Char, 5-3, 6-3 

Leaving the VT220 emulator, 9-5 
Close command, 9-5 
Icon command, 9-5 

Left mouse button, 8-25 
Ust command, 15-20 
Usting 

file names, 5-4 
Load command, 3-5, 3-9, 6-6 
Loading 

applications, 6-6 
Loading applications 

keyboard procedure, 6-6 
Long command, 3-7 
Low command, 4-10 

M 
Make System Disk command, 3-8, 

5-8 
Making a selection, 23-5 
Mark command, 7-7, 7-8, 16-14 
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Marking 
information, 7-7 

Marking dates in Calendar, 16-14 
Match Case command, 14-10 
Medium Grid command, 24-8 
Memory, 2-2, 7-2, 7-10, 7-11, B-2, 

B-7, B-14 
in Calculator, 17-3 

Memory Requirements option, B-7 
Menu bar, 3-2, 20-3 
Menus 

Alarm, 16-7 
Card, 15-5 
Control, 4-9, 4-10 
drop-down, 1-7 
Edit, 14-5, 14-13, 15-10, 24-3 
File, 3-4, 4-3, 14-11, 14-12, 

14-14, 14-15, 15-15, 15-16, 
15-17, 22-7, 24-2 

File menu, 3-3 
Font, 24-5 
FontSize, 24-5 
Installation, 8-3, 8-6 
MS-Paint, 24-1 
Options, 16-12, 24-8 
Palette, 22-6, 24-7 
Preferences, 8-3, 8-20 
Priority, 4-9, 4-10 
Search, 14-9, 15-7, 15-12 
selecting 

keyboard procedure, 6-4 
Setup, 8-3, 8-14 
Show, 16-11 
Special, 3-8 
Special menu, 3-3 
Style, 24-5 
System, 3-4, 7-7, 14-11, 15-15, 

22-7 
System menu, 3-3 
View, 3-6 
View menu, 3-3 

Merge command, 15-19 
Merge dialog box, 15-19 
Merging files in Cardfile, 15-19 

Iudex-10 

Messages, 25-1 
applications, 2-16 

Month command, 16-10 
Month view 

in Calendar, 16-10 
Mouse 

actions defined 
click, 1-3 
double-click, 1-3 
drag, 1-3 
point, 1-3 

Mouse cursor, 20-3 
Mouse settings command, 8-20, 8-25 
Move command, 1-7 

keyboard procedure, 6-7, 6-16 
Moving 

cards in Cardfile, 15-7 
text 

in Cardfile, 15-11 
in Notepad, 14-8 

through card files, 15-6 
windows, 2-6 

MSDOS.EXE, 5-5 
MS-DOS Executive window, 3-1, 

3-2, 14-13, 15-17, 16-16 
changing directories, 5-2, 5-3 
components, 3-2 
CONTROL.EXE, 8-2 
creating directories, 5-3 
cursor, 3-2 
deleting directories, 5-6 
directories, 5-1 
disk drives, 5-10 
diskettes, 5-7 
displaying disks, 5-10 
displaying multiple directories, 

5-5 
drive icons, 3-2 
first window, 1-2 
highlight, 3-2 
icon area, 3-2 
icons, 3-2 
listing directories, 3-2 
menu bar, 3-2 



MS-DOS Executive window (cont'd.) 
naming disks, 5-9 
path, 3-2 
path name, 3-2 
Path name, 5-1 
preparing disks, 5-7 
printing directory listings, 5-6 
scroll bars, 3-2 
size box, 3-2 
System menu box, 3-2 
title bar, 3-2 
work area, 3-2 

MS-DOS operating system 
WIN .IN I 

VT220 emulator, 12-2 
MS-Paint, 20-1, 22-1 
Ms-Paint commands 

Align Center, 24-6 
Coarse Grid, 24-8 

MS-Paint commands 
Align, 24-6 
Align Right, 24-6 
Clear, 24-4 
Copy, 23-6, 24-3 
Create, 24-2 
Cut, 24-3 
Edit Pattern, 24-9 
Erase, 24-3 
Fine Grid, 24-8 
Flip Horizontal, 23-7, 24-4 
Flip Vertical, 24-4 
Invert, 24-4 
Medium Grid, 24-8 
New, 24-2 
No Grid, 24-8 
Opaque, 24-6 
Open, 24-2 
Paste, 23-6, 24-3 
Patterns, 23-4 
Print, 24-2 
Save, 24-2 
Save As, 24-2 
special effects, 24-4 
Trace Edges, 24-4 

MS-Paint commands (cont'd.) 
Transparent, 24-6 
Undo, 24-3 
Zoom In, 23-8, 24-8 
Zoom Out, 23-9, 24-8 

MS-Windows 
finishing 

standard applications, 7-5 
initialization file, 14-1 
MS-DOS Executive window, 

14-1, 14-13, 15-2, 15-17, 
16-2, 16-16, 17-1, 18-1, 
19-1 

returning, 7-6 
MS-Windows command 

Close 
VT220 emulator, 9-5 

Copy 
VT220 emulator, 9-4 

Icon 
VT220 emulator, 9-5 

Mark 
VT220 emulator, 9-4 

Paste 
VT220 emulator, 9-4 

Run 
configuration files 

VT220 emulator, 12-2 
VT220 emulator, 9-2 

MS-Windows commands 
About, 1-7, 3-4, B-3 
Add New Font, 8-6, 8-12 
Add New Printer, 8-6, 8-7 
All, 3-7 
By Date, 3-7 
By Kind, 3-7 
By Name, 3-7 
By Size-, 3-7 
Change Directory, 3-8, 5-2 
Close, 1-7, 4-12, 6-9, 7-4 
Communications Port, 8-14 
Connections, 8-7, 8-14, 8-15 
Copy, 2-15, 3-5, 4-3, 4-4, 4-5, 

5-4, 7-7, 7-8 
Country settings, 8-20, 8-26 
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MS-Windows commands (cont'd.) 
Create Directory, 3-8, 5-3 

N 

Cut, 2-15 
Delete, 3-5, 4-3, 4-6, 5-6 
Delete Font, 8-6, 8-14 
Delete Printer, 8-6, 8-10 
End Session, 3-8 
Format Data Disk, 3-8, 5-7 
Get Info, 3-5, 4-3, 4-12 
High, 4-10 
Icon, 1-7, 2-13, 6-7, 6-9 
Keyboard settings, 8-20, 8-23 
Load, 3-5, 3-9, 6-6 
Long, 3-7 
Low, 4-10 
Make System Disk, 3-8, 5-8 
Mark, 7-7, 7-8 
Mouse settings, 8-20, 8-25 
Move, 1-7, 6-7, 6-16 
Network Terminal Services, 8-14 
New, B-4 
Partial, 3-7, 5-4 
Paste, 2-15, 7-7, 7-8, 7-9 
Pause, 4-10 
Print, 3-5, 4-3, 4-7, 5-6, 8-16 
Printer, 8-14, 8-16 
Programs, 3-7 
Rename, 3-5; 4-3, 4-11 
Resume, 4-10 
Run, 3-5, 3-11, 5-5, 6-8, 7-6, 

8-2, B-3 
Screen colors, 8-20, 8-21 
selecting 

keyboard procedure, 6-5 
Set Volume Name, 3-8, 5-9 
Short, 3-7 
Size, 1-7, 2-9, 6-15 
Terminate, 4-10 
Zoom, 1-7, 2-11, 2-12, 6-15 

Network Terminal Services 
VT220 emulator, 11-9 

Index-12 

Network Terminal Services 
command, 8-14 

New command, 14-12, 15-15, 16-15, 
19-4, 24-2, B-4 

No Grid command, 24-8 
Notepad, A-3 

canceling edits, 14-7 
copying text, 14-9 
deleting files, 14-16 
deleting text, 14-7 
editing, 14-5 
finding text, 14-9 
formatting text, 14-3 
insertion point, 14-6 
introducing, 14-1 
moving text, 14-8 
opening files, 14-11, 14-12 
printing files, 14-16 
saving changes, 14-16 
saving files, 14-14, 14-15 
scroll bars, 14-5 
scrolling, 14-4 
selecting text, 14-6, 14-7 
starting, 14-1 
time log file, 14-13 
typing text, 14-2 
viewing files, 14-14 
window, 14-2 

Notepad commands 
About, 14-11 
Clear, 14-7 
Copy, 14-5, 14-9 
Cut, 14-5, 14-8 
Delete, 14-16 
Find, 14-9 
Find Next, 14-10 
Match Case, 14-10 
New, 14-12 
Open, 14-12 
Open command, 14-14 
Paste, 14-5, 14-8, 14-9 
Print, 14-16 
Save, 14-16 
Save As, 14-15 



Notepad commands (cont'd.) 
Select All, 14-7 
Time/Date, 14-14 
Undo, 14-7 

Notepad files, 14-11 
deleting, 14-16 
file size, 14-11 
opening, 14-11, 14-12 
opening files, 14-12 
printing, 14-16 
saving, 14-14, 14-15 
saving changes, 14-16 
viewing, 14-14 

Notepad window, 14-12 
Num Lock, 6-11 

0 
Opaque command, 24-6 
Open command, 14-12, 14-14, 

15-16, 15-17, 16-15, 16-17, 
24-2 

Open dialog box, 14-12, 14-14, 
15-16, 15-17, 16-15, 16-17 

Opening 
files 

in Calendar, 16-15 
in Cardfile, 15-15 
in Notepad, 14-11, 14-12 

Opening files 
in Calendar, 16-15 
in Cardfile, 15-16 

Options menu, 16-12, 24-8 

p 

commands, 24-8 
Coarse Grid, 24-8 
Edit Pattern, 24-9 
Fine Grid, 24-8 
Medlum Grid, 24-8 
No Grid, 24-8 
Zoom In, 24-8 
Zoom Out, 24-8 

Page Down (Pg Dn) key, 7-5 
Page Up (Pg Up) key, 7-5 

Palette menu, 22-6, 24-7 
commands, 24-7 

Palettes, 22-6 
Partial command, 3-7, 5-4 
Pass command, 19-3 
Paste command, 2-15, 7-7, 7-8, 

7-9, 14-5, 14-8, 14-9, 15-11, 
15-12, 15-13, 16-6, 17-4, 

23-6, 24-3 
Pasting, 2-15 
Path, 3-2 
Path name, 3-2, 5-1 

changing dlrectories, 5-3 
Patterns 

addlng, 23-3 
Patterns command, 23-4 
Pause command, 4-10 
Picture command, 15-13 
PIF, 7-2 

changing, B-14 
Close Window on exit option, 

B-11 
closing standard applications, 7-4 
contents, B-12 
creating, B-3 
customized, B-2 
default settings, B-12 
defined, B-1 
Directly Modlfies option, B-8 
edlting, B-5 
edltor, B-2, B-3 
getting help, B-3 
Initial Directory option, B-7 
KB Desired, B-8 
KB Required, B-7 
Memory Requirements option, 

B-7 
options, B-5 
Program Name option, B-5 
Program Parameters option, B-6 
Program Switch option, 7-7, B-10 
Program Title option, B-6 
running applications, B-2 
Screen Exchange option, B-11 
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PIF (cont'd.) 
standard applications, 7-2 

PJF section, A-12 
Playing Reversi, 19-3 
Point 

action defined, 1-3 
Polygon 

freehand, 23-2 
Ports section, A-15 
Preferences menu, 8-3 

commands 
Country settings, 8-20, 8-26 
Keyboard settings, 8-20, 8-23 
Mouse settings, 8-20, 8-25 
Screen colors, 8-21 
Screen Colors, 8-20 

Print command, 3-5, 4-3, 4-7, 5-6, 
14-16, 16-19, 24-2 

default printer, 8-16 
Print commands, 15-19 
Print dialog box, 16-19 
Printer command, 8-14, 8-16 
Printer connections, 8-15 
Printer driver files, 8-7 
printers 

adding, 8-7 
Printers 

adding, 8-6, 8-9 
removing, 8-10 

Printing 
cards in Cardfile, 15-19 
default printer, 4-8 
directory listings, 5-6 
files, 4-7 

in Calendar, 16-19 
in Cardfile, 15-19 
in Notepad, 14-16 

graphics mode, 4-11 
in MS-Paint, 22-7 
ptint queue, 4-9 
screens, 6-17 

Print queue, 4-9 
Priority menu, 4-9, 4-10 
Program Information Editor 

Window, B-3 

Iudex-14 

Program Name option, B-5 
Program Parameters option, B-6 
Programs command, 3-7 
Program Switch option, B-10 
Program Title option, B-6 

R 
Recalling 

settings 
VT220 emulator, 12-3 

Set-Up files 
VT220 emulator, 12-3 

Recall Set-Up Parameters 
Actions Set-Up screen 

VT220 emulator, 12-3 
Receiving characters from a host 

session logging, 12-4 
Remove command, 16-19 
Remove dialog box, 16-19 
Removing 

days in Calendar, 16-19 
menus 

keyboard procedure, 6-6 
printers, 8-10 

Rename command, 3-5, 4-3, 4-11 
Renaming files, 4-11 
Resources, 7-2 
Restore command, 15-14 
Restoring cards in Cardfile, 15-14 
Resume command, 4-10 
Return/Shift key, 6-3 
Returning toMS-Windows, 7-6 
Return key, 6-2, 6-6, 6-8, 6-10 
Reversi 

hints, 19-4 
introducing, 19-1 
playing, 19-3 
rules, 19-3 
starting, 19-1 
starting new games, 19-4 

Reversi commands 
New, 19-4 
Pass, 19-3 

Reversi window, 19-2 



Right mouse button, 8-25 
Rules for Reversi, 19-3 
Run command, 3-5, 3-11, 5-5, 7-6, 

8-2, B-3 
keyboard procedure, 6-8 

Running 
applications, B-2 

keyboard procedure, 6-7, 6-8 
Control Panel, 8-2 
multiple standard applications, 

7-6 
standard applications 

large, 7-10 
outside windows, 7-6 

Running applications 
file name, 3-10, 3-12 

s 
Save As command, 14-15, 15-18, 

16-17, 24-2 
Save As dialog box, 14-15, 15-18, 

16-18 
Save command, 14-16, 15-19, 16-18, 

24-2 
Save Set-Up Parameters 

Actions Set-Up screen 
VT220 emulator, 12-3 

Saving 
changes 

files 

in Calendar, 16-18 
in Cardfile, 15-19 
in Notepad, 14-16 

in Calendar, 16-17 
in Notepad, 14-14, 14-15 

settings 
VT220 emulator, 12-3 

Set-Up files 
VT220 emulator, 12-3 

Saving files 
in Calendar, 16-17 
in Cardfile, 15-17, 15-18 

Scratch pad, 16-5, 16-14 
Screen colors command, 8-20, 8-21 

Screen Exchange option, B-11 
Screen printing, 6-17 
script, 13-1 
Script commands 

BAUD RATE, 13-14 
BREAK, 13-15 
CASE, 13-16 
CHAIN, 13-3, 13-18 
CLEAR LINE, 13-18 
CLOSE, 13-30 
COMMENT, 13-19 
DATA BITS, 13-19 
DEBUG, 13-2, 13-3, 13-20 
DIAL, 13-20 
DISCONNECT, 13-21 
DISPLAY, 13-21 
DTR CLEAR, 13-22 
DTR SET, 13-22 
ECHO, 13-2, 13-3, 13-23 
END ON ERROR, 13-29 
EXIT, 13-23 
EXIT EMU LA TOR, 13-24 
EXIT EMULATOR ON, 13-24 
EXIT ON, 13-25 
FPRINT, 13-25 
GOTO, 13-26 
HANG UP, 13-26 
KEYBOARD OFF, 13-27 
KEYBOARD ON, 13-27 · 
LOAD, 13-27 
NO DEBUG, 13-20 
NO ECHO, 13-23 
NO SKIP ON, 13-38 
NO XON/XOFF, 13-44 
NTS, 13-28 . 
ON ERROR, 13-29 
OPEN, 13-30 
PARITY, 13-31 
PAUSE, 13-2, 13-32 
PORT, 13-33 
PRINTER OFF, 13-33 
PRINTER ON, 13-33 
PRINT SCREEN, 13-34 
PURGE TYPE, 13-34 
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Script commands (cont'd.) 
READ, 13-34 
RETRY, 13-3, 13-35 
SCRIPT, 13-3, 13-35 
SEND, 13-2, 13-36 
SEND FROM, 13-36 
SET, 13-37 
SKIP, 13-37 
SKIP ON, 13-3, 13-38 
STOP BITS, 13-39 
SYSTEM, 13-40 
TIMEOUT, 13-42 
TIMER, 13-2, 13-42 
TIMER OFF, 13-42 
TYPE UNTIL, 13-43 
WAIT FOR, 13-43 
XON/XOFF, 13-44 

Script examples, 13-4, 13-7 
Scripting 

control characters, E-2 
DEC MCS, E-2 
function keys, E-2 
Non-displayable characters, E-1 
nonprintable characters, E-1 
PF1 through PF4, E-2 

SCI'ipt processing 
ending a script, 13-10 
troubleshooting, 13-11 

Scroll arrow, 1-6 
Scroll bars, 1-6, 3-2, 14-5 
Scroll box, 1-6, 15-7 
Scrolling, 23-9 

defined, 1-6 
in Calendar, 16-4, 16-8 
in Cardfile, 15-6 
in Notepad, 14-4 
keyboard procedure, 6-11 
mouse procedure, 1-6 
standard applications, 7-4 

keyboard procedure, 7-5 
VT220 emulator window, 9-3 
VT220 keys 

Ctrl/Find, 9-3 
Ctrl/Next, 9-3 

Iudex-16 

Scrolling 
VT220 keys (cont'd.) 

Ctri/Prev, 9-3 
Ctrl/Select, 9-3 

Search For text box, 14-10 
Search menu, 14-9, 15-7, 15-12 
Select All command, 14-7 
Selecting 

command buttons 
keyboard procedure, 6-10 

commands 
keyboard procedure, 6-5 

files, 4-2 
keyboard procedure, 6-13, 

6-14 
Keyboard procedure, 6-13 

information for transfer, 7-7 
menus 

keyboard procedure, 6-4 
multiple files, 4-2 
text 

in Calendar, 16-5 
in Cardfile, 15-9 
in Notepad, 14-6, 14-7 

times 
in Calendar, 16-4 

Selecting default printer, 8-16 
Selection 

editing, 23-5 
making, 23-5 

Selection Net, 23-5 
Selection Rectangle, 23-5, 24-4 
Serial communications 

VT220 emulator, 11-9 
Set command, 16-8 
Setting 

tabs manually 
VT220 emulator, 11-26 

Setting Clock, 18-2 
Setup menu, 8-3 

commands 
Communications Port, 8-14 
Connections, 8-14, 8-15 
Network Terminal Services, 

8-14 
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' ,/ Setup menu 
commands (cont'd.) 

Printer, 8-14, 8-16 
Set-Up screens 

current selection settings 
VT220 emulator, 11-2 

menu bar 
VT220 emulator, 11-2 

status section 
VT220 emulator, 11-2 

title bar 
VT220 emulator, 11-2 

VT220 emulator 
Actions, 11-6 
Communications, 11-9 
Display, 11-13 
General, 11-16 
Keyboard, 11-20 
Printer, 11-23 
Tabs, 11-25 
Telephone, 11-27 

Set-Up selections 
Answerback Concealed 

VT220 emulator, 11-23 
Answerback String 

VT220 emulator, 11-23 
Auto Answerback 

VT220 emulator, 11-23 
Auto Wrap 

VT220 emulator, 11-15 
Background 

VT220 emulator, 11-15 
Blink 

VT220 emulator, 11-15 
Break 

VT220 emulator, 11-23 
Clear All Tabs 

VT220 emulator, 11-26 
Clear Communications 

VT220 emulator, 11-8 
Clear Display 

VT220 emulator, 11-8 
Columns 

VT220 emulator, 11-15 

Set-Up selections (cont'd.) 

Cursor Keys 
VT220 emulator, 11-23 

Cursor Style 
VT220 emulator, 11-15 

Data Bits and Parity 
VT220 emulator, 11-12 

Disconnect Delay 
VT220 emulator, 11-12 

Font Size 
VT220 emulator, 11-15 

Keypad Mode 
VT220 emulator, 11-23 

Line mode 
VT220 emulator, 11-17 

Local Echo 
VT220 emulator, 11-17 

Manually Set Tabs 
VT220 emulator, 11-26 

Margin Bell 
VT220 emulator, 11-23 

Modem Answer 
VT220 emulator, 11-29 

Multinational Character Set 
VT220 emulator, 11-20 

Multinational Mode 
VT220 emulator, 11-17 

Network Terminal Services 
VT220 emulator, 11-12 

New Line 
VT220 emulator, 11-17 

Port/Network 
VT220 emulator, 11-12 

Print Extent 
VT220 emulator, 11-24 

Print Mode 
VT220 emulator, 11-24 

Print Size 
VT220 emulator, 11-24 

Recall Set-Up Parameters 
VT220 emulator, 11-8 

Receive File 
VT220 emulator, 11-8 

Reset Terminal 

Index-17 



Set-Up selections 
Reset Terminal (cont'd.) 

VT220 emulator, 11-8 
Save Set-Up Parameters 

VT220 emulator, 11-8 
Send File 

VT220 emulator, 11-8 
Set 8 Column Tabs 

VT220 emulator, 11-26 
Set Default Set-Up Parameters 

VT220 emulator, 11-8 
Set Tab Interval 

VT220 emulator, 11-26 
Speed 

VT220 emulator, 11-12 
Stop Bits 

VT220 emulator, 11-12 
Telephone Numbers 

VT220 emulator, 11-29 
Terminal Emulation 

VT220 emulator, 11-20 
Terminal 10 

VT220 emulator, 11-20 
Text Cursor 

VT220 emulator, 11-15 
UDK Lock State 

VT220 emulator, 11-20 
UDK Shifted State 

VT220 emulator, 11-20 
User Defined Keys 

VT220 emulator, 11-20 
User Features 

VT220 emulator, 11-20 
User Icon Name 

VT220 emulator, 11-15 
Warning Bell 

VT220 emulator, 11-23 
Window Title 

VT220 emulator, 11-15 
XOFF Point 

VT220 emulator, 11-12 
Set Volume Name command, 3-8, 

5-9 
Shapes, 23-2 
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Shapes (cont'd.) 
filling, 23-4 
functions, 21-3 
summary, 21-3 

Shift/Tab, 6-10 
Shift key, 4-2, 6-2 
Short command, 3-7 
Show menu, 16-11 
Shrinking 

description, 1-15 
Size box, 2-10, 2-12, 3-2 

keyboard procedure, 6-15 
Size command, 1-7, 2-9 

keyboard procedure, 6-15 
Spacebar, 6-2, 6-9 
Special applications, 7-11 
Special effects, 24-4 

commands, 24-4 
editing, 23-7 

Special menu, 3-3, 3-8 
Change Directory, 5-2 
commands, 3-8 

Special Time command, 16-13 
Special Time dialog box, 16-13 
Special times 

in Calendar, 16-13 
Specifying VT220 configuration files 

on startup, 12-2 
Spooler, 4-8, 4-9 

Control menu, 4-9, 4-10 
Priority menu, 4-9 

Spooler window, 4-9 
Starting 

Calculator, 17-1 
Calendar, 16-2 
Cardfile, 15-2 
Clock, 18-1 
MS-Paint, 22-1 
new games in Reversi, 19-4 
Notepad, 14-1 
Reversi, 19-1 
standard applications 

outside windows, 7-6 
Starting the emulator 



Starting the emulator (cont'd.) 
login information 

VT220 emulator, 9-2 
VT220 emulator, 9-2 

Run command, 9-2 
VT220 icon, 9-2 

Status section 
autotyping 

VT220 emulator, 12-4 
communications 

VT220 emulator, 11-4 
integral modem 

VT220 emulator, 11-4 
printer 

VT220 emulator, 11-4 
receiving or sending files 

VT220 emulator, 11-4 
telephone modes 

VT220 emulator, 11-4 
VT220 emulator, 11-4 

Style menu, 24-5 
commands, 24-5 

Align, 24-6 
Align Center, 24-6 
Align Right, 24-6 
Opaque, 24-6 
Transparent, 24-6 

Subdirectory, 5-1 
Switching 

windows, 2-6 
keyboard procedure, 6-14 

System diskette, 5-8 
System menu, 1-15, 3-3, 3-4, 7-7, 

14-11, 15-15, 22-7 
commands 

About, 1-7 
Close, 1-7, 1-15 
Icon, 1-7 
Move, 1-7 
Size, 1-7 
Zoom, 1-7 

System menu box, 3-2, 3-4 

T 
Tab key, 6-3, 6-10, 8-4 
Terminate command, 4-10 
Text, 23-3 

adding, 23-3 
files, 14-12 
in Notepad, 14-2, 14-3 

Text command, 15-14 
Tiling, 2-2 
Time/Date command, 14-14 
Time log file, 14-13 
Title bar, 3-2, 20-3 

shrinking, 2-14 
Tools, 23-2 

Box, 23-1, 23-4 
Fill, 23-4 
functions, 21-2 
Scroll, 23-9 
Selection Net, 23-5 
Selection Rectangle, 23-5 
summary, 21-2 
Text, 23-3 

Tools and shapes palette, 20-3 
Trace Edges command, 24-4 
Transferring information 

keyboard procedure, 7-7 
windows, 2-14 

Transferring informations 
applications, 7-7 

Transparent command, 24-6 
Typing text 

u 

in Cardfile, 15-4 
in Notepad, 14-2 

Understanding Set-Up screens 
VT220 emulator, 11-2 

Undo command, 14-7, 15-10, 24-3 
Unmark command, 16-14 
Unmarking dates in Calendar, 16-14 
Using MS-DOS Executive window 

3-2 I 

Using Set-Up 
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Using Set-Up (cont'd.) 
VT220 emulator, 11-1 

table information, 11-5 
with a mouse 

1 11-5 
Using Setup menu, 8-14 
Using special features 

VT220 emulator, 12-1 
Using the emulator 

VT220 emulator, 9-1 
keyboard, 10-1 
multiple sessions, 9-3 

Using the VT220 emulator 
multiple sessions, 9-2 

Using the VT220 System menu 
commands 

Script command, 9-4 
Using VT220 System menu 

v 

commands, 9-3 
About command, 9-4 
Copy command, 9-4 
Mark command, 9-4 
Paste command, 9-4 
Set-Up command, 9-4 

Viewing 
appointments in Calendar, 16-8 
dates in Calendar, 16-9, 16-11 
files 

in Calendar, 16-17 
in Cardfile, 15-17, 15-20 
in Notepad, 14-14 

times in Calendar, 16-8 
View menu, 3-3, 3-6, 3-7 

commands, 3-7 
Volume name, 5-9 
VT220 emulator keyboard, 10-1, 10-2 

w 
Wildcards, 5-5 
WlN.lNl, 8-2, A-1 

adding printers, 8-8 
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WlN.lNI (cont'd.) 
changing, A-3 
Colors section, A-9 
DECinfo section, A-23 
DECKeybd section, A-21 
DECLAT section, A-20 
Devices section, A-24 
Extensions section, A-8 
Fonts section, A-25 
International section, A-17 
naming printers, 8-6 
PIF section, A-12 
Ports section, A-15 
sections, A-2 
Windows section, A-3 

Window, 1-1 
Windows 

active, 2-6 
changing sizes, 2-8, 6-15 
dosing 

standard applications, 7-4 
enlargening, 2-8 

keyboard procedure, 6-15 
filling the screen, 2-11 

keyboard procedure, 6-15 
making smaller, 2-11 

keyboard procedure, 6-15 
moving, 2-6 

keyboard procedure, 6-16 
multiple, 2-2 

keyboard procedure, 6-14 
receiving messages 

keyboard procedure, 6-16 
shrinking, 2-13 
switching, 1-1, 2-6 

keyboard procedure, 6-14 
tiling, 2-2 
transferring information, 2-14 

Windows section, A-3 
Word Char key, 5-3, 6-3 
Work area, 3-2 
Workstation resources, 7-2 
Writing a script, 13-2 



z 
Zoom command, 1-7, 2-11, 2-12, 

6-15 
Zoom In command, 23-8, 24-8 
Zoom Out command, 23-9, 24-8 
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READER'S COMMENTS 

MS-Windows 
User's Guide 

AA-LBS7A-TH 

Your comments and suggestions help us to improve the quality of our publications. 

For which tasks did you use this manual? (Circle your responses.) 

(a) Installation (c) Maintenance (e) Training 
(b) Operation/use (d) Programming (f) Other (Please specify.) __ _ 

Did the manual meet your needs? Yes D No D Why? ----------

Please rate the manual in the following categories. (Circle your responses.) 
Excellent Good Fair Poor Unacceptable 

Accuracy (product works as described) 
Clarity (easy to understand) 
Completeness (enough information) 
Organization (structure of subject 
matter) 

5 4 3 2 1 
5 4 3 2 1 
5 4 3 2 1 
5 4 3 2 1 

Table of Contents, Index (ability to 
find topic) 
Illustrations, examples (useful) 
Overall ease of use 
Page Layout (easy to find information) 
Print Quality (easy to read) 

5 

5 
5 
5 
5 

4 

4 
4 
4 
4 

3 

3 
3 
3 
3 

2 

2 
2 
2 
2 

1 

1 
1 
1 
1 

What things did you like most about this manual? ---------------

What things did you like least about this manual? ---------------

Please list and describe any errors you found in the manual. 
Page Description/Location of Error 

Additional comments or suggestions for improving this manual: ---------

Name ______________ _ 
Street ______________ ___ 

City--------------­
State/Country-----------­
Postal (ZIP) Code ----------

Job Title----------­
Company-----------­
Department ----------­
Telephone Number --------Date _____________ __ 
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